What is HostExplorer?

Hummingbird HostExplorer is a comprehensive PC-to-host connectivity
product that delivers mainframe data to the desktop without the overhead
of legacy protocols. HostExplorer connects desktop computers to IBM
mainframes and IBM-compatible systems, to IBM midrange systems (the
AS/400 family), and to ASCII character systems using Telnet. The
terminal emulation components (TN3270, TN5250, Telnet, and TN3151)
provide fast access to corporate data and run with Windows platforms
across corporate intranets and the Internet.

HostExplorer supports Kerberos, SSL/TLS, and Secure Shell (available
only if you purchased and installed Connectivity Secure Shell). Once
installed, each program provides options that allow you to secure point-
to-point communication across your enterprise.

Note: If you are running a web-deployed installation of HostExplorer, some menu commands and

session options may not be available, depending on which commands and options your
administrator has enabled.



HostExplorer Development Kit

HostExplorer provides application programming interfaces (APIs) that let
you customize HostExplorer, Hummingbird FTP and WyseTerm.

HostExplorer Programming Help is available in the following location:
Program Files\Hummingbird\Connectivity\version\Ho:

This Help file is only available if you have installed the HostExplorer
Development Kit using Custom or Complete installation during Setup.

Related Topics
Overview—Session Profiles
HostExplorer Menu Descriptions




HostExplorer Applications

HostExplorer includes the following applications:

3270 Emulates IBM mainframe terminals (including 3179G, 3472G,
3278, and 3279 models), runs 3270 applications, and lets you transfer
files between a host machine and your PC using the IND$FILE file
transfer application.

5250 Emulates IBM AS/400 terminals, runs 5250 applications, and lets
you transfer structured data between your PC and an AS/400 host in an
FTP-style environment.

VT Emulates the DEC VT420 video terminal and includes support for
VT52,VT100, VT101, VT102, VT220, VT320, VT420, ANSI, SCO ANSI,
IBM 3151, and Linux Console.

Macro and Profile Converter Lets you convert Wall Data RUMBA,
Attachmate Extra!, or IBM P-Comm macros into Hummingbird Basic
macros. You can also convert Attachmate Extra! profiles into
HostExplorer session profiles.

5250 Data Transfer Wizard Lets you transfer files between a PC and a
5250 host. If you transfer a file from the host to your PC, you can specify
standard SQL statements to retrieve host data into the downloaded file.
For more information, see 5250 Data Transfer Wizard.

Deployment Packager Lets you create custom Package Assembly files
that define how package files (containing extra documents, data, and
applications) are deployed with the HostExplorer product. For more
information, see the Deployment Packager Help. This component
requires a separate installation. To install it, select Host Access Services
on the CD.

Deployment Wizard Lets you create or edit Deployment Projects that
describe everything you need to deploy HostExplorer from a web server.
You can also use Deployment Wizard to specify any existing package
files that should be deployed. This component requires a separate
installation. To install it, select Host Access Services on the CD.

Index Page Wizard Lets you create or edit HTML indexes that contain



links to multiple Deployment projects on a single web page. This
component requires a separate installation. To install it, select Host
Access Services on the CD.

Quick Script Editor Offers an easy way to automate tedious tasks such
as entering repetitive information into an order entry form, entering your
user name and password into a login screen, and uploading a report to
the server at a certain time every day. You do not require programming
knowledge to work with Quick Scripts.

Print Services Console Lets you distribute reports from host computers
to any LAN (local area network) printer in your enterprise network. This
component requires a separate installation. To install it, select Host
Access Services on the CD.



Hummingbird FTP

Hummingbird FTP lets you perform FTP transfers between your PC and
a host using Windows Explorer. It is a client implementation of the File
Transfer Protocol that lets you transfer both text (ASCII) and image
(binary) files between your PC and a remote computer that is running a
server implementation of FTP. You can also use it to perform file and
directory management on your PC and a remote computer. See
Hummingbird Neighborhood Help for more information.



HostExplorer Development Kit

You can customize the following HostExplorer applications using the
corresponding application programming interfaces (APIs) and available
scripts: HostExplorer, Hummingbird FTP, and WyseTerm.

HostExplorer Programming Help is available in the following location:
Program Files\Hummingbird\Connectivity\version\Ho:

This Help file is available only if you have installed the HostExplorer
Development Kit using Custom or Complete installation during Setup.



Overview—Session Profiles

To connect to a host, you must use a session profile. You can create
profiles, or you can use default session profiles (provided with the
HostExplorer product). A session profile contains default settings that
control session appearance and functionality, as well as information
needed to connect to a host (such as host domain name or IP address
and host terminal type). You can customize the default settings before or
after connecting to a host.

When you open HostExplorer, all session profiles are displayed in the
Open Session dialog box. If you attempt to connect to a host using a
default session profile (for example, Default 3270) you are prompted to
supply the host address before you can connect.

Related Topics
Connecting to a Host




Creating a Session Profile

To create a profile:

1.

In the Open Session dialog box, open the folder where you want to
store your profile.

Click the Create New Profile icon. The New Profile dialog box opens.

3. In the Profile Name box, type a name for your profile.

Note: A profile name cannot contain any of the following characters:\ / : * ?2 “ < >

In the Profile Type list, select a connection profile type. You can select
a display session profile (3270, 5250, or VT), a printer session profile
(3270 or 5250), or a profile template (which specifies the type as well
as other parameters for a new session profile).

You can set session profile options immediately, or you can create a
profile first and set the profile options later. To set profile options now,
use the Properties button. Do one of the following:

. Click Properties to open the Session Properties dialog box.

. Click the arrow to display a list of shortcuts to folders that are
appropriate for the connection profile type that you want to create.
Click a shortcut to go directly to the folder in the Session Properties
dialog box.

If you want to apply a theme to the new profile, select a pre-
configured or a custom theme in the Theme box. You can create
custom themes in the Session Profile dialog box.

In the Connect By list, select a connection method.

8. The next option varies depending on which connection method you

select. Provide connection information for the host to which you want
to connect in the Host Name/LU or Pool Name/Telephone
Number/Tunnel Profile box.

Note: If you select Secure Shell connection (available for VT connections only), enter a
tunnel profile name or browse to one.

The Secure Shell option is available only if you purchased and installed Connectivity
Secure Shell. For more information on securing a HostExplorer session with Secure



Shell, see the corresponding topic in the Connectivity Secure Shell Help.

9. Click Connect to establish a connection to the specified host when
you close the New Profile dialog box.

0. Click OK.

Related Topics

Connecting to a Host

Open Session Dialog Box
Overview—Connectivity Secure Shell




Using Templates

If an existing session profile contains settings that you want to use for
other profiles that you create later, you should save the profile as a
template. The settings saved in a template determine the properties of
new session profiles that template.

The Templates directory is a container for all templates and is, by

default, a subdirectory of the Profile directory where the user files are
stored on your machine. To access the User Files folder, double-click
the User Files shortcut in the Hummingbird Connectivity program group.

Any session profile that is in this Templates directory can serve as a
template for a new profile.

To create a template:
Do one of the following:

. In Hummingbird Neighborhood, right-click the HostExplorer session
profile that you want to use as a template. Copy the profile, and then
paste it in the Templates folder.

. In the Open Session dialog box, open the Templates folder and click
the New Profile button. Set the properties for the profile in the The
New Profile dialog box and click OK.

The session profile is now available as a template and appears in the
Profile Type list of the New Profile dialog box

To create a session profile based on a template:
1. In Hummingbird Neighborhood, open the folder in which you want to
store your new profile.

2. On the File menu, click New HostExplorer Profile. The New Profile
dialog box opens.

3. In the Profile Type box, select the template file on which you want to
base the new profile.

Note: The properties of the template you select automatically display in the New Profile
dialog box.



4. In the Profile Name box, type a name for the new profile.
5. Click OK.

The new session profile inherits the properties of the specified template.

To rename a template:

1. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Double-click the Templates folder to

open it.
2. Right-click the template and click Rename.
3. Modify the name of the template and press Enter.

Related Topics
Open Session Dialog Box
User Environment Customization




Managing Session Profiles

Use the Open Session dialog box to create, configure, open, rename,
move, copy, and delete profiles.

Note: You can also use the Open Session dialog box to open, rename, move, copy, and delete layouts
(saved working environments).

You can access session profile settings either before or after connecting
to a host.

Related Topics
Accessing Profile Settings
Open Session Dialog Box
Working with Layouts




Accessing Profile Settings

Session profile settings (located in the Session Profile dialog box) let you
customize components of the session window and customize the
functionality of HostExplorer features.

To access session profile settings before connecting:

1. Double-click a connection type in the HostExplorer program group.
The Open Session dialog box opens.

2. Right-click a session profile and click Properties. The Session Profile
dialog box opens.

3. Double-click a folder to access the settings you want to customize.

To access profile settings after connecting:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Double-click a folder to access the settings you want to customize.

Related Topics
User Environment Customization




Saving Session Profiles

While connected to the host, you can update and save the most recent
changes made to the current session profile, or you can rename the
profile to create a new one.

When you close a session, the Save Profile On Window Close setting
saves any changes you made to the session profile (by default). If you
want to experiment with settings without the risk of saving them when you
exit, you can clear the Save Profile On Window Close option.

To save a profile:

1. On the File menu, select Save Session Profile. The Save Profile
dialog box opens.

2. Do one of the following:

. To save the changes to the current session profile, click Save.

. To save the settings as a new session profile, type a new name
and click Save.

Related Topics
Save Profile Dialog Box




Removing the Save Profile on Window Close
Function

When you close a session, the Save Profile On Window Close setting
saves any changes you made to the profile (by default). If you want to

experiment with settings without the risk of saving them when you exit,
you can clear the Save Profile On Window Close option.

To change the save setting:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Session Window folder and click the General category.
3. Clear the Save Profile On Window Close option.

Note: After you clear this setting, you must click Save Session Profile on the File menu to
save any changes before closing your session.

Related Topics
Session Window Folder—General Category




Organizing Session Profiles
You can organize session profiles by moving, copying, renaming, or
deleting session profiles or folders.

Tip: To select multiple items, hold down the Shift or Ctrl key while
clicking profiles or folders.

To create a new folder:

1. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Right-click an empty area of the pane.
From the context menu, click Create New Profile Folder.

2. A new folder appears with a temporary name. Type a name for the
new folder and press Enter.

To move, copy, rename, or delete a session profile or folder:

1. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Right-click the session profile or folder.

2. Using the context menu, perform one of the following actions on the
selected profile or folder:

. To move it, click Cut. To copy it, click Copy.Open the destination
folder and click Paste.

. To rename it, click Rename. Type the new name and press Enter.
Note: A profile name cannot contain any of the following characters: \/: * ? “ <> |

. T0 delete it, click Delete. Click Yes to confirm the deletion.



Working with Layouts

HostExplorer lets you work with multiple sessions at one time. If you have
a working environment that you use frequently (known as a layout), you
may want to save it to a file so that you can re-use it later. For example, if
you often work with four sessions placed at specific positions on the
computer screen, you can save this working environment as a layout.
The next time you open this layout, the four sessions appear in the same
positions as they were in when you saved them.

To save a layout:

1. Position and size your session windows so that they are ready to be
saved as a layout.

2. On the File menu of any session window, click Save Layout. The
Save Layout dialog box opens.

3. Inthe Selected Sessions area, select the sessions that you want to be
saved in the layout.

4. In the Folder area, navigate to the location in which you want to save
the layout and select a folder.

5. In the Layout Name box, type a name for the new layout.
6. Click Save.

To open a layout:
Do one of the following:

. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Select the layout that you want to open
and click Connect.

. On the File menu of a session window, click Open Layourt.

HostExplorer launches the sessions of the layout in the same position
and size as when they were saved.



Closing a Session

When you close a session, you are terminating the connection with the
host system. To ensure that you close any active processes on the host,
it is recommended that you log off before closing your session.

To close a session:

1. Log off from the host (recommended).

2. On the File menu, click Close Session.

3. Click Yes to confirm the session termination.



Connecting to a Host

After you create a session profile, you can connect to a host:

. From Hummingbird Neighborhood
. From the desktop
. From the command line

For information about creating a secure connection, see the “Securing
HostExplorer Connections” help book.

Related Topics
Overview—Session Profiles
Creating a Session Profile




Host Connections from Hummingbird
Neighborhood

To connect to a host from Hummingbird Neighborhood:

1. On your desktop, double-click the Hummingbird Neighborhood icon to
launch Hummingbird Neighborhood.

2. Double-click the profile that is configured for the host to which you
want to connect.

When the host logon screen displays, you can log on and start working.

Note: You can automate a connection by creating a shortcut on the desktop and then double-clicking
it.

Related Topics
Overview—Session Profiles




Opening Multiple Sessions in the Same Window

HostExplorer lets you maintain multiple host connections simultaneously
in the session window. Only one session is visible at a time.

Note: You can open sessions to different terminal types in the same window.

To open multiple sessions in the same window:

1. In Hummingbird Neighborhood, double-click a profile to open a
connection to a host.

2. On the File menu, click Open Session in Same Frame. The Open
Session dialog box opens.

3. Double-click a HostExplorer session profile. The session displays in
the original window.

4. To switch views between sessions, select a different session from the
Window menu.

Note: Printer controls do not open in the same session window.

Related Topics
Host Connections from Hummingbird Neighborhood
File Menu




Host Connections from the Desktop

To connect to a host from the desktop:

1.

On the desktop, double-click Hummingbird Connectivity.

2. Double-click HostExplorer.
3.
4. Double-click the profile that is configured for the host to which you

Double-click 3270, 5250, or VT. The Open Session dialog box opens.

want to connect.

When the host logon screen opens, you can log on and start working.

Related Topics

Open Session Dialog Box
Overview—Session Profiles

Connection Folder—TN3270 Category

Connection Folder—TN5250 Category

Connection Folder—Telnet Category




Host Connections from the Command Line

To connect to a host from the command line:

1. On the Windows Start menu, click Run.

2. In the Run box, type the full path to the HostExplorer executable file,
enclosing it in quotation marks. For example, the default path is:

C:\Program Files\Hummingbird\Connectivity\versic

where version is the version number of your Hummingbird
product. You can click Browse to locate the executable.

3. Click OK.

4. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Double-click the profile that is
configured for the connection you want.

When the host logon screen opens, you can log on and start working.

Related Topics
Adding and Removing Shortcuts




Host Connections Using a Modem

To connect using a modem (VT only):

1.
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Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Click the Create New Profile button. The
New Profile dialog box opens.

In the Profile Name box, type a name for the new profile.
In the Profile Type list, select VT.
In the Connect By list, select Modem.

In the Telephone Number box, type the telephone number of the host
to which you want to connect.

Select Connect, and then click OK to close the New Profile dialog
box.

When the host logon screen opens, you can log on and start working.

Note: This procedure assumes that you have installed and configured a modem for the host that you

want to call. For modem installation instructions, refer to the Microsoft Windows documentation.

Related Topics
Open Session Dialog Box

Adding and Removing Shortcuts

Connection Folder—Modem Category




Connecting to Available Hosts

To automatically connect to an available host:

1. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Right-click a 3270, 5250, or VT profile
and click Properties. The Session Profile dialog box opens.

2. Expand the Connection folder and click the TN3270, TN5250, or
Telnet category.

3. In the Hosts area, click the Add New Host button to add the host(s)
that you want HostExplorer to use. You can click the Delete button to
remove a host from the list.

4. You can use the options in the List Retries area to specify how you
want HostExplorer to attempt to connect to an available host (for
example, the number of re-connect attempts or the delay between
them).

5. Click OK.
HostExplorer attempts the connections according to the order of the host

names in the list. To re-position the hosts in the list, you can click the
Move Up or Move Down button.

Related Topics

Open Session Dialog Box

Add New Host Dialog Box

Connection Folder—TN3270 Category
Connection Folder—TN5250 Category
Connection Folder—Telnet Category




3270 Special Connections
You can establish communication with a 3270 mainframe using one of
the following products:

. Microsoft SNA Server
. Novell Netware for SAA




Disconnecting from a Host

You can disconnect from a host by clicking Disconnect on the File menu.
Before disconnecting, log off the host system.

If the host system disconnects unexpectedly, you can use the default
disconnect setting, Keep Session Window Open, to keep the session
window open when the session is terminated. You can also change the
disconnect options. For information on how to change this and other
disconnect actions, see the next topic.

Related Topics
Connection Folder—Other Category
Connecting to a Host




Changing the Disconnect Action

You can control how your session responds to an unexpected
disconnect.

To change the disconnect action:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Connection folder and click the Other category.

3. In the Upon Disconnect From Host list, click one of the following
options:
. Close Session Window
. Keep Session Window Open
. Restart Session
. Show ‘Open Session’ Dialog

Related Topics
Connection Folder—Other Category




Overview—Hummingbird Connectivity Kerberos

Kerberos is a security authentication protocol developed at MIT. The
protocol provides a secure means of communication between two parties
across an insecure network. In general, the communication is between a
user and a remote service.

To communicate securely, each party proves its identity to the other using
a pair of encrypted credentials that a third party, the Kerberos service,
generates through symmetric cryptography. In effect, each party serves
as the other's authentication agent. Only the user, remote service, and
Kerberos service know the keys necessary to decrypt the credentials.
The protocol, therefore, prevents a third party from impersonating either
of the original parties.



Kerberos Participants

The Kerberos protocol involves the actions of five participants, as follows:
User—The person who initiates communication with a remote service.

Client—The software that communicates with the service on behalf of
the user. In the case of HostExplorer, there are actually two clients in
operation:

. The Kerberos client—retrieves your credentials from the Kerberos
service and sends them to the remote service for authentication

. HostExplorer—communicates with the remote services once the user
has been authenticated

Remote Service—The service on the remote host that communicates
with the client. HostExplorer, for example, communicates with the Telnet
service.

Kerberos Client—The service that generates the credentials for the user
and the remote service. The service can be Hummingbird Connectivity
Kerberos or MIT Kerberos.

Key Distribution Center (KDC)—Also known as the Kerberos server.
Both the Authentication Server (AS) and the ticket-granting server (TGS)
run on the KDC. The AS stores the authentication information for every
principal in the Kerberos realm. Kerberos uses this information to
generate credentials. The TGS grants service tickets to clients who need
them to communicate with their server.



Ticket-Granting Process

To access a server that is configured for Kerberos, the client
(HostExplorer) needs to provide this server with a ticket which verifies
your identity.

The ticket-granting process is as follows:

1.

HostExplorer sends a request to the Authentication Server (AS) for a
ticket-granting ticket (TGT).

The AS returns a TGT to HostExplorer, which provides HostExplorer
with access to the TGS. The TGT is used by HostExplorer to obtain
service tickets from the TGS without having to provide a password
each time it wants to connect to a kerberized service.

HostExplorer sends a request to the TGS for a service ticket. The
request is appended with the TGT received from the AS.

The TGS uses the TGT to verify HostExplorer's identity, and then
issues a ticket to HostExplorer for the desired service.

HostExplorer sends the service ticket to the server. The server either
rejects the ticket or accepts it. If the server accepts the ticket, then the
user is considered authenticated and the connection is successful.

Because the server ticket is timestamped, HostExplorer can make
additional requests to the server using this same ticket for a certain time
period (usually 8 hours) without having to be re-authenticated. Therefore,
an attacker who happens to capture the ticket cannot use it after the
ticket expires.

For more information about Kerberos security, go to:

http://web.mit.edu/kerberos/www/



http://web.mit.edu/kerberos/www/

Configuring the Kerberos Client

To use Kerberos to secure communication between HostExplorer and the
server, you need to install Hummingbird Connectivity Kerberos or MIT
Kerberos client.

You also need to configure the Kerberos client for your Kerberos realm.
Therefore, when you enter your user name at authentication time,
Connectivity Kerberos automatically appends your default realm.

Note: The host administrator needs to provide you with this previously defined Kerberos realm. Also,
the administrator should provide you with the server address of the KDC.

For more information about configuring the Kerberos client and retrieving
a ticket-granting ticket (TGT), see the Connectivity Kerberos Help.
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Overview—Connectivity Secure Shell

Connectivity Secure Shell is a client implementation of the Secure Shell
protocol (SSH-2). It was developed by Hummingbird to provide additional
security for the existing suite of Hummingbird Connectivity products.

In addition to Secure Shell 2 support, Connectivity Secure Shell offers
support for SSL-enabled HostExplorer TN3270, TN5250, and VT
sessions, as well as for Connectivity Kerberos, Hummingbird’s
implementation of the Kerberos 4 and 5 protocols.

Note: This feature is available only if you have Connectivity Secure Shell installed. For more
information, see Connectivity Secure Shell Help.

Related Topics
Creating a Session Profile
New Profile Dialog Box




Overview—Hummingbird Connectivity SSL

Secure Socket Layer/Transport Layer Security (SSL/TLS) protocol
provides encryption of all traffic between HostExplorer sessions and a
server. Specifically, the SSL/TLS protocol secures the communication
between the client (HostExplorer) and the server (for example, VT) by
providing the following:

. Server authentication—Proves the identity of the server.

. Client authentication—Proves the identity of the client (optional).

. Encryption—Ensures that the transmission of communication
between the server and the client cannot be read by a third party.

SSL was first put forward as a transport protocol. The last draft of SSL
V3.0 was published in November 18, 1996, and is available at the
following web site:

http://home.netscape.com/eng/ssl13/draft302. txt

The most recent version of the TLS protocol as the successor to SSL
V3.0 is RFC2246 which is available at the following web site:

http://www.ietf.org/rfc/rfc2246.txt

For information on how key encryption is used to secure HostExplorer
communication through SSL/TLS, see the “Encryption/Decryption” topic »

Related Topics
Generating Self-Signed Certificates
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Negotiating SSL/TLS Communication

The telnet connection is made first when an SSL/TLS HostExplorer
session initiates communication with a server that supports SSL/TLS.
During this process, HostExplorer and the server negotiate how to carry
out the server (and possibly the client) authentication. They also agree on
a common key for symmetric encryption using the key exchange
algorithm.

Note: The actual sequence of negotiation depends on the server and client configuration.

The SSLI/TLS negotiation occurs as follows:

1.

HostExplorer sends an initial SSL/TLS “client hello” message to the
server.

The server responds with a “server hello” message to HostExplorer.

3. The server sends its certificate to HostExplorer. The certificate can be

validated with a digital signature by computing and then encrypting a
message digest. The certificate can be signed by a certificate
authority (CA) or it can be self-signed.

The server may also send a request for a user certificate
depending on the security of the server.

HostExplorer uses the public key of the server certificate to
decrypt the message digest. HostExplorer re-computes the digest
using the encryption algorithm specified in the digital signature and
compares the two digests. If the two digests are the same, then it
proves that the certificate was not modified during the
transmission. Therefore, it can be trusted.

After several other SSL/TLS messages, HostExplorer and the
server agree on a common key to be used in subsequent
communications using symmetric encryption, as well as the
symmetric encryption algorithm itself.

Related Topics
Security Folder—SSL/TLS Category
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Verifying the Success of SSL/TLS Negaotiation
Generating Self-Signed Certificates




Initiating SSL/TLS Connectivity

There are two ways to initiate SSL/TLS connectivity when the client
connects to the server:

. Start the SSL/TLS negotiation when the server accepts the
connection.

. Negotiate Transport Layer Security (TLS) through Telnet as the first
step, and then start SSL/TLS negotiation.

The success of your connection to the server depends on whether or not
the server to which you are connecting is configured to negotiate TLS
options through Telnet. For example, if you configure HostExplorer to skip
Telnet negotiation, but the server is set for Telnet negotiation, then the
server will close the connection. On the other hand, if you configure
HostExplorer to negotiate through Telnet, but the Telnet negotiation
option is disabled on the server, then HostExplorer may time out, causing
the connection to fail.

It is recommended that you consult your administrator for the option
setting on the server before you configure the HostExplorer session
profile for SSL/TLS connectivity.

To initiate SSL/TLS connectivity:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Security folder, and click the General category.
Select the SSL/TLS option.
Click the SSL/TLS tab.

Select the version of the SSL/TLS protocol that you want to use or
proceed to the next step to accept the default.
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6. Do one of the following:

. Clear Negotiate Via Telnet to start the negotiation immediately.

. Select Negotiate Via Telnet to negotiate TLS through Telnet and
then start the negotiation.




Related Topics
Negotiating SSL/TLS Communication
Verifying the Success of SSL/TLS Negaotiation




Verifying the Success of SSL/TLS Negotiation

Both HostExplorer and the server must agree on the encryption and
decryption algorithm that they will use to exchange data. If the SSL/TLS
negotiation succeeds, then the connection to the server is secure. If the
negotiation fails, the connection to the server is not secure and may fail.
In this case, you should disconnect from the server.

Note: The way in which the server reacts when the negotiation fails depends on the server
configuration. Usually, servers are configured to close the connection if the negotiation fails.
However, it is possible on UNIX systems to drop down to an unsecured connection.

HostExplorer provides the following features that can be used to help you
verify your secure connection status:

. Disconnecting if the SSL/TLS negotiation fails

. Session window title identifiers

. Lock icon in the status line

The next three Help topics describe how to determine if the connection is
secure.

Related Topics

Disconnecting if the SSL/TLS Negotiation Fails
Display Folder—3270 General Category
Display Folder—VT General Category

Session Window Folder—General Category




Determining 3270 or 5250 Connection Security

The Operator Information Area (OIA) of the session window can help
determine if the 3270 or 5250 connection is secure.

To determine if the 3270 or 5250 connection is secure:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Display folder and click the General category.
3. In the OIA Line Mode list, select one of the following items:

. Terminal Style OIA Line
. Windows Style OIA Status Bar

4. Click OK.

5. Look at the setting displayed in the OIA of the session window after
the connection has been established. If you selected Terminal Style
OIA Line and the connection is secure, a key icon appears in the
bottom left-hand corner. If you selected Windows Style OIA Status Bar
and the connection is secure, a lock icon appears at the bottom left-
hand corner of the session window.



Determining VT Connection Security

The Operator Information Area (OIA) of the session window can help
determine if the VT connection is secure.

To determine if your VT connection is secure:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Display folder and click the General category.

3. In the Status Line Mode list, select one of the following items:

. Terminal Style Status Line
. Windows Style Status Bar

Click OK.

Look at the setting displayed in the OIA of the session window after
the connection has been established. If you selected Terminal Style
Status Line and the connection is secure, a key icon appears in the
bottom left-hand corner. If you selected Windows Style Status Bar and
the connection is secure, a lock icon appears at the bottom left-hand
corner of the session window.



Determining a Secure Connection Via the
Window Title

You can verify if the connection is secure by checking the encryption
status in the session window title.

To verify a secure connection:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Session Window folder and click the General category.

3. In the Window Title box, type %e which indicates the encryption
status.

4. Click OK.

5. Look at the title of the session window. If the connection is secure,
“Encrypted” appears in the window title. If the connection is not
secure, “Not Encrypted” appears in the window title.



Disconnecting if the SSL/TLS Negotiation Fails

If the negotiation fails, the connection to the server is not secure and may
fail. In this case, you should disconnect.

To disconnect from the server:

1.
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On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Security folder, and click the General category.
Select the SSL/TLS option.

Click the SSL/TLS tab.

Select Close Connection If SSL Negotiation Fails.

Click OK.



Selecting Cipher Suites

During cipher suite negotiation, HostExplorer and the server decide on a
cipher suite that they both can support. This includes:

. the key exchange algorithm (for example, Diffie Hellman)
. the encryption algorithm (for example, 3DES_EDE_CBC)
. the cipher suite that will used to transfer data

. the message digest used to determine whether the message was
altered

A breakdown of the cipher suite
TLS_DH_RSA_WITH_3DES_EDE_CBC_SHA is as follows:

. TLS—TLS-based cipher suite

. DH—uses the Diffie Hellman algorithm for key exchange

. RSA—uses RSA for authentication (server and possibly client)

. 3DES_EDE_CBC—uses the 3DES_EDE_CBC algorithm for
symmetric encryption

. SHA—uses the Secure Hash Algorithm (SHA) algorithm for message
digest calculations

HostExplorer offers a wide variety of cipher suites. The available ciphers
vary depending on the version of SSL/TLS that you are using (version 2,
3, or both).

Note: The server to which you are connecting may only support certain cipher suites. Therefore, if you
select specific cipher suites, and the server does not support any of them, the connection may

not be established. If this occurs, select all of the available cipher suites and retry the
connection.

To select a cipher suite to use for data encryption/decryption:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Security folder, and click the General category.
3. Select the SSL/TLS option.
4. Click the SSL/TLS tab.
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5. In the Version list, select the version of SSL/TLS that you want to use.

6. Click Select Cipher Suites. The SSL TLS Ciphers dialog box opens
corresponding to the SSL/TLS version that you specified.

7. By default, the Use Default Ciphers check box is automatically
selected. This indicates that you want to use only the default ciphers
available on your machine. However, you have the choice of selecting
specific ciphers.

Tip: If you want to select all the ciphers in the list, click Select All. To
clear the list, click Clear All.

8. Click OK.

Related Topics
SSL/TLS Ciphers Dialog Box




Overview—-Certificates

Once HostExplorer and the server decide on the encryption method used

for transmitting data, they send each other X.509 certificates. These
certificates are used to identify the server that you are communicating
with, and for the server to identify you (if you provide a user certificate).

Similar to a driver's license, which includes information that proves the
identity of the driver (such as name, address, signature, photo, and
official stamp), a certificate contains a collection of information used to
identify the person or organization that it represents. It includes the
following items:

. Subject—The name of the individual, server or other entity, as well as
the public key.

. Issuer—The name of the certificate authority (CA) that issued the
certificate.

. Period of Validity—The length of time for which the certificate is valid.

. Administrative Information—The version and serial number of the
certificate.

The information in a certificate is organized based on various encoding
rules (most of the data is binary). The certificates can be base-64

encoded so that they can be sent and received through e-mail. A viewer
utility is required to view and manipulate certificates.

Related Topics

Generating Certificate Requests
Generating Self-Signed Certificates
Importing Certificates
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Certificate Authorities

Certificates are digitally signed by a trusted third party (for example,
Verisign) known as a certificate authority (CA). With this type of
certificate, the client can trust it to be authentic. The certificate verification
involves a “chain of trust”—that is, although you cannot be sure that the
information provided to you by a host is true, if the information has been
signed (meaning that it has been previously verified and validated) by a
trusted CA, then you can trust the information.

The CA can either be public (a company that signs certificates for many
systems) or private (an authority set up by an organization to sign
certificates for their system only).

Tip: Certificates do not need to be signed by a third party—they can be
self-signed. For more information, see Generating Self-Signed
Certificates.

CAs are generally recognized by most software (that is, web browsers
and operating systems). CA certificates are built into the underlying
software. If this is not the case, their certificates can be downloaded from
web sites.

When the CA signs the certificate, a message digest is taken of the
information within the certificate. A message digest is a computed hash of
the message contents which appears at the end of the certificate when it
is digitally signed. This digest can be verified at any time by re-calculating
it and comparing the newly calculated value with the original message
digest. If the two digests match, then the message was not modified
between the time it was sent and the time it was received, thus
guaranteeing the integrity of the transmitted data.

The message digest is encrypted with the CA's private key using public
key cryptography, and is used to determine if the certificate was
tampered with.

Note: Ideally, all of the information in the certificate would be protected using public key cryptography;

however, this type of processing is inherently slow. Therefore, only the checksum value is
protected using this type of cryptography.
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Private Certificate Authorities

An organization can set up its own private certificate authority (CA)
recognized only by it's own networks. The CA signs certificates only for
the organization. The private CA generates its own root certificates and
distributes them to the machines belonging to the organization. However,
for HostExplorer to use these root certificates for SSL/TLS
communication, it must have access to them.

Note: The advantage of having your certificates signed by a recognized third party (for example,
Verisign) is that when you install the operating system or web browser, the root certificates
corresponding to the recognized CAs are installed automatically.

Private CAs can sign server certificates generated by system
administrators. They can also sign user certificates generated by
individuals within the organization.
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About Certificates and Keys Manager

Certificates and Keys Manager is a centralized repository and
management tool for keys and certificates that reside in the Hummingbird
certificate and key store.

Certificates and Keys Manager lets you manage keys and certificates for
use with Secure Shell and SSL connections initiated with a number of
Hummingbird Connectivity products including Exceed, HostExplorer,
Hummingbird FTP, and classic FTP. You can perform the following tasks:

. view information about your keys

. view information about your certificates

. generate user keys

. generate certificate requests

. generate self-signed certificates

. Import and export keys

. Import and export certificates

Related Topics
Security Folder—SSL/TLS Category




Viewing Key Information

Keys are grouped by type in the left pane of the Certificates and Keys
Management Console:

. User Keys—Click to view a list of the user keys contained in the
my . hks file. These are keys that you either created or imported.

. Server Keys—Click to view a list of the server keys imported into the
server.hks file.

Note: Changing .hks files manually is not recommended.

To view the details of a user or server key:

Click the key type in the left pane, and then, in the list pane that appears
on the right, double-click the key to open the Key Information window.

Related Topics
Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity SSL




Viewing Certificate Information

Certificates are grouped by type in the left pane of the Certificates and
Keys Management Console:

. User Certificates—Click to view the user certificates stored in the
my . hcs file. These certificates were either created or imported by

you, and signed by CAs or system administrators.

. Server or Intermediate Certificate Authorities—Click to view the
certificates stored in the ca. hcs file. These certificates belong to the
commercial or private Certificate Authorities (CA) that are below the
root CAs in the certificate chain.

. Trusted Root Certificate Authorities—Click to view the certificates
stored in the root . hcs file. These certificates belong to the top-level
(or parent) CAs who sign their own certificates. Generally, they
establish trust by publishing their public keys widely.

Note: Changing .hcs files manually is not recommended.

To view the details of a certificate:

Click the certificate type in the left pane, and then, in the list pane that
appears on the right, double-click the certificate to open the Certificate
Information window.

Related Topics
Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity SSL




Generating Private/Public Keypairs

Part of the process of generating a certificate is to create a private/public
keypair. You can also use these keys on their own for authentication and
encryption. Keypairs are stored on your machine and protected by a
passphrase that will be necessary to open and use them.

Tip: You can use one key for multiple certificates.

You can create keys before you generate the certificate, and then select
the keys during the certificate generation process. Otherwise, you can
create the keys as part of the certificate generation process itself. In
either case, you will use the Key Generation Wizard to create the keys.

To create a private/public keypair:

1. Open the Key Generation Wizard by clicking User Keys in the left
pane of the Certificates and Keys Management Console, and then
clicking the Create New Key button at the bottom of the key pane.

2. Click Next on the welcome screen. The Key Parameters screen
opens.

3. Provide the necessary information and click Next. The wizard
generates the key.

Note: Depending on the size of the key to be generated and the speed of your CPU, the
key generation process may take some time.

Click Finish. The key is displayed in the key pane and saved in the
my . hcs file located in the certs directory where the user files are stored

on your machine. To access the User Files folder, double-click the
User Files shortcut in the Hummingbird Connectivity program group.

4. Click Close.

Related Topics
Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity SSL




Generating Certificate Requests

If you do not want to use a self-signed certificate, you can request a
certificate from a certificate authority (CA). A certificate request contains
personal information describing the individual requesting the certificate.
This certificate request is sent to the appropriate certificate authority or
security administrator who, in turn, sends you a signed certificate.

To generate a certificate request:

1.

Open the Certificate Creation Wizard by clicking User Certificates in
the left pane of the Certificates and Keys Management Console, and
then clicking the Create New Certificate button at the bottom of the
certificate pane.

On the Wizard Type drop-down list, select Create A Certificate
Request.

Click Next on the welcome screen. The Certificate Information screen
opens.

Provide the required information and click Next.
Do one of the following:

. If you have already created a keypair, select it from the User Keys
list, and type the passphrase for the selected key. You can use the
buttons below the User Keys list to view key details and change the
passphrase.

. If you have not created a keypair, click the Create New Key button
and use the Key Generation Wizard to create a keypair. For more
information, see Generating Private/Public Keypairs.

Click Next. The wizard generates the certificate request. The public
key part of the private/public key combination you specified is stored
into the certificate.

Click Finish.

8. The certificate is listed in the certificate pane, and the request is now

saved in the my . hcs file located in the certs directory where the
user files are stored on your machine. Use the Export button to export



the certificate to . pem format.

9. Manually forward the . pem exported request to the appropriate CA
(for example, a commercial CA such as a Verisign or your
organization's private CA) or to your security administrator. You can
send the certificate request through e-mail.

When you receive the signed certificate (for example, the user certificate
or a new root certificate), you must update the certificate request with the
certificate you received. To do so, double-clicking your original certificate
request in the right pane of the console. In the Certificate Information
dialog box, click Update. In the Open dialog box, select the file where you
saved the response from the CA and click Open.

Related Topics
Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity SSL




Generating Self-Signed Certificates

Self-signed certificates are certificates in which the subject and the issuer
are the same, and there is no independent means of verifying the
trustworthiness of the certificate, as is the case with Root certificates.
They are ideal if you need a certificate to test whether or not the
connection works. Also, an organization might want to store user
information in a certificate, but it may not want (or need) this certificate
information to be validated. Self-signed certificates can also be used for
authentication and authorization on a private network.

For example, when connecting to a host, the host must provide a
certificate, and this certificate can be self-signed (and then exported) by
the server administrator. If there is no doubt as to the validity of this
information and your application is configured to accept self-signed
certificates, then the self-signed certificate are sufficient.

To create a self-signhed certificate:

1. In the Certificates and Keys Management Console, open the
Certificate Creation Wizard by clicking User Certificates in the left
pane of the console, and then clicking the Create New Certificate
button at the bottom of the certificate pane.

2. On the Wizard Type drop-down list, select Create A Self-Signed
Certificate.

3. Click Next on the welcome screen. The Certificate Information screen
opens.

4. Provide the required information and click Next.
5. Do one of the following:

. If you have already created a keypair, select it from the User Keys
list, and type the passphrase for the selected key. You can use the
buttons below the User Keys list to view key details and change the
passphrase.

. If you have not created a keypair, click the Create New Key button
and use the Key Generation Wizard to create a keypair. For more
information, see Generating Private/Public Keypairs.




6. Click Next. The wizard generates the certificate. The public key part of
the private/public key combination you specified is stored into the
certificate.

7. Click Finish.

8. The certificate is encoded and listed in the certificate pane. It is saved
in the my . hcs file located in the certs directory where the user files

are stored on your machine.

Related Topics
Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity SSL




Modifying Keys and Certificates

Generally speaking, keys and certificates are not editable. However,
different types of keys and certificates do allow you to alter certain

parameters.



Changing the Passphrase for a User Key

Select User Keys in the left pane. In the list pane, select the key and click
the Change Passphrase button to open the Change Passphrase dialog
box.



Changing the Host Identification of a Server Key

Select Server Keys in the left pane. In the list pane, select the key and
click the Change Host Identification button to open the Change Host
Identification dialog box. Provide the required information. If you do not
know the IP address of the specified host, click Get IP.



Enabling Cryptographic Service Providers

A cryptographic service provider (CSP) is an independent software
module that performs cryptography algorithms for authentication,
encoding, and encryption. The Certificates and Keys Management
Console retrieves the list of installed CSP modules from your registry and
uses only the ones you have selected from the Select Cryptographic
Service Providers dialog box. Normally, the defaults should not be
changed; the providers selected by default are the only ones you will
likely use. It is possible, however, to try an unsupported provider, or to
temporarily disable a certain provider in order to stop using certificates
from that provider.

To access the cryptographic service provider settings, select User
Certificates in the left pane and click the Cryptographic Service Providers
button. The Select Cryptographic Service Providers dialog box opens.
You may use the dialog box to filter the list of user certificates by
selecting or disabling providers.



Importing and Exporting Keys

Hummingbird key store files (. hks) are repositories for the keys you
create or import. User keys are comprised of a public/private key pair and
are stored in the my . hks file. Server keys are public keys only and are
stored in the server . hks file. These files are located in the Certs

directory where the user files are stored on your machine. When you
import or export either type of key, you do so to and from these files.

Note: Modifying key files manually is not recommended.

To import a key to the user or server key store:

1. Under Keys, in the left pane of the Certificates and Keys Management
Console, click the key store (User Keys or Server Keys) into which
you want to import a key.

2. Click the Import button.

3. In the Open dialog box, locate and select the keypair you want to
import. By default, Connectivity Secure Shell auto-detects all key
formats, but you can specify the following file filters:

. Hummingbird HKS Files (*.hks)—Lists Hummingbird key stores.
. PEM Files (*.pem)—Lists OpenSSL-derived keys.

. SSH2 Public Key Files (*.pub)—Lists OpenSSH and SSH2 public
key formats.

4. Click Open.
5. If you are prompted, type the passphrase for the selected key.

The key is added to the key store and is displayed in the list pane of the
console. If you imported an * . hks file, the keys it contains are extracted

and added to the my . hks or server . hks store.

Note: If the imported key does not appear in the list pane, right click in the pane and click Refresh in
the pop-up menu.

To export a key from the user or server key store:
1. Under Keys, in the left pane of the Certificates and Keys Management



Console, click the key store (User Keys or Server Keys) from which
you want to export a key.

2. From the list that appears, select the key you want to export, and click
the Export button. The Save As dialog box opens.

3. Use the Save In drop-down list to specify the target location for the
key.
4. In the File Name box, specify a key name.

5. In the Save as Type box, specify the format to which you want to
export the key:

. Hummingbird HKS Files (*.hks)—Exports the public and, in the
case of user keys, the private portion of the selected key to a
Hummingbird key store file.

. PEM Files (*.pem)—Exports the public and, in the case of user
keys, the private portion of the selected key to a . pem file.

. SSH2 Public Key Files (*.pub)—Exports the public portion of the
specified key as an SSH2 public key.

. OpenSSH Public Key Files (*.pub)—Exports the public portion of
the specified key as an OpenSSH public key.

6. Click Save.

Related Topics
Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity SSL




Uploading Public Keys

Hummingbird Key Upload Wizard lets you upload public keys to a host
for public key authentication. You can access the wizard from the
Certificates and Keys Management Console, or from the Certificate
Creation Wizard while creating a certificate.

To upload a public key to a host:

1. Under Keys, in the left pane of the console, click User Keys.

2. In the right pane, right-click the key you want to upload, and click
Upload on the pop-up menu. Hummingbird Key Upload Wizard opens.

3. Click Next on the welcome screen, and provide the required
information on each subsequent screen. For more information on a
particular screen, click Help.

Related Topics
Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity SSL




Importing and Exporting Certificates
The Hummingbird certificate store is comprised of three files. Each stores
a specific type of key:

. My . hcs stores user certificates.

. ca.hcs stores server certificates are certificates from intermediate
certification authorities.

. root.hcs stores certificates from trusted root certification authorities

These files are located in the Certs directory where the user files are

stored on your machine. When you import or export a certificate, you do
so to and from these certificate stores.

For procedural information, select the task you want to perform:

. Importing Certificates
. Exporting Certificates

Related Topics
Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity SSL




Importing Certificates

In order for a certificate to be sent to the server during connection
negotiation, you need to install it by importing it to your Hummingbird
certificate store. The certificate you import may be any of the following:

. & new or updated root certificate that is sent to you from a system
administrator

. a root certificate installed with your Windows operating system, that
you deleted and need to re-import

. a signed user certificate that is sent to you by your system
administrator or certificate authority (CA) as a result of your submitted
certificate request

To import a certificate:

1. Under Certificates, in the left pane of the console, click the certificate
store into which you want to import a certificate.

2. Click the Import button.

3. In the Open dialog box, locate the certificate you want to import. You
can select one of the following file filters in the Files Of Type drop-
down list:

. Hummingbird HCS Files (*.hcs)—Lists Hummingbird certificate
stores.

. X.509 Certificate (*.cer, *.crt, *.der, *.pem)—Lists different
variations of X.509 certificates.

. PKCS#12 (*.p12, *.pfx)—Lists different variations of PKCS#12 files.
4. Click Open.

Note: If the imported certificate does not appear in the list pane, right click in the pane and
click Refresh in the pop-up menu.

Related Topics
Security Folder—SSL/TLS Category
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Exporting Certificates

You can export certificates currently saved in the Hummingbird certificate
store in order to distribute them to other machines. This is necessary if,
for example, you generate a self-signed certificate for a user or for a host
machine on the network, or if you want to connect to a host from a
machine other than the one on which the certificate resides.

To export a certificate:

1. Under Certificates, in the left pane of the Certificates and Keys
Management Console, click the certificate store from which you want
to export a certificate.

2. In the list pane, select the certificate you want to export.
3. Click the Export button.

4. In the Save AS dialog box, use the Save In drop-down list to specify
the target location for the certificate.

5. In the File Name box, specify the certificate name.

6. In the Save as Type box, specify the format to which you want to
export the certificate:

. Hummingbird HCS Files (*.hks)—Exports the certificate to the
Hummingbird certificate store file (my.hcs, ca.hcs, or root.hcs
depending on the type of certificate).

. Base-64 Encoded X.509 (*.cer)—Exports a base-64-encoded,
X.509-format certificate file.

. DER Encoded Binary X.509 (*.cer)—Exports a DER-encoded,
binary X.509-format certificate file.

7. Click Save As.

Related Topics
Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity SSL




Overview—Transferring Files

This section describes how to transfer files between your PC and
mainframe, AS/400, and UNIX systems.

. Mainframe transfers—To transfer mainframe data, use Telnet.
HostExplorer uses proprietary protocols with the TN3270 connection.
Transfers are initiated from within the session.

. 5250 transfers—To transfer unstructured data, use Hummingbird FTP.
These transfers are initiated from within Hummingbird Neighborhood.
To transfer structured data, use either 5250 Data Transfer in
Hummingbird Neighborhood or the 5250 Data Transfer Wizard.

. VT transfers—To transfer VT data, use Telnet or Hummingbird FTP.
For Telnet transfers, HostExplorer uses protocols, such as Xmodem,
Ymodem, Zmodem, and Kermit. These transfers are initiated from
within the Telnet session. Hummingbird FTP transfers are initiated
from an FTP session within Hummingbird Neighborhood.

For mainframe and VT transfers, you can use either your hard drive or
Clipboard as the source or destination for the transferred data. If you use
Clipboard as the destination when you download host data, you can then
paste the data directly to a Windows application.



Transferring Files to a Mainframe

The INDS$FILE protocol lets you transfer files between a PC and CMS,
TSO, and CICS host systems. You can manage single or multiple file
transfers by creating a list in the Transfer List area of the file transfer
dialog box.

Tip: For more information, see the Upload To Host or the Download
From Host dialog box descriptions in the HostExplorer Help.

To transfer files to a mainframe:

1.

On the Transfer menu, click Send File to Host. The Upload To Host
dialog box opens.

In the Source list, click either Disk or Clipboard, depending on where
the data currently resides.

In the Scheme list, select one of the available file transfer schemes.

In the Local File Name box, type the name of the file you want to
upload or browse to its location.

In the Host File Name box, type the name of the file you want to
create on the host.

The next option varies according to the scheme that you select (CICS,
CMS, or TSO). If you selected CMS or TSO, enter the intended
mainframe location for the file in the Minidisk or Dataset box.

Click Templates to open the File Transfer Name Templates dialog box,
which lets you specify a template to use to format the file. Click OK
when finished.

Click Options to open the Session Profile dialog box, which lets you
configure the file transfer settings. Click OK when finished.

To start the transfer, click Send. To stop the transfer, click Stop. To
cancel the transfer, click Cancel.

The Transfer List area displays such attributes as name, status, and
progress of transfer files. You can add, remove, update and copy transfer
files using the buttons under the list.




Related Topics
Upload to Host Dialog Box
Download from Host Dialog Box




Receiving Files from a Mainframe

The INDS$FILE protocol lets you transfer files between a PC and CMS,
TSO, and CICS host systems.

To receive files from a mainframe:

1.

8.

On the Transfer menu, click Receive File from Host. The Download
From Host dialog box opens.

In the Host File Name box, type the name of the file you want to
download from the host.

In the Destination list, click either Disk or Clipboard as the download
destination.

In the Scheme list, select one of the available file transfer schemes.

In the Local File Name box, specify a path to the file you want to
create or overwrite on your PC, or browse to its location.

If you want to use a template to format the file, click the Templates
button and specify a template. Click OK when finished.

If you want to change the options associated with the file transfer
session profile, click Options to open the Session Profile dialog box.
Click OK when finished.

To start the transfer, click Receive. To stop the transfer, click Stop.

The Transfer List area displays such attributes as name, status, and
progress of transfer files. You can add, remove, update and copy transfer
files using the buttons under the list.

Related Topics
Download from Host Dialog Box




Transferring Files to and from AS/400

There are three methods of transferring files between your PC and an
AS/400 system. The method you use depends on the type of data you
want to transfer.

. Hummingbird FTP—Transfer unstructured data.

. 5250 Data Transfer—Transfer structured data in an FTP-style
environment.

. 5250 Data Transfer Wizard—Transfer structured data and use SQL
statements to select and arrange data.



Hummingbird FTP

Hummingbird FTP, included with HostExplorer, lets you connect to an
FTP server running on the AS/400 system and transfer the necessary
files. To launch FTP, go to the Hummingbird folder in Hummingbird
Neighborhood. For more information on how to transfer files using FTP,
see the Hummingbird Neighborhood Help.



5250 Data Transfer

5250 Data Transfer is accessible through Hummingbird Neighborhood. It
provides FTP-style file management, letting you transfer one or more files
by dragging and dropping the files between the remote host and the local

file system. For more information, see the Hummingbird Neighborhood
Help.



5250 Data Transfer Wizard

The 5250 Data Transfer Wizard consists of dialog boxes that let you
configure the settings for a file transfer profile. You can use the wizard to
create a profile from scratch or create one based on an existing profile.
You can use the Execute button to perform a transfer at any stage of the
wizard process. (The Execute button is available only when you have
provided the minimum information required to perform a transfer.)

When the profile is complete, you can choose to begin the data transfer
process immediately, or to save the transfer wizard profile. If you are
transferring files from a host to your PC, you can also use the wizard to
specify additional parameters for the SQL statement for the transfer.

To launch the 5250 Data Transfer Wizard:

1. On the Windows Start menu, navigate to the HostExplorer program
group and click 5250 Data Transfer Wizard. The Welcome page of the
wizard opens.

2. Do one of the following:

. To use an existing transfer profile, select Use Saved 5250 Data
Transfer Wizard Profile. Specify a path to the file or browse to its
location.

. To create a new profile, click Next.

Related Topics
Overview—Transferring Files
5250 Data Transfer Wizard—Welcome Page




Transferring Files to and from VT

To transfer files between your PC and a VT host, the host computer must
support Xmodem, Ymodem, Zmodem, or Kermit protocols. These
protocols consist of a set of file transfer rules that your PC and the host
system follow when transferring files.

Tip: To stop a transfer, click Cancel in the file transfer dialog box.

Before you can transfer files between your PC and a VT host, you require
the following information:

. the transfer protocol the host supports

. the transfer information the host requires

. the required command to initiate the host's transfer program—the
command you use (SZ, RZ, SX, RX, Kermit) is system-specific

Related Topics
Overview—Transferring Files
Transferring Files to a VT Host
Receiving Files from a VT Host




Protocols

Zmodem The most efficient file transfer protocol. It provides faster file
transfers, auto-download capabilities, batch file transfers, and protection
for 16-bit and 32-bit Cyclical Redundancy Check (CRC). It also allows
both the sender and the receiver to initiate file transfers. Additionally, it
provides security between program applications while eliminating file-
transfer errors.

Xmodem This file transfer protocol includes Xmodem-1K. File transfers
with Xmodem require that each byte sent must remain unchanged and
that the transfer must occur on a clear 8-bit channel. Data is transferred
in 128-byte or 1024-byte (1K) packet sizes. Each packet is assigned a
packet number and sent one at a time. Because packet sizes have fixed
lengths, a file using padded bytes is rounded up to the next packet. For
error detection, sent packets include Checksum or CRC bytes. Packets
are sent in sequence, allowing the receiver to verify if a packet was sent
or if it is out of order.

Ymodem This file transfer protocol supports batch file transfers and can
send the file name and file size before the actual file data.

Kermit The least efficient file transfer protocol. Use it when the receiver
does not support X/Y/Zmodem software. Kermit sends batch files with the
name and time stamp of each file in small packet sizes. The packets
contain fields that mark their beginning, length, type, and sequence
number.



Transferring Files to a VT Host

To transfer files to a VT host:

1. On the VT host, initiate the host transfer program. For more
information, see the documentation for your host file transfer utility.

2. On the Transfer menu, click Send File To Host. The Upload Files
dialog box opens.

3. Click Add Files and browse to the location of your files.
4. Select one or more files and click Open.

5. In the Protocol list in the Upload Files dialog box, click the supported
protocol for the file transfer.

6. Click Options to modify transfer options.
7. To start the transfer, click OK.



Receiving Files from a VT Host

To receive files from a VT host:

1.

On the VT host, initiate the host transfer program. For more
information, see the documentation for your host file transfer utility.

On the Transfer menu, click Receive File From Host. The Download
Files dialog box opens.

In the Receive Path box, specify a path. Click the Browse button to
locate a file.

In the Protocol list in the Download Files dialog box, click the
supported protocol for the file transfer.

Click Options to modify transfer options.
To start the transfer, click OK.



Overview—Editing Host Data

Topics in this Help book describe how you can edit host data using copy,
paste, cut, and other word processing functions. You can customize edit
settings in the Session Profile dialog box. Some edit settings are specific
to the terminal. For example, settings in the Edit folder are not available

when you are connected to a VT host.

Before you edit host data, consider the following factors:
. Have you modified the mouse settings? Some functions are possible
only with the default mouse settings.

. Is the location to which you want to copy the text protected or
unprotected?

. What is the host operating system?

Related Topics

Cutting, Copying, and Pasting Text
Dragging Text to a New Location
Enabling Auto Copy

Using Entry Assist and Word Wrap
Creating a Shortcut Scheme

Using Shortcuts

Saving Data to a File




Cutting, Copying, and Pasting Text

You can use the cut, copy, and paste features for any unprotected area of
the screen.

To cut, copy, and paste text:

1. In the host session window, select the block of text you want to cut or
copy.
2. On the Edit menu, click either Cut or Copy.

3. Position your cursor in the unprotected area of the screen where you
want to paste the text.

4. On the Edit menu, click Paste.

Related Topics
Clipboard Format Description




Dragging Text to a New Location

This feature is available only on mainframes and AS/400 systems. It
functions only in an unprotected area of the screen.

In addition, the following procedure is possible if you have not modified
the default mouse settings. To restore default settings, in the General
category of the Mouse folder in the Session Profile dialog box, click
Reset All.

To drag a block of text to a nhew location:

1. In an unprotected area of the host session window, select the block of
text that you want to move.

2. Do one of the following:

. To move the text, drag the selected rectangle to the new location.

. To place a copy of the text at the new location, hold down the Cirl
key and drag the selected rectangle to the new location.

Related Topics
Mouse Folder—General Category




Enabling Auto Copy

When you enable Auto Copy, all selected text is automatically copied and
pasted to the Clipboard.

To enable Auto Copy:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Edit folder and click the Copy, Cut and Paste category.
3. Select Auto Copy Selected Text.
4. Click OK.

Related Topics
Edit Folder—Copy, Cut and Paste Category




Using Entry Assist and Word Wrap

HostExplorer provides two editing features, Entry Assist and Word Wrap,
that you can use to make your editing tasks more efficient.



Entry Assist

Entry Assist, available only in TN3270 and TN5250 sessions, provides
word processing features for editing text in memaos, letters, and reports.
With Entry Assist enabled, you can use Word Wrap, Tab Stops, and
Margin options.

Entry Assist also provides a cursor position indicator in the Operator
Information Area (OIA). When you move the cursor, it indicates the row
and column position. For example, in a model 2 terminal, a value of 1/1
represents the upper left-hand corner, and a value of 24/80 represents
the lower right-hand corner. When you enable End-of-line and Tab Stops,
a horizontal arrow appears next to the DOC indicator. The DOC indicator
appears in the lower-right corner of the OIA when you enable Entry
Assist.



Word Wrap

With Word Wrap enabled, text at the right-hand margin wraps down to
the next available line. In modes other than Insert mode, you must clear
the next line before typing. Word Wrap can work within preset margins or
use the field width as the value for the left and right margins. This lets
you use Word Wrap within different systems without resetting the
margins.

To enable Entry Assist and Word Wrap:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Tip: Press Ctrl+E to toggle Entry Assist on and off. Press Ctrl+W to
toggle Word Wrap on and off.

2. Expand the Edit folder and click the Entry Assist category.
3. Select the Entry Assist Enabled and WordWrap Enabled options.

4. To set tab stops, type a numeric value in the Tab Stops box. You can
also click in any unprotected area of the screen and click Set.

Related Topics
Edit Folder—Entry Assist Category
Saving Data to a File




Creating a Shortcut Scheme

HostExplorer lets you define keywords to represent frequently used
words, phrases, or keystrokes. You can choose to have each instance of
the keyword replaced by its associated text as you work or when you
finish editing.

You can save multiple shortcuts in a scheme. If you create multiple
schemes, only one can be active at a time.

To create a shortcut scheme:

1.

Open the Session Profile dialog box.

2. Open the General category of the Shortcuts folder.
3.
4. In the Shortcut Mode box, select Manual, Automatic, or On Field Exit.

Click Enable Shortcuts to enable the Shortcuts feature.

For more information, see Using Shortcuts and Shortcuts Folder—
General Category.

Open the Assignments category of the Shortcuts folder.

Click the Add New Shortcut button. The Add New Shortcut dialog box
opens.

Enter a keyword and the text that you want the keyword to represent.

8. Select Case Sensitive if you want to enable this option. Clear Enabled

if you do not want the shortcut to be enabled in the Shortcuts list.

Note: You can also enable or disable a shortcut in the Shortcuts list by selecting or clearing
the box beside the keyword.

Click OK. The shortcut appears in the Shortcuts list.

Click the Save Scheme As button to save all the shortcuts in the list
as a scheme.

To edit a shortcut:

1.

Click Edit Shortcut Info in the Assignments category of the Shortcuts
folder. The Edit Shortcut Info dialog box opens.

Modify the information that you want to change.



3. Click OK.

Related Topics

Using Shortcuts

Shortcuts Folder—General Category
Shortcuts Folder—Assignments Category
Add New Shortcut Dialog Box

Edit Shortcut Info Dialog Box




Using Shortcuts

To use Shortcuts:

Depending on which mode you select when you configure Shortcuts, do
one of the following:

. Manual—Add Replace-Shortcuts to the toolbar. HostExplorer replaces
the keyword with the longform text when you click the Shortcuts
button. When you have saved and enabled a shortcut or shortcut
scheme in Manual mode, you can add Replace-Shortcuts to your
toolbar. »

. Automatic—Type the keyword and its delimiters in the text you are
editing. HostExplorer automatically replaces the keyword with the
longform text as you type.

. On Field Exit—Use the Tab key to move between fields. HostExplorer
replaces the keyword with the longform text when you exit a field.
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Saving Data to a File

When you save host data to a file, the data is saved to a default directory
and file name. Before you save a screen to a file, you can specify a
different location and file name and choose one of the following save
modes:

. Overwrite—QOverwrites any existing data.

. Append—Adds the new data to the end of an existing file without
overwriting any data.

To save data to a file (3270 and 5250):

1. On the Options menu, click Edit Session Profile. The Session Profile
dialog box opens.

Expand the Capture folder and click the General category.

In the Save Options list, select Overwrite or Append.

In the Save As Options list, click ASCII(DOS) or ANSI(Windows).
Select or clear the Confirm All Saves box.

o g bk~ WD

If desired, type a new directory and file name in the Default Save
Filename box, or browse to one.

~

Click OK to save the changes and exit the dialog box.
8. On the File menu, click Save Screen To Disk.

9. In the Save Screen to Disk dialog box, specify the settings to be
saved.

0. Click Save.

To save data to a file (VT):

1. On the Options menu, click Edit Session Profile. The Session Profile
dialog box opens.

2. Expand the Capture folder and click the General category.
3. In the Save Mode list, select Overwrite or Append.
4. In the Capture Mode list, select Raw or Text.



Select or clear the Confirm All Saves box.

6. In the Save As Options area, select or clear Confirm All Saves.

If desired, type a new directory and file name in the Default Save
Filename box, or browse to one.

Select or clear the Capture Erased Screens box, depending on the
type of data you want to save. »

Click OK to save the changes and exit the dialog box.

0. On the File menu, click Save Screen To Disk.

2.

In the Save Screen to Disk dialog box, specify the settings to be
saved.

Click Save.

Related Topics
Save Screen to Disk Dialog Box

Capture Folder—General Category




Overview—Printing Host Data

Topics in this Help book describe how you can print and log host data.
Depending on the print option you select on the File menu or in the Print
folder of the Session Profile dialog box, you can do any of the following:

. Print the contents of single or multiple display session screens.

. Print data contained in a defined area of single or multiple display
session screens.

. Capture screens or screen areas and save the data to a file, which
you can then print. Depending on the host system, you can capture
session activity panel by panel or as one long file.

. Associate a printer session profile with a display session profile (3270
and 5250). When you connect to a host using the display session
profile, the printer session profile starts automatically and prints the
data.

Note: You can also print data using HostExplorer Print Services to any LAN printer on your
enterprise network, provided that the host is running a version of TCP/IP that

supports the TN3270E and TN5250E protocols. To use the HostExplorer Print
Services product, you must install it separately from the HostExplorer product.

Related Topics

Printing Screens

Printer Session Profiles

Introducing Report Schemes

Save Screen to Disk Dialog Box
Capture Folder—General Category




Printing Screens

HostExplorer lets you print the screen of any host to which you are
connected. You can print an individual screen or multiple screens.

To
1.

print an individual screen:

On the File menu of the session window, click Print Screen. The Print
dialog box opens.

In the Name list, choose a printer.

3. Click OK.

To

N

2

print multiple screens:

On the File menu of the session window, click Print Multiple Screens.
The Print Multiple Screens dialog box opens.

In the host session window, go to the first screen that you want to
print.

In the Print Multiple Screens dialog box, click Capture Screen.
Go to the next screen that you want to print and click Capture Screen.
Repeat step 4 for each screen that you want to print.

In the Print Multiple Screens dialog box, specify the screens that you
want to print.

You can specify options for the print job by clicking Properties, which
opens the Session Profile dialog box with the Print Screen category of
the Print folder selected.

Note: To specify the number of host screens that you want printed on each page, click the
Print Screen-Advanced category and specify the number in the Host Screens per
Page list.

In the upper right-hand area of the dialog box, click Print. The Print
dialog box opens.

Specify the printer that will be used to print the multiple screens.
Click OK.

Related Topics



Print Multiple Screens Dialog Box
Print Folder—Print Screen Category




Introducing Report Schemes

Using HostExplorer, you can define an area of multiple 3270 or 5250
terminal screens and save the configuration as a report scheme. When
printing, the emulator automatically browses through the screens and
prints the data contained in the defined area.

You can create as many report schemes as you need. The default report
scheme name is saved in the Session Profile.

To create or edit a report scheme:

1. On the File menu of a session window, click Report Wizard. The
Report Wizard dialog box opens.

2. Click Edit to open the Report Wizard, which guides you through the
process of setting up a print area report scheme.

To execute a report scheme:

1. On the File menu of a session window, click Report Wizard. The
Report Wizard dialog box opens.

2. Accept or change the Scheme and Destination settings, and then click
Print.

Related Topics
Creating a Print Area Report Scheme
Report Wizard Dialog Box




Creating a Print Area Report Scheme

The Report Wizard guides you through the process of setting up a print
area and creating a report scheme. Each report configuration is saved in
a scheme file.

To launch the Report Wizard:

1. On the File menu, click Report Wizard. The Report Wizard dialog box
opens.

2. Click Edit to launch the Report Wizard.

The Report Wizard process consists of the following steps:

Step 1: Scheme Information

Step 2: Application ID

Step 3: First Page Identification

Step 4: First Page Area Selection

Step 5: Last Page Identification

Step 6: Subsequent Area Selection

Step 7: Scheme Summary

Related Topics
Introducing Report Schemes
Report Wizard Dialog Box



javascript:Step2ApplicationID.Click();
javascript:Step3FirstPageIdentification.Click();
javascript:Step4PositionCoordinates.Click();
javascript:Step5LastPageIdentification.Click();
javascript:Step6AreaCoordinates.Click();
javascript:Step7Summary.Click();
javascript:PrinterSessionProfiles.Click();




Printer Session Profiles

Using HostExplorer printer session profiles, you can print information
from a host computer to any LAN printer in your enterprise network. The
host computer can be either IBM mainframe (3270) or IBM AS/400
(5250) midrange computers.

To
1.

To

print using a printer session profile:

Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Open the printer session profile that you
want to use for printing. The Printer Session window opens displaying
the print status.

Modify the profile properties by clicking Session Properties on the
Options menu.
print when you connect to a display session profile:

On the Options menu of a mainframe window, click Session
Properties. The Session Profile dialog box opens.

Expand the Print folder and click the Printer Session category.

3. In the Base Printer Session Profile box, specify a printer session

profile (. hep), or click Browse Printer Session Profiles to search for
one. If you want to create a new printer session profile, click Create A
New Printer Session Profile.

Select Start Printer Session Automatically. Select or clear Limit To
Single Instance.

If you want to close the printer session when you terminate the
session, select Close Printer Session Automatically.

6. In the Host Name box, type the host name or IP address.

Select a setting in the Printer LU Settings list or specify a printer LU
name in the Specific Printer LU box. Click OK.

Disconnect from the session, and re-connect to it. The Printer Session
window opens.

Click Session Properties on the Options menu. Choose a specific



printer and configure print settings on the Printer Destination tab.

Related Topics
Print Folder—Printer Session Category




Printing a Keyboard Mapping List

If you want to customize the functions associated with the keyboard keys,
you can print a list of the mappings for reference.

To print a keyboard mapping list:

1. On the Options menu, click Keyboard Mapping. The Keyboard Map
dialog box opens.

2. In the lower-left area of the dialog box, click List Assigned Functions.
The Keyboard Assignments dialog box opens.

3. Click Print, and then click OK.

Related Topics
Keyboard Map Dialog Box
Keyboard Assignments Dialog Box




Printing Scrollback Buffer Contents

If you are connected to a UNIX host, you can print the contents of the
Scrollback Buffer.

To print the contents of the Scrollback Buffer:

1. In a UNIX screen, select the text you want to print. You can scroll
vertically to select text outside the terminal screen.

2. On the File menu, click Print Screen.
3. Click Selection, and then click OK.

Related Topics
Overview—Printing Host Data
Printing Screens




Printing Using LPR

You can connect a remote printer directly to your PC as if it were a local
printer. To provide remote host access to your PC printer, enable the LPD
service in InetD. This connection appears automatically in all your
Windows applications each time you run your PC.



Setting up a Printer for LPR

Before you attempt to print, you must define your printer. How you define
your printer depends on the location from which you are printing (PC or
host) and the location of the destination printer (PC or host). If you do not
define your printer properly, LPR cannot direct your file to the desired
printer.



Defining a Printer

The Windows products provide remote printing capabilities through the
LPR application. LPR is an application that lets you print PC files to any
UNIX or LPD host on a TCP/IP network running an LPD server program.
The LPR window displays a separate window for each UNIX or other
LPD host printer queue to which you are connected.

To define a printer:

1.

On the Windows Start menu, navigate to the
Hummingbird/Accessories program group and click LPR. The LPR
window opens.

On the Printer menu, click Add Remote Printer. The Add Remote
Printer dialog box opens.

In the boxes provided, enter the following information:
. Host—The name or IP address of the host to which the printer is

connected.

. Queue Name—The name of the queue listed in the host

/etc/printcap file. This field is required.

. User ID—The user name that you use to log in. The logged in user

name displays automatically.

If desired, select one of the following Advanced features:
. Read Host's Queue—Automatically displays available queue status

information (for example, printer problems, job list, queue
problems) from the host in the printer window. You can also use the
Refresh command on the Printer menu or the F5 key to update the
host queue.

. Graceful Close—All data that is already queued for transmission is

sent before information associated with the socket is released.

5. When finished, click OK.



Sending a Print Job to LPR

After you have correctly defined the printer for LPR, you can begin
printing.

To print files to a printer:

1. On the Windows Start menu, navigate to the
Hummingbird/Accessories program group and click LPR. The LPR
window opens.

2. On the File menu, click Print.

3. Browse to the file you want to print and click OK. The system
automatically checks the printer queue and then sends the job.

Related Topics
Printing Using LPR
Checking a Printer Queue Using LPQ




Checking a Printer Queue Using LPQ

Each time you send a print job, the system automatically checks the
printer queue. You can check the queue without sending a print job, as
described in the following procedure.

To check the printer queue:

1. On the Windows Start menu, navigate to the
Hummingbird/Accessories program group and click LPQ.

2. In the boxes provided, type the following information:

. Host—The name or the IP address of the host whose printer queue
you wish to view.

. Printer—The network name of the printer whose queue you wish to
guery. System Administrators sometimes name printers after the
groups they service (for example, Documentation).

. Username—The user name in the printer queue you wish to check.

3. Click OK.

LPQ connects to the host you specified and returns information on print
jobs pending, spooling, and printing.



Configuring a Remote Printer

If a printer connection is no longer valid, you can remove it. If the printer
information has changed, you can modify the printer properties.

To remove a remote printer:

1. On the Windows Start menu, navigate to the
Hummingbird/Accessories program group and click LPR. The LPR
window opens.

2. In the window, select the printer you want to remove.
3. On the Printer menu, click Remove Remote Printer.
4. Click Yes to confirm the deletion.

To edit the properties of a remote printer:

1. On the Start menu, navigate to the Hummingbird/Accessories
program group and click LPR. The LPR window opens.

2. On the Printer menu, click Edit Remote Printer Properties. The Edit
Remote Printer Properties dialog box opens.

3. Edit the properties as desired. To test the printer, click Test Queue.
4. When you are satisfied with the information, click OK.



Overview—HostExplorer Options

Host Explorer provides numerous options that you can configure to
create a customized user environment. You can create a set of
customized session properties and save them as a scheme that you can
reuse each time you make that connection. You can also save a set of
schemes as a theme that you can apply to a profile for a specific use. To
further customize your environment, you can create custom menus and
toolbars.

For more information about configuring profile options, see Session
Property Categories.

Related Topics
Overview—Automating Sessions
User Environment Customization




User Environment Customization

Property settings (such as menu options and toolbar buttons) that affect
program behaviour are considered part of the user environment. To
customize the HostExplorer user environment, you can do any of the
following:

. Select preset schemes or create new schemes.

. Design and create a workspace theme that incorporates multiple
schemes.

. Simplify the session window by creating and editing custom menus.
. Create custom toolbars for the session window.
. Assign color schemes and images to the session window.

Related Topics

Revising the Session Window with Customized Schemes
Creating Themes

Menu Customization

Toolbar Customization

Mouse Customization

Keyboard Customization

Overview—Automating Sessions




Revising the Session Window with Customized
Schemes

With HostExplorer, you can create custom schemes for session profiles.
Creating a customized scheme lets you revise the Session Profile dialog
box, as well as the toolbars and menus that are displayed in the session
window.

You can save a group of property settings as a scheme and apply it to a
specific profile so that you do not have to customize individual session
properties each time you connect to a host.

Related Topics

Creating Schemes

Creating Themes

Customize Session Properties Dialog Box—Scheme Tab
Customize Session Properties Dialog Box—Customize Tab




Creating Schemes

You can use either of the following methods to create a custom scheme:

. Create schemes for individual categories in the Session Profile dialog

box (accessible from the Options menu).

. Use the Customize Session Properties dialog box (accessible from

the Tools menu) to customize the Session Profile dialog box that
displays in the session window. Using this dialog box, you can create,
select, rename and save Session Properties schemes. You can also
create new categories, rename property captions, rearrange
properties and categories, and delete properties from a scheme.

To create a scheme using the Session Profile dialog box:

Using the Session Profile dialog box, you can create settings schemes
for the following categories: color, font, keyboard, hotspots, mouse,
sound, events, shortcuts, and track menu.

1.

5.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Open the desired folder (for example, to create a color scheme, open
the Color folder).

Modify the options that you want to change.

Note: You may need to select a different tab within the folder to access specific options.

Click Save Scheme As. Enter a name for the scheme in the Save
Scheme As dialog box.

Click OK.

To create a Session Properties scheme:

You can use Session Properties schemes to customize the Session
Profile dialog box in a profile. For example, you could create a single
folder that contains only the categories that you need for that profile.

1.

2.

On the Tools menu, click Customize Session Properties. The
Customize Session Properties dialog box opens.

Click New. Enter a name for the scheme in the New Scheme dialog



box, and then click OK.

Note: Select Start with Defaults if you want to use the default session properties
configuration as a basis for the scheme that you want to create.

3. Click the Customize tab.
4. Do one of the following:

. In the Custom Scheme Name area, right-click a category to access
the context menu, which lets you create new categories, rename
property captions, and delete properties from the selected scheme.

. Drag and drop a property from the Default Scheme Name area to
the Custom Scheme Name area.

5. When finished, click OK.

Related Topics

Customize Session Properties Dialog Box—Scheme Tab
Customize Session Properties Dialog Box—Customize Tab
Tools Menu

Creating Themes

User Environment Customization




Creating Themes

HostExplorer lets you apply various schemes for different profiles. You
can apply schemes individually for each profile, or you can select and
apply multiple schemes and save them as a theme. For example, you
could create two different profile themes for a mainframe application: one
for payroll and one for inventory. Each theme could contain different
settings for keyboard mappings, colors schemes, or include specific
macros or quick scripts.

For each profile option, you can assign the default scheme, the profile
scheme, a pre-configured scheme, or you can create a custom scheme.

To create a theme:

1. In the Session Profile dialog box, select the General category of the
Themes folder.

2. In the Scheme list, double-click a scheme to display a list of available
assignments in the Assignment column. If the list box is empty, you
can create new schemes using the Session Profile dialog box. (For
example, you can create a new color scheme in the Color folder.)

3. Select a pre-set or a custom scheme from the drop-down list.

4. Click Apply to apply the revised scheme and override the settings in
the profile.

Note: Set the scheme assignment to Profile to retain the profile default settings.

5. Click the Save Theme As button to save the settings as a custom
theme.

6. Click OK to save the theme and close the dialog box.

Related Topics

Themes Folder—General Category

Revising the Session Window with Customized Schemes
Toolbar Customization

HostExplorer Functions




Menu Customization

HostExplorer lets you create custom menu schemes that you can apply
to session profiles. For example, you could use a custom menu for a
specific session and a generic menu for another.

Using custom menu schemes, you can do any of the following:

. simplify your work area by including only certain menu items
. hide or display specific features

. edit or rename menu captions

. reorganize menus and menu options

. Create submenus

. add shortcuts to specific HostExplorer functions

Related Topics

Creating Menu Schemes

Customize Menus Dialog Box—Scheme Tab
Customize Menus Dialog Box—Customize Tab
HostExplorer Functions




Creating Menu Schemes

To create a custom menu scheme:

1.

In a host session window, click Customize Menus on the Tools menu.
The Customize Menus dialog box opens.

On the Scheme tab, click New to create a new menu. The New
Scheme dialog box opens.

Enter a name for the scheme. Select Start with Defaults to use the
default menu settings as a basis for the new menu scheme.

On the Customize tab, right-click in the Menus area. If Start with
Defaults is cleared, the area is empty.

If you want to create a new menu, click Create New Menu from the
context menu. Enter a name for the new menu in the Create New
dialog box and click OK.

Select a function group, and then drag and drop functions to the menu
folders until the menu scheme is complete.

Note: You can also use the context menu to delete menu items, create submenus, add
separators and rename menu captions.



Modifying Menu Schemes

To modify a custom menu scheme:
1. In a host session window, on the Tools menu, click Customize Menus.
2. On the Scheme tab, select a menu scheme from the drop-down list.

Note: You cannot save changes to the default menu scheme.

3. On the Customize tab, right-click a menu folder that you want to
modify. Select an option from the context menu.

4. Click Apply to implement the changes immediately.
5. When finished, click OK to close the dialog box.

Note: Click Save As on the Scheme page to save the modified scheme as a new scheme.

Related Topics

Revising the Session Window with Customized Schemes
Menu Customization

Customize Menus Dialog Box—Scheme Tab

Customize Menus Dialog Box—Customize Tab
HostExplorer Functions




Enabling Menu Options

Feature Lockdown in HostExplorer Management Console lets an
administrator specify menu options that are available for end users. By
default, all menu options are selected.

The left pane of this screen lists HostExplorer menus for all connection
types. The right pane lists all menu options and lets you enable or disable
the options within these menus.

To disable menu options:

1. In the Administrative Tools folder, click HostExplorer Management
Console.

2. In the left pane, select a menu category that you want to customize.

3. In the right pane, clear the check boxes of the menu options that you
want to disable.

4. When finished, close the HostExplorer Management Console.

Related Topics
HostExplorer Menu Descriptions




Toolbar Customization

The default toolbar contains buttons that execute menu commands. You
can add buttons on the default toolbar to simplify tasks, or delete buttons
that you don’t use. You can also create toolbar schemes that let you
maintain toolbars that are designed specifically for tasks in a specific
session or are designed generically for use in other sessions.

A toolbar button is defined by all of the following:

. the command that is executed when you click the button
. its graphic or icon
. its context-sensitive ToolTip

Related Topics

Customize Toolbars Dialog Box—Scheme Tab
Tools Menu

HostExplorer Functions




Creating and Moving Toolbars

For quick access to frequently used features, you can create new
toolbars and map commands and characters to the toolbar buttons. You
can also customize toolbars and create toolbar schemes.

To create a toolbar:

1. On the Tools menu, click Customize Toolbars. The Toolbars dialog
box opens.

2. On the Toolbars tab, click New.

3. Type a name for the toolbar. Select Start with Defaults to use the
default toolbar configuration as a basis for the new toolbar.

4. Click OK. The toolbar name is added to the Toolbars area, and the
new toolbar displays in the workspace.

5. On the Functions tab, choose a function group. You can then drag
individual functions onto the new toolbar to create buttons.

To move a toolbar:

1. Double-click the toolbar (anywhere but on an icon) to position it in the
session window.

2. Double-click it again to position it outside the session window.

Note: You can also drag the toolbar to a position along any margin of the session window,
within the terminal screen, or on the Windows desktop.

Related Topics

Customize Toolbars Dialog Box—Scheme Tab
New Scheme Dialog Box

Tools Menu

HostExplorer Functions




Displaying and Hiding Toolbars

To display or hide a toolbar:

1. On the Tools menu, click Customize Toolbars. The Customize
Toolbars dialog box opens.

2. On the Scheme tab, select the box next to the toolbar you want to
display. Clear the box to hide it.

Note: You can display multiple toolbars in a session window.



Adding, Deleting and Moving Buttons

You can perform the following procedures to customize the buttons on a
toolbar.

To add a new button:

1. On the Tools menu, click Customize Toolbars. The Customize
Toolbars dialog box opens.

2. On the Scheme tab, select the box next to the toolbar that you want to
customize. The toolbar appears in the workspace.

3. Click the Functions tab and select a Function Group.

4. In the Function box, drag an individual function to the toolbar in the
workspace. A button is created with that function assigned to it.

5. Click OK.

To delete a button:

1. On the Tools menu, click Customize Toolbars. The Customize
Toolbars dialog box opens.

1. In the host session window, right-click the toolbar button that you want
to delete.

2. Select Delete Button from the context menu.

To move a button:

1. On the Tools menu, click Customize Toolbars. The Customize
Toolbars dialog box opens.

2. In the host session window, position the cursor over a button. Drag
and drop it to a new location.

Note: To reset the default configuration to the toolbar, click Reset on the Customize
Toolbars dialog box.

Related Topics
Customize Toolbars Dialog Box—Scheme Tab
Customize Toolbars Dialog Box—Options Tab




Tools Menu




Modifying the Button Caption

To change the button caption:

1. On the Tools menu, click Customize Toolbars. The Customize
Toolbars dialog box opens.

2. In the host session window, right-click the button that you want to
change and click Edit Caption. The Edit Caption dialog box opens.

3. Type the new caption and click OK. The new caption is assigned to
the toolbar button.

4. Click OK.

Related Topics
Edit Caption Dialog Box
Customize Toolbars Dialog Box—OQOptions Tab




Changing the Button Image

You can change the existing graphic of a toolbar button to an image that
is supplied by HostExplorer or to one that you have created.

Note: You must add the customized image file to each profile that uses the image.

To change the graphic for a button to a HostExplorer image:

1. On the toolbar, right-click the button that you want to change and click
Customize Toolbars. The Toolbars dialog box opens.

2. In the host session window, right-click the button, select HostExplorer
Images, and click one of the images in the display. The toolbar button
image changes to the one that you selected.

To change the graphic of a button to a customized image:

1. Create an image that you want to use for the toolbar button using a
graphics illustration program, such as Microsoft Paint. The graphic
must have the following properties:

. format—bitmap
. Size—16 X 16 pixels
. image color—16 color
. background color—RGB (192, 192, 192)
Place the image in the HostExplorer\Toolbar directory where the

user files are stored on your machine. To access the User Files

folder, double-click the User Files shortcut in the Hummingbird
Connectivity program group.

2. In the host session window, open the Customize Toolbars dialog box.

3. On the Options tab, click the browse button next to the User
Customized Image File box. The Browse dialog box opens.

4. Browse to your image and click Open.
5. Click Apply and leave the Toolbars dialog box open.

6. In the host session window, right-click the button that you want to
change.



7. Point to User Customized Images and click the image that you want
to use. The toolbar button image changes to the one that you

selected.
8. Click OK to close the Customize Toolbars dialog box.

Related Topics
Customize Toolbars Dialog Box—QOptions Tab




Modifying Button Style and Size

To change the display of a button:

1. On the Tools menu, click Customize Toolbars. The Customize
Toolbars dialog box opens.

2. In the host session window, right-click the button that you want to
change.

3. Point to Style and click one of the following items:

. Default—Displays only the toolbar button image.
. Image Only—Displays only the toolbar button image.
. Label Only—Displays only the caption of the toolbar button.

. Image and Label—Displays both the image and the caption of the
toolbar button.

4. Click OK to close the Customize Toolbars dialog box.

To increase the size of buttons:

1. On the Tools menu, click Customize Toolbars. The Customize
Toolbars dialog box opens.

2. On the Options tab, select Large Icons.
3. Click Apply.
4. Click OK to close the Customize Toolbars dialog box.

Related Topics
Customize Toolbars Dialog Box—QOptions Tab




Other Toolbar Modifications

You can group toolbar buttons of similar functionality by inserting a
separator in front of the selected button.

To insert a separator on a toolbar:

1. Open the Customize Toolbars dialog box.

2. Right-click a button to the right of where you want the separator.
3. Click Insert Separator.

ToolTips are context-sensitive Help messages that appear when you
position the mouse pointer over the buttons on a toolbar. If you do not

want ToolTips to appear, you can hide them.

To turn off the ToolTips:

1. Open the Customize Toolbars dialog box.

2. On the Options tab, clear Show ToolTips On Toolbars.
3. Click Apply to apply the change.

4. Click OK to close the dialog box.

Related Topics
Customize Toolbars Dialog Box—QOptions Tab




Restoring Default Settings

If you want to undo any customization changes, you can restore both the
button and toolbar settings to their original default settings.

To restore default settings to a toolbar:

1. Open the Customize Toolbars dialog box.

2. On the Scheme tab, select the toolbar that you want to restore.
3. Click Reset.

To restore default settings to a button:

1. Open the Customize Toolbars dialog box.

2. Right-click the button that you want to restore.
3. Select Reset.

Related Topics
Customize Toolbars Dialog Box—Scheme Tab




Session Property Categories

HostExplorer provides many options that you can configure to suit your
preferences. For general configuring procedures, see the Configuring
HostExplorer Sessions or the Customizing the User Interface Help book.

Note: If you are running a web-deployed installation of HostExplorer, some session options may be
unavailable, depending on which options your administrator has enabled or disabled.

You can configure the following session property categories in the
Session Profile dialog box:

Connection and Security

Terminal, Display, Color, and Font

Keyboard, Hotspots, and Edit

Print, File Transfer, and Session Window

Themes, Toolbar and Menu

Mouse, Sound, and Events

Shortcuts, Track Menu, and Capture

Related Topics

Overview—HostExplorer Options

User Environment Customization

Revising the Session Window with Customized Schemes




Connection and Security



Connection Folder
TN3270 Category
TN5250 Category
Telnet Category

Microsoft SNA Server Category

Netware for SAA Category

Modem Category
Advanced Category—3270, 5250, VT

NVT Category

Other Category
Secure Shell Category

LU Category




Security Folder
General Category

Kerberos Category
SSL/TLS Category




Terminal, Display, Color, and Font



Terminal Folder
3270 Category
5250 Category

VT Category
Graphics Category—3270

Advanced Category—VT

Character Set Category—3270 and 5250, VT
Size Category—VT

APl Category—3270, 5250, VT




Display Folder
General Category—3270, 5250, VT
Cursor Category—3270, 5250, VT




Color Folder
General Category—3270, 5250, VT
Palette Category—3270, 5250, VT




Fonts Folder
General Category—3270, 5250, VT




Keyboard, Hotspots, and Edit



Keyboard Folder
General Category—3270, 5250, VT

Advanced Category—3270, 5250
Advanced Category—VT

Device Category—VT




Hotspots Folder
General Category—3270, 5250, VT
Assignments Category—3270, 5250, VT




Edit Folder

General Category—3270, 5250

Copy, Cut and Paste Category—3270, 5250, VT
Clipboard Formats Category—3270, 5250, VT
Entry Assist Category—3270, 5250

Tabs Category—VT




Print, File Transfer, and Session Window



Print Folder

Print Screen Category—3270, 5250, VT

Print Screen-Advanced Category—3270, 5250, VT
PCPRINT Category—3270

Printer Session Category—3270, 5250

Host Printing Category—VT

Host Printing Advanced Category—VT




File Transfer Folder
General Category—3270, VT

Custom Category—3270

Code Pages Category—3270
Modem Category (VT)—XModem, YModem, Kermit, ZModem




Session Window Folder
General Category

Workspace Category

Window Sizing Category




Themes, Toolbar and Menu



Themes Folder
General Category




Toolbar Folder
General Category




Menu Folder
General Category




Mouse, Sound, and Events



Mouse Folder
General Category




Sound Folder
General Category




Events Folder
General Category

Assignments Category




Shortcuts, Track Menu, and Capture



Shortcuts Folder
General Category

Assignments Category




Track Menu Folder
General Category




Capture Folder
General Category—3270, 5250, VT




Session Properties Folder
General Category




User Environment Customization

There are several ways to customize the session window and terminal
screen. You can design the window and screen peripherals to be specific
to the current session or for generic use in other sessions.

The Track menu provides quick access to frequently used session
functions (such as menu options, unique characters, action, editing and
Quick-Keys). You can configure the Track menu to execute commands
for a specific session.

Note: If you are running a web-deployed installation of HostExplorer, some session options may be
unavailable, depending on which commands and options your administrator has enabled.

Related Topics

Mouse Customization

Keyboard Customization

Toolbar Customization

User Environment Customization (VT)




Modifying Font Attributes

You can change the font style that is displayed in the terminal screen to
either TrueType or Bitmap. For best resolution, use bitmap fonts.

To modify font attributes:

1.

a k~ 0D

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Fonts folder and click the General category.
Click Select Font. The Session Font dialog box opens.
In the dialog box, assign the desired attributes.

Click Apply and then click OK.

Note: For the best resolution, use bitmap fonts by selecting HE_Bitmap in the Font Name
list.

Related Topics
Fonts Folder—General Category

Session Font Dialog Box




Modifying the Cursor

You can customize the size and appearance of the cursor.

To modify cursor attributes:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Display folder and click the Cursor category.
3. In the Cursor Type list, click an option to assign a shape to the cursor.

4. In the Cursor Mode list, click an option to assign either Blink or Solid
mode.

5. Select or clear either of the following options:

. Display Cross-Hair Cursor—Displays a cross-hair cursor in the host
session window.

. Change Shape on Insert—Lets you use the Insert button on the
keyboard to toggle between cursor types.

6. Click OK.

Related Topics
Display Folder—Cursor Category




Modifying Session Component Colors
You can create a custom display by changing the default colors of the
session screen and terminal style OIA.

Tip: You can also modify color shades in the Palette category of the
Color folder.

To modify session component colors:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Color folder and click the General category.

3. Inthe Scheme list, select a pre-set color scheme in the drop-down list
or create a custom color scheme.

4. Click Save As to name and save a scheme.
5. Click OK.

Note: To implement these changes for future sessions, click Save Session Profile on the
File menu, and then click the profile to which you want to save the changes.

Related Topics
Color Folder—General Category
Color Folder—Palette Category




Assighing a Windows Bitmap Pattern

You can assign a Windows bitmap pattern to the area between the
session window and the terminal screen. By default, the color of this area
IS green.

To assign a Windows bitmap pattern:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Session Window folder and click the Workspace category.

3. Select Show Workspace, and then Show Bitmap In Workspace.

In the Bitmap File box, browse to your Windows bitmap directory. For
example:

c:\winnt

Select and open a bitmap file.
Click Apply.

Note: If the Windows bitmap pattern does not display after you make the changes,
clear Force Exact Terminal Window Size in the Window Sizing category.

Related Topics
Session Window Folder—Workspace Category

Session Window Folder—Window Sizing Category




Eliminating the Border between Window and
Screen

If you enlarge the session window, the border increases. You can remove
the border by locking the screen to the window.

To eliminate the border between the window and the screen:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Session Window folder and click the Window Sizing
category.

Select Force Exact Terminal Window Size.
Click OK.

Note: If you choose not to eliminate this border, the border increases when you enlarge the
session window.

Related Topics
Session Window Folder—Window Sizing Category




Specifying Text for the Title Bar

You can change the text that is displayed in the title bar by modifying the
variables in the Window Title equation.

To specify text for the title bar:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Session Window folder and click the General category.
3. In the Window Title box, type the desired Special Identifier variable(s).

B

4. Click OK.

Related Topics
Session Window Folder—General Category
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Customizing the Track Menu

You can customize the Track menu in two steps: first, you map it to a
mouse action, and then you assign functions. In the following procedure,
you map the Track menu to appear when you right-click the mouse
button.

To map the Track menu to the mouse:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Mouse folder and click the General category.
In the Mouse Action list, click Right Single Click.

In the Function Group list, click System Commands.

In the Function list, click Show-Track-Menu.

Click Set.

o g bk~ WD

With the menu mapped to a mouse action, you can now use the following
procedure to customize the menu.

To customize the Track menu:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand Track Menu folder and click the General category.
In the Function Group list, click an option.

In the Function list, click an option.

Click Append.

a k~ 0D



Changing the Language

When you change the language for a 3270 or 5250 session,
HostExplorer automatically applies the correct keyboard ID, code page,
and character set. You can have multiple sessions running using different
languages.

To change the language:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Terminal folder and click the Character Set category.
3. Inthe Host Code Page list, select a language.
4. Click OK.

Related Topics
Terminal Folder—3270 and 5250 Character Set Category




User Environment Customization (VT)

The VT host provides features that are unique to the VT environment.
These features let you customize the session window and terminal
screen in ways that are not possible on a mainframe or AS/400 host.

Note: The procedures in this Help book apply only to the VT terminal type.



Scrollback Buffer

The Scrollback buffer is a zone that lets you scroll through data that has
scrolled off the terminal screen. Once enabled, you can search the
scrollback zone for text strings. You can set a value between 1 and 9,999
as the number of lines maintained within the zone. To disable the
Scrollback buffer, set the number to zero.

Related Topics

ISO Latin-1 UPS and DEC Supplemental Set
ISO Latin-1 UPS Set

DEC Supplemental UPS Set




Searching and Disabling the Scrollback Buffer

If the Scrollback buffer is enabled, you can search it for text strings.

Note: This procedure applies only to the VT terminal type.

To search the Scrollback buffer:

1. On the Edit menu in a VT session, click Find.

2. Type the text for which you want to search.

3. Specify the search direction.

4. To search for text containing the same case, select Match Case.
5. Click Find Next.

Note: If the text string exists, the line containing the text moves to the top of the screen. If
the text string is on the current screen, the line does not move.

To disable the Scrollback buffer:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Display folder and click the General category.
3. Inthe Lines Available In Scrollback box, change the value to 0.



Compose Sequences

A compose sequence is a combination of two keys pressed sequentially
to create a special character not available on the keyboard. Using
compose sequences, you can enter special characters on a VT terminal
screen.

Compose sequences work only in Compose (CMP) mode. When you
start Compose mode, the CMP indicator appears in the status line. Some
compose sequences are available when you use both the ISO Latin-1 or
DEC Supplemental UPS (User-Preferred Supplemental) character set;
other compose sequences are available to specific character sets.

Related Topics
Creating Special Characters
Special Characters




Creating Special Characters

You can create special non-keyboard characters that appear when a user
simultaneously presses two keys. This key combination is called a
compose sequence. You need to be in Compose (CMP) mode to create
special characters.

To create a special character:

1. Start Compose Mode by pressing Alt+F8. This key combination
displays the CMP indicator in the status line.

2. Press the two-key combination that defines the special character.

Related Topics

ISO Latin-1 UPS and DEC Supplemental Set
ISO Latin-1 UPS Set

DEC Supplemental UPS Set

Special Characters




Modifying Screen Dimensions

You can use the Size category to set the general size options for the VT
terminal.

Note: This procedure applies only to the VT terminal type.

To modify screen dimensions:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.
2. Expand the Terminal folder and click the Size category.

3. On the Default Screen Width list, do one of the following to specify the
default screen size HostExplorer uses when launching a new session:

. Select a default screen width (80 or 132 columns). You can then
type a value in the Default Screen Height box, or leave the default
value.

. Select Custom and type a number between 20 and 300 in the
Columns box and between 10 and 200 in the Rows box.

4. Click OK. The terminal screen size reflects your changes.

Note: The default screen size is 80 columns by 24 rows.

Related Topics
Terminal Folder—Size Category




Changing Character Sets

You can specify the User-Preferred Supplemental (UPS) Character set
and the National Replacement Character (NRC) set.

Note: This procedure applies only to the VT terminal type.

To change the character sets:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Terminal folder and click the Character Set category.

3. Select the User-Preferred Supplemental (UPS) character set you

5.
6.

want to use.

Select the National Replacement Character (NRC) set you want to
use.

To enable an NRC set, select the Use NRC Set (7-Bit) box.
Click OK.

Related Topics

ISO Latin-1 UPS and DEC Supplemental Set
ISO Latin-1 UPS Set

DEC Supplemental UPS Set

Terminal Folder—VT Character Set Category



Setting Tab Stops

Navigate through data with greater speed by setting tab stops. You can
use tab stops to control where the cursor moves when you press the Tab
key.

Note: This procedure applies only to the VT terminal type.

To set tab stops:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Edit folder and click the Tabs category.
3. Enter a value in the Tab Stop box.
4. Click the screen where you want to set a tab stop and click Set.

Related Topics
Edit Folder—Tabs Category




Mouse Customization

You can remap mouse buttons to perform different functions and then
choose to save your settings to a profile or use them for the current
session only. For example, you can configure the right-click action to
perform any of the available functions listed in the General category of

the Mouse folder.



Default Mouse Actions
The default mouse settings perform the following actions:

Mouse Setting Action

Click Moves the cursor to the pointer location.

Double-click Selects the word at the current pointer location.

Shift+click Expands the currently selected area. If an area of text is not selected, it selects
the rectangular area between the cursor and the mouse pointer.

Right-click Moves the cursor to the pointer location and transmits the data. This option is

(mainframe and useful in programs compliant with System Application Architecture (SAA).

AS/400)

Right-click (VT) Pastes any clipboard data to the current pointer location.

Related Topics
Remapping Mouse Buttons

Keyboard Customization

Toolbar Customization




Remapping Mouse Buttons

To remap a mouse button:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Mouse folder and click the General category.
3. In the Mouse Action list, click an action.

4. In the Function Group list, click the group to which you want to add
the new mouse action.

5. In the Function list, click the function that you want to map to the
mouse action.

6. In the Text Selection Mode list, click Block or Stream.
7. Click Set to apply the changes.

Note: Your changes apply only to the current session. To save changes for other sessions
using the current profile, click Save Session Profile on the File menu, and then select
a profile and click Save.

Related Topics
Mouse Folder—General Category




Keyboard Customization

Using the graphical keyboard utility, you can remap keys to customize
your keyboard and then use the keyboard file while working on multiple
hosts. You can map and assign the keys on your PC keyboard to different
values, functions, Quick-Keys, Quick Scripts, and macros.

Tip: To reset the currently mapped mode, click Clear Entry. To reset all
modes for the current key, click Default. To reset all keys to their default
values, click Reset Alll.

Keyboard mapping is useful if you require a key that does not exist on
your keyboard or if you are more familiar with a terminal keyboard (such
as a DEC VT220 keyboard) and want to remap your PC keyboard to its
specifications.

Related Topics

Reconfiguring an Existing Keyboard
Enabling a Keyboard File

Printing a Keyboard Mapping List
Keyboard Emulation Tables
Connection Folder—NVT Category




Remapping Keys

To remap a key:

1.

7.

On the Options menu, click Keyboard Mapping. The Keyboard Map
dialog box opens.

Select a mode for the new key. For example, if you want to remap a
key in Shift mode, select Shift.

In the Function Group list, choose a function group.

In the Function list, drag a function to a key in the keyboard mapping
area. This deletes the old key mapping and maps the new function.
Values for the selected key are displayed in the Description area.

Click Save to open the Save Keymap dialog box. Enter a name for the
keyboard file, and click Save.

Tip: To restore the original keyboard mappings, click Reset All. To
restore the mapping for only one key, click the key and click Default.

Click Load to open the Load Keymap dialog box. Select the name of
the keyboard file you want to load, and click OK.

In the Keyboard Map dialog box, click OK.

Related Topics
Keyboard Map Dialog Box

Save Keymap Dialog Box

Hotspots Folder—General Category




Reconfiguring an Existing Keyboard

You can use the default keyboard files as templates to create custom
files. After modifying a default keyboard file, save the file with a new
name so that the default keyboard is preserved.

To reconfigure an existing keyboard file:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Keyboard folder and click the General category.

3. In the Keymap list, select Default.

7.

Click Keyboard Mapping to open the Keyboard Map dialog box. Make
the necessary changes.

Click Save to open the Save Keymap dialog box. Enter a name for the
keyboard file, and click Save.

Click Load to open the Load Keymap dialog box. Select the name of
the keyboard file you want to load, and click OK.

Type a new name for the keyboard file and click Save.

The new keyboard file now displays in the Keymap list.

Related Topics
Keyboard Folder—General Category

Keyboard Map Dialog Box

Save Keymap Dialog Box




Enabling a Keyboard File

To enable a new keyboard file:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Keyboard folder and click the General category.
3. In the Keymap list, click the keyboard file you want.
4. Click OK.

The current session then uses the selected keyboard file.

Note: To use this keyboard file with other sessions using the current profile, click Save Session Profile
on the File menu, and then click the profile to which you want to save the keyboard file.

Related Topics
Hotspots Folder—General Category
Keyboard Map Dialog Box




ISO Latin-1 UPS and DEC Supplemental Set

The following compose sequences are available for the ISO Latin-1 User-
Preferred Supplemental (UPS) and DEC Supplemental graphic character
sets:

Description Character || Sequence
A acute A A
a acute 4 a'
A circumflex A AN
a circumflex a an
Agrave A A
a grave a a’
Aring A A
aring a ar*
Atilde A A~
a tilde a a~
A diaeresis A A"
a diaeresis a a"
AE ligature A AE
a e ligature e ae
C cedilla C C,
c cedilla c c,
E acute E E'
e acute é e'
E circumflex E E~




e circumflex é en
E grave E (=
e grave e e’
E diaeresis E E"
e diaeresis é e"
| acute i I

i acute i I

| circumflex ] | A

i circumflex 1 | A

| grave I I

i grave i I

| diaeresis | "

i diaeresis T "
N tilde N N~
n tilde f n-~
O acute o] o}
0 acute o] o'
O circumflex o) on
o circumflex o} on
O grave o] 0"
o grave 0 0’
O slash /] o/
o slash [} o/
O tilde 0 0~




o tilde 0 0~

O diaeresis o] o

o diaeresis 0 o"
German sharp s 3 Ss

U acute U u'

u acute a u'

U circumflex 0 un

u circumflex a un

U grave u U

u grave u u’

U diaeresis U] u"

u diaeresis 1] u"
number sign # + +
apostrophe ‘ ‘ (space)
commercial at @ aa or AA
opening bracket [ ((
closing bracket ] ))
backslash \ [lorl<
single quotation mark ) ' (space)
opening brace { (-
closing brace } ) -
vertical line | /N

tilde ~ ~ (space)




inverted !

cent sign ¢ c/ or C/ or c| or C|
pound sign £ I-or L- or I=or L=
yen sign ¥ y-orY-ory=orY=
section sign 8 so or SO or S! or s! or sO or SO
copyright sign © coorCOorcOorCO
feminine ordinal indicator || a a_orA_

angle quotation mark left « <<

angle quotation mark right || » >>

degree sign ° on

plus minus sign + + -

superscript 1 1 in

superscript 2 2 2n

superscript 3 3 3n

micron M /uor/U

paragraph sign i p! or P!

middle dot n

masculine ordinal indicator || o o orO_
one-quarter fraction Ya 14

one-half fraction Yo 12

inverted ? ??




ISO Latin-1 UPS Set

The following compose sequences are available for the ISO Latin-1 User-
Preferred Supplemental (UPS) character set:

Description Character || Sequence

No break space (space)(space)
Broken vertical bar : [|or!A
Diaeresis N ""or" (space)
Logical not - -,
Multiplication symbol X X X

Division symbol + -

Soft hyphen - - -

Registered trademark ® RO

Macron -~Nor _ M

Acute accent

Three quarters Y 34
Uppercase Icelandic Eth b D-
Lowercase Icelandic Eth o} d-

Uppercase Icelandic thorn

b TH
Lowercase Icelandic thorn
b th
Uppercase Y acute
pp ~ v
Lowercase Y acute
y y

Cedilla




DEC Supplemental UPS Set

The following compose sequences are available for the DEC
Supplemental User-Preferred Supplemental (UPS) character set:

Description Character || Sequence

O E ligature E OE

o e ligature (0] oe

Y diaeresis Y '

y diaeresis y y"

currency sign a x0 or XO or x0 or X0
guotation mark | " “ (space)




Overview—Configuring Global Options
This topic describes how to configure global options using the
HostExplorer Global Features console.

You can customize and simplify the session window by modifying option
settings, or by enabling or disabling session options in the Global
Features tree. You can use in-place editing to modify session options.

Note: The Global Features tree does not support drag-and-drop.

To configure global options:

1. On the Options menu, click Global Options. The HostExplorer Global
Features console opens.

2. In the left pane, in the Global Features folder, click Common Features
or Advanced Features. The individual features display in the right
pane.

To enable or disable a feature:

Do one of the following:

. Click on the checkbox (or on an item with a check box) to select or
clear the item. Click again to toggle the value.

. Right-click the item, and then select Check or Uncheck from the
context menu.

To edit a feature value:

1. Use one of the following methods to display an edit field:

. Select an item, and then press F2 (or double-click the item).
. Right-click the item, and then select Edit from the context menu.

2. Enter a new value or edit the existing value.

When finished, click OK to close the Global Features console.

Related Topics
HostExplorer Global Features




Overview—Automating Sessions

This Help book describes how to automate tasks using Quick Scripts,
macros, and events. You can create desktop icons and shortcuts to
automate host connections at startup. You can also create a macro or
Quick-Key to launch the login script automatically each time you open
HostExplorer.

Note: Automating logins may result in security problems.

Related Topics

Overview—Quick Scripts

Recording, Editing, and Running Macros
Overview—Events
Overview—Automating Login




Overview—Quick Scripts

Unlike macros, which are statements based on the Hummingbird Basic
programming language, Quick Scripts are made up of commands. These
commands automate tedious tasks such as entering repetitive
information into an order entry form, or entering your user name and
password into a login screen. HostExplorer lets you assign Quick Scripts
to keyboard mappings, mouse actions, hotspots, toolbar buttons, and the
Track menu.

Note: Quick Scripts are emulation-specific. For example, a VT Quick Script functions properly only
when launched from a VT session. To switch to a different Quick Script type, click New on the
File menu of Quick Script Editor and specify a different type.

Quick Script Editor lets you create and modify HostExplorer Quick Scripts
(gs3, gs5, and .qgsvVv). You can launch Quick Script Editor from the
Accessories folder of the Hummingbird Connectivity Program Group.
Sample Quick Script files are available in the
Accessories\QuickScript directory where your user files are stored
on your machine. To access the User Files folder, double-click the
User Files shortcut in the Hummingbird Connectivity program group.

To launch Quick Script Editor from HostExplorer:

1. Using HostExplorer, connect to a host.

2. On the Tools menu of the session window, point to Quick Script, and
click Edit.

The Quick Script Editor opens displaying a toolbar and menus specific to
HostExplorer Quick Scripts.

Note: If you want to start working with FTP Quick Scripts, you need to either open an existing Quick
Script or create one in Quick Script Editor.

To launch the Quick Script Editor from Hummingbird Neighborhood:

1. Launch Hummingbird Neighborhood by double-clicking on the
Hummingbird Neighborhood icon on your desktop.

2. On the Hummingbird menu, click Quick Scripts.




Related Topics

Running Quick-Keys, Quick Scripts, or Macros at Startup
Tools Menu

Overview—Hotspots




Recording Quick Scripts

You can use Quick Script Editor to record keystrokes and other session
events directly in the host session window.

To record a Quick Script:

1.
2.
3.

4.

On the Tools menu, point to Quick Script and click Start Recording.
Perform the steps that you want to record.

On the Tools menu, point to Quick Script and click Stop Recording.
The Save Quick Script Files dialog box opens.

Type a file name for the HostExplorer Quick Script and click Save.

Related Topics
Overview—Quick Scripts

Running Quick Scripts
Running Quick-Keys, Quick Scripts, or Macros at Startup

Automating Login Using Quick Scripts




Running Quick Scripts

After you create or edit your script using Quick Script Editor, you can
execute it at any time.

To run a Quick Script:

1. In the host session window, point to Quick Script on the Tools menu
and click Run. The Browse Quick Script Files dialog box opens.

2. Select a Quick Script file and click Open. The selected Quick Script
runs.

Note: To stop the execution of a Quick Script at any time, point to Quick Script on the Tools
menu and click Stop.

Related Topics

Overview—Quick Scripts

Recording Quick Scripts

Running Quick-Keys, Quick Scripts, or Macros at Startup
Automating Login Using Quick Scripts




Recording, Editing, and Running Macros

Using the Macro Recorder, you can record keystrokes, mouse actions,
and other session events. You can also record a macro at startup to
include operations that occur prior to a connection. Using the Macro
Editor, you can edit the macro and enhance functionality, such as adding
timeouts and delays to accommodate slower connections.

Tip: Using Hummingbird Macro Basic Workbench, a Microsoft VBA-
compatible Basic interpreter and compiler, you can write a macro using
the Basic Script tool.

To record a macro:
1. On the Tools menu, point to Macro and click Start Recording.
2. Perform the steps that you want to record.

3. On the Tools menu, point to Macro and click Stop Recording. The
Save Recorded Macro File dialog box opens.

4. Type a file name for the macro and click Save.

To edit a macro:

1. On the Tools menu, point to Macro and click Edit. Hummingbird Basic
Workbench opens.

On the File menu, click Open.
Select the macro that you want to edit.
Make the necessary changes.

a k~ 0D

On the File menu, click Save and close the editor.

Note: You can also launch Hummingbird Basic Workbench on the Windows Start menu.
This utility is located in the Hummingbird/Accessories program group.

To run a macro:

1. In the host session window, point to Macro on the Tools menu and
click Run. The Browse Macro Files dialog box opens.

2. Select a macro file and click Open. The selected macro runs.



Note: You can automatically run a macro when you launch HostExplorer.

Related Topics
Connection Folder—Other Category
Running Quick-Keys, Quick Scripts, or Macros at Startup




Converting Wall Data RUMBA Macros

HostExplorer provides a utility that lets you convert Wall Data RUMBA
macros (. rmc files) into Hummingbird Basic macro files. The utility keeps
the original file intact and requests a destination folder for placing the
converted file. You can convert individual files or entire directories.

To convert Wall Data RUMBA macros:

1. On the Windows Start menu, navigate to the HostExplorer program
group and click Macro And Profile Converter. The Macro And Profile
Converter dialog box opens.

2. In the Conversion Type list, click Wall Data RUMBA Macros (*.RMC).

3. Inthe Files To Convert or Directory To Convert box, specify the file or
directory you want to convert.

4. In the Destination Directory box, specify a destination directory in
which to place the converted files.

5. If you are converting an entire directory and want the utility to include
subfolders in that directory, select the Recursive Search option.

6. If you are converting an entire directory and want to be notified before
each file is actually converted, select the Prompt Before Each
Conversion option.

7. Click Convert to begin the conversion.



Converting Attachmate Extra! Macros and
Profiles

HostExplorer provides a utility that lets you convert Attachmate Extra!
macros (. ebm files) and profiles (. edp files). The utility converts . ebm
files into Hummingbird Basic macro files, and it converts . edp files into
standard HostExplorer session profiles (. hep files).

The utility keeps the original file intact and requests a destination folder
for placing the converted file. You can convert individual files or entire
directories.

To convert Attachmate Extra! Macros or Profiles:

1.

On the Windows Start menu, navigate to the HostExplorer program
group and click Macro and Profile Converter. The Macro And Profile
Converter dialog box opens.

In the Conversion Type list, do one of the following:

. To convert a macro, choose the Attachmate Extra! Macros (*.EBM)
option.

. To convert a profile, choose the Attachmate Extra! v6.x Profiles
(*.EDP) option.

In the Files To Convert or Directory To Convert box, specify the file or
directory you want to convert.

In the Destination Directory box, specify a destination directory in
which to place the converted files.

If you are converting an entire directory and want the utility to include
subfolders in that directory, select the Recursive Search option.

If you are converting an entire directory and want to be notified before
each file is actually converted, select the Prompt Before Each
Conversion option.

Click Convert to begin the conversion.



Overview—Events

HostExplorer Event Handler lets you automate tasks by assigning actions
to specific system or host-initiated events. For example, when a string is
received from the host, you can automatically engage the Save-Screen
feature.

You can also automate tasks such as the execution of command
sequences and scripts using Quick-Keys, macros, and Quick Scripts. In
addition, you can assign events to other actions such as system
commands, action keys, editing keys, and characters.

Related Topics
Events Folder—General Category
Events Folder—Assignments Category




Creating an Event Scheme

You can define an event scheme to hold all related events that you
assign to certain function groups. You can save schemes and use them
in other profiles.

To create an event scheme:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Events folder and click the Assignments category.

3. Make sure that all the events that you want to add to the scheme are
listed in the Events list.

4. Click the Save Scheme As button. The Save Scheme As dialog box
opens.

5. In the Scheme Name box, type a nhame for the scheme and click OK.

Related Topics
Events Folder—Assignments Category




Creating and Deleting Events

After you have created events, you can add them to an event scheme.

To create an event:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Events folder, and click the Assignments category.

3. In the Scheme list, select a scheme.

6.

Under the Events list, click the Add New Event button. The Add New
Event dialog box opens.

In the dialog box, define parameters for and assign functions to the
new event.

Click OK.

To delete an event:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Events folder and click the Assignments category.

3. In the Scheme list, select the scheme that contains the event that you

5.

want to remove.
In the Events list, select the scheme that you want to remove.

Tip: To remove all events from the scheme, click the Delete All
button.

Click the Delete button.

Related Topics
Events Folder—Assignments Category

Add New Event Dialog Box




Editing Events

You can edit the parameters of existing events and re-assign them to
different function groups and functions. You can also change the order in
the current scheme, which affects the priority given to an event if it
overlaps another event. Higher events is in the stacking order are given
higher priority.

To edit an event:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Events folder and click the Assignments category.

3. In the Scheme list, select the scheme that contains the event that you
want to edit.

4. In the Events list, select the event that you want to edit.

5. Under the Events list, select the Edit Event Info button. The Edit Event
Info dialog box opens.

6. Configure the settings in the dialog box.
7. Click OK to save the settings and exit the dialog box.

To change the order of events:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Expand the Events folder and click the Assignments category.

3. Inthe Scheme list, select the scheme that contains the event you
want to move.

4. In the Events list, select the event that you want to move.

5. Under the Events list, click the Move Up or the Move Down button to
place the event in the position you want.

Related Topics
Events Folder—Assignments Category
Edit Event Info Dialog Box




Enabling Events

You can enable or disable programmed events.

To enable all programmed events:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Events folder and click the General category.

3. Select the Enable Events check box.

4.

Click OK.

To enable a specific event:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Expand the Events folder and click the Assignments category.

3. Under the Events list, click the Add New Event or the Edit Event Info
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button, depending on whether you want to create or modify an event.
The Add New Event or Edit Event Info dialog box opens.

In the Event Type list, select the event that you want to enable.
Select the Enabled check box.
Configure the settings for the event, if necessary.

7. Click OK.

Related Topics
Events Folder—General Category

Events Folder—Assignments Category

Add New Event Dialog Box

Edit Event Info Dialog Box




Overview—Hotspots

Hotspots are designated text strings or regions on the host screen.
Hotspots can occur anywhere on the screen and can contain a preceding
and/or trailing blank. Text hotspots can contain intervening blanks,
meaning they can consist of more than one word. Region hotspots are
rectangular areas that you define.

HostExplorer lets you define hotspot schemes. You can define a scheme
and then add however many text and region hotspots you want to that
scheme.



Assigning Hotspot Functions

When selected, hotspots execute predefined functions. You can assign
hotspots to any action, editing, or character key, and have them execute
system commands, macros, Quick-Keys, and Quick Scripts. Hotspots are
profile specific. Hotspot schemes can be saved and used in other
profiles.

After you have created a hotspot, you can click the hotspot text or region
and watch as the predefined action is executed. For example, many
electronic mail packages have the PF key legend at the bottom of the
screen. The format is usually as follows: PF2:Read, PF3:End, and so on.
In the Session Profile dialog box, if the Show Hotspots option in the
General category of the Display folder is selected, you can click the PF2
text on the screen to execute the PF2 action automatically.

The following text strings are automatically recognized as hotspots with n
representing any digit:

. Program Function Keys—PFn, PFnn, Fn, Fnn
. Program Attention Keys—PAn, An

For example, the PF1, PF2, F1, F12, PAl, PA2, Al text strings are
automatically recognized as hotspots.

Note: The Default hotspot scheme is available only for 3270 and 5250 connections.



Overlapping Hotspots

If hotspots overlap on the session screen, you can define the order in
which they are displayed. In the Hotspots Assignment category, the
hotspots nearest the top of the current hotspot scheme take precedence
over those below. You can manipulate the order at any time.

Note: Hotspots that do not display because of overlapping cannot be executed.

Related Topics
Hotspots Folder—General Category
Hotspots Folder—Assignments Category




Working with Hotspots

You can define a hotspot scheme to hold all related text and region
hotspots.

To create a hotspot scheme:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Open the Hotspots folder and click the Assignments category.

3. Click the Save Scheme As button. The Save Scheme As dialog box

4.

opens.
In the Scheme Name box, type a nhame for the scheme and click OK.

After you have defined a hotspot scheme, you can add text or region
hotspots to that scheme.

To create a new hotspot:

1.
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On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Open the Hotspots folder and click the Assignments category.

From the Scheme list, select a scheme.

Click the Add New Hotspot button. The Properties dialog box opens.
From the Type list, select a hotspot type and do one of the following:

. For a text hotspot, type the text you want to include in the hotspot
in the Hotspot Text box. This text doubles as the name for the
hotspot.

. For a region hotspot, type the name you want for the hotspot in the
Hotspot Name box.

6. Specify options for the hotspot. Click Next.

Specify a function group, a function, and ToolTip text.

8. Click Finish.



To delete a hotspot:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Open the Hotspots folder and click the Assignments category.
In the Scheme list, select a scheme.

Select the hotspot that you want to remove.

Click the Delete button.
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Related Topics
Hotspots Folder—Assignments Category




Modifying Hotspots

To edit a hotspot:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Open the Hotspots folder and click the Assignments category.

3. Select a scheme and select the hotspot you want to edit.

4. Click the Edit Hotspot Info button. The Edit Hotspot dialog box opens.
5. Configure the settings in both the Properties and Action dialog boxes.
6. Click OK to save the settings and exit the dialog box.

To change the order of hotspots:

1. On the Options menu, click Session Properties. The Session Profile
dialog box opens.

2. Open the Hotspots folder and click the Assignments category.
3. Select a scheme and select the hotspot you want to move.

4. Click the Move Up or Move Down button to place the hotspot in the
position you want.



Displaying Hotspots

To display hotspots:

On the View menu, click Hotspots. The hotspot setting applies to both
text and region hotspots.

To display hotspots using the Session Profile dialog box:

1.

N

2

7.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Open the Hotspots folder and click the Assignments category.
Confirm that the hotspots to activate are listed in the Hotspots box.

Click the General category.
Select the Enable Hotspots check box.
In the Hotspot Style box, select a style from the list.

In the Mouse Activation box, select Left Single Click or Left Double
Click.

Click OK.

To display hotspot tips:

1.

On the Options menu, click Session Properties. The Session Profile
dialog box opens.

Open the Hotspots folder and click the Assignments category.

3. Inthe Scheme list, select the scheme that contains the hotspot that

5.
6.

you want to modify.

In the hotspot list, select the hotspot for which you want to view the
hotspot tip.

Select the Show Hotspot Tips check box.
Click OK.

When you place your cursor over the hotspot in your session screen, the
hotspot ToolTip appears.




Related Topics

Hotspots Folder—Assignments Category
Properties Dialog Box

Action Dialog Box




Overview—Quick-Keys

Quick-Keys are multi-functional shortcuts that can store text and
commands. You can use Quick-Keys to execute a sequence of
commands automatically. HostExplorer lets you assign Quick-keys to
keyboard mappings, mouse actions, hotspots, toolbar buttons, and the
track menu.

You can create a Quick-Key using a combination of text, keys, and
commands. Once you have created a Quick-Key, you can assign it to any
session of the same terminal type.

Related Topics
HostExplorer Functions
Quick-Key System Commands




Creating Quick-Keys
You can create a Quick-Key to act as a shortcut for text and commands.

To create a Quick-Key:

1. On the Options menu, click Quick-Keys. The Quick-Key Editor dialog
box opens.

2. In the Quick-Key Name box, type a name for the Quick-Key.
3. In the Function Group list, select a function group.

4. In the Function list box, select the individual function you want to
apply to Quick-Key and click Append Function. The function is
displayed in the Assigned Quick-Key String field.

5. Repeat the previous step until you have appended all the desired
functions.

6. Click Set to implement the Quick-Key.
7. Click Save to save the Quick-Key to a Quick-Key file.

Note: When creating Quick-Keys, be sure to include a timing delay. This delay allows the
Auto Start Quick-Key to run when host data is received from a new session. To add
a delay, click Pause on the Function menu, and then click Append Function.

Related Topics
Quick-Key Editor Dialog Box




Loading and Running Quick-Keys

Load an existing Quick-Key to make it available.

To load a Quick-Key:

1. On the Options menu, click Quick-Keys. The Quick-Key Editor dialog
box opens.

2. Click Load. The Load Quick-Key dialog box opens.
3. Enter the name of the Quick-Key you want to load and click OK.

Run a Quick-Key to activate it.

To run a Quick-Key:

1. On the Options menu, click Quick-Keys. The Quick-Key Editor dialog
box opens.

2. From the Quick-Key list, select a previously loaded Quick-Key.
3. Click Run.

Note: You can automatically run a Quick Key when you launch HostExplorer.

Related Topics
Quick-Key Editor Dialog Box
Running Quick-Keys, Quick Scripts, or Macros at Startup




Creating Connection and Login Shortcuts

To automate connections, you can place profiles in a Star tup folder and
then create a HostExplorer shortcut that contains a - * switch as part of

the target string. When you double-click the shortcut, all profiles located
in the Star tup folder start automatically.

To designate profiles for automatic startup:

1. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Right-click the existing profile(s) you
want to designate for automatic startup and click Copy.

2. Open the Startup folder.
3. Right-click in the main area of dialog box and click Paste.

4. In Windows Explorer, navigate to the home directory for HostExplorer.
For example:

C:\Program Files\Hummingbird\Connectivity\versic

where version is the version number of your Hummingbird
product.

5. Right-click the file HostEx32. exe, click Send To, and then click
Desktop (Create Shortcut).

6. On the desktop, right-click the HostEx32. exe shortcut and click
Properties. The Properties dialog box for the shortcut opens.

7. On the Shortcut tab, add a -* switch to the end of the target
string. For example:

"C:\Program
Files\Hummingbird\Connectivity\version\HostExplc

*

where version is the version number of your Hummingbird
product.



8. Click OK.



Adding and Removing Shortcuts

You can add a connection shortcut icon to the desktop or another
location. To launch a session, double-click the shortcut icon.
To add a shortcut icon:

1. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Right-click a profile.

2. Click Create Shortcut. The Browse For Folder dialog box opens.
3. Browse to the location for the shortcut and click OK.

To remove a shortcut icon:

1. On the desktop, right-click the profile that you want to remove.
2. Click Delete.
3. Click Yes to confirm the deletion.



Running Quick-Keys, Quick Scripts, or Macros at
Startup

You can create a Quick-Key, Quick Script, or macro to launch the login
script automatically each time you open HostExplorer.

Warning! Automating logins may cause security problems.

To automatically run a Quick-Key, Quick Script, or macro at startup:

1.

On the Options menu of a session window, click Session Properties.
The Session Profile dialog box opens.

Open the Connection folder and click the Other category.

3. In the Auto Start Quick-Key/Quick Script/Macro box, do one of the

following:

. Type the full path name of the Quick-Key, Quick Script, or macro
that you want to use. Alternatively, click Browse to search for these
items.

. Select a Quick-Key from the drop-down list.

Note: If you click the browse button to search for Quick Script or macro files, select
Quick Script or Hummingbird Basic Files in the Files of Type list. To search for
Quick Script files, select HostExplorer Quick Script Files.

Click OK when finished.

On the File menu, click Save Session Profile. The Save Profile dialog
box opens.

6. Select the profile or type a new name.

Click Save.

Note: You can use this process to minimize the number of steps required to log into a
system. For example, you can avoid having to type your user name and password
each time you access a host.

Related Topics
Connection Folder—Other Category

Save Profile Dialog Box




Overview—Automating Login

You can automate your login using any of the following methods:

Automating Login Using Quick-Keys (3270 and 5250)

Automating Login Using Quick-Keys (VT)

Automating Login Using Quick Scripts

Automating Login Using the Express Logon Feature




Automating Login Using Quick-Keys (3270 and
5250)

You can automate login to a host by creating a Quick-Key or Quick Script
that contains the necessary information. The procedure for creating an
automated login for a 5250 connection or a 3270 connection depends on
the host operating system.

Warning! Automating logins may cause security problems.

To automate your login (5250 and, in some cases, 3270):

1.
2.

9.
0.

Connect to a host.

On the Options menu, click Quick-Keys. The Quick-Key Editor dialog
box opens.

In the Quick-Key Name box, enter a name for the Quick-Key, or select
one from the list.

In the Assigned Quick-Key String box, type your login name (user ID),
enclosed within quotation marks.

In the Function Group list, click Editing Keys.

. In the Function list box, click Tab.

Click Append Function. This action adds the command to the
Assigned Quick-Key String box.

Enter your password by doing one of the following:

. If you have created and saved your password already in the Other
category of the Connection folder, click System Commands on the
Function Group list. In the Function list box, click Password. This
action inserts an encrypted format of your password into the
Assigned Quick-Key String box.

. If you have not created and saved your password in the Other
category of the Connection folder, type your password in the
Assigned Quick-Key String box, enclosed with quotation marks.

In the Function Group list, click Action Keys.
In the Function list box, click Enter. Click Append Function when



finished.

At this point, the Assigned Quick-Key String box should contain
one of the following strings:

. If you have entered your password in the Other category of the
Connection folder:

"user 1id" Tab Password Enter

. If you manually typed your password in the Assigned Quick-Key
String box:

"user id" Tab "password" Enter

1. Click Set to implement the Quick-Key.
2. Click Save to save the Quick-Key to a Quick-Key file.

Related Topics

Connecting to a Host

Quick-Key Editor Dialog Box
Connection Folder—Other Category




Automating Login Using Quick-Keys (VT)

You can automate your login to a UNIX host by creating a Quick-Key that
contains the necessary information.

Warning! Automating your login may create security problems.

To automate your login (VT):

1.
2.

1.
2.

Connect to a host.

On the Options menu, click Quick-Keys. The Quick-Key Editor dialog
box opens.

In the Quick-Key Name box, type a name for the Quick-Key.

In the Assigned Quick-Key String box, type your login name (user id),
enclosed within quotation marks.

In the Function Group list, click Editing Keys.

. In the Function box, click Return.

Click Append Function. This action adds the command to the
Assigned Quick-Key String box.

In the Function Group list, click System Commands.

In the Function list box, click Pause. Click Append Function when
finished.

Enter your password by doing one of the following:

. If you have created and saved your password already in the Other
category of the Connection folder, click System Commands on the
Function Group list. In the Function list box, click Password. This
action inserts an encrypted format of your password into the
Assigned Quick-Key String box.

. If you have not created and saved your password in the Other
category of the Connection folder, type your password in the
Assigned Quick-Key String box, enclosed with quotation marks.

In the Function Group list, click Action Keys.

In the Function box, click Return. Click Append Function when
finished. At this point, the Assigned Quick-Key String box should



contain one of the following strings:

. If you have entered your password in the Other category of the
Connection folder:

"user 1id" Return Pause Password Return

. If you manually typed your password in the Assigned Quick-Key
String box:

"user id" Return Pause '"password" Return

3. Click Set to implement the Quick-Key.
4. Click Save to save the Quick-Key to a session profile.

Related Topics

Connecting to a Host

Quick-Key Editor Dialog Box
Connection Folder—Other Category




Automating Login Using Quick Scripts

Automate host login by creating a Quick Script that contains the
necessary information.

To automate your login (5250, in some cases 3270 and VT):

1.

In the host session window, point to Quick Script on the Tools menu
and click Edit. HostExplorer Quick Script Editor opens.

Double-click the default header line “Untitled: Description of Quick
Script”. The Quick Script Description dialog box opens.

Type a name and description for the new Quick Script file and click
OK.

On the Commands menu, click Declare Variable. The Declare
Variable dialog box opens.

In the Variable Name box, type a name for the variable; for example,
UserlD.

6. In the Initial Value box, type your login name (user ID) and click OK.

To declare a variable for your password, repeat steps 4 to 6.

8. On the Commands menu, click Send Variable to Screen. The Send

Variable To Screen dialog box opens.

In the Variable Name list, select the variable name that you specified
for your login name and click OK.

On the Commands menu, click Send Keystrokes. The Send
Keystrokes dialog box opens.

In the Category list, select Editing Keys.

2. In the Mnemonic list, select Tab, and click Insert. The mnemonic

appears in the Keystrokes box. Click OK.

On the Commands menu, click Send Variable to Screen. The Send
Variable to Screen dialog box opens.

In the Variable Name list, select the variable name that you specified
for your password and click OK.

On the Commands menu, click Send Keystrokes. The Send



Keystrokes dialog box opens.
6. In the Category list, select Action Keys.

7. In the Mnemonic list, select Enter, and click Insert. The mnemonic
appears in the Keystrokes box.

8. Click OK.
9. On the toolbar, click Save.

Related Topics
Connecting to a Host
Connection Folder—Other Category




Automating Login Using the Express Logon

Feature
3270

The Express Logon Feature (ELF) lets a user running a 3270 client
session log on to a host system using a digital certificate instead of a
user ID and password.

To use the Express Logon Feature, make sure that the following are true:

. The host session is configured for SSL with client authentication.
. Each user has a unique digital certificate.
. The connection is to a supported VT server.

An Express Logon macro sends tags for the username and password.
The tags are USR. ID for username and PSS .WD for password. As a

result, your username and password are not sent over the connection. In
order for an application to be accessed using the Express Logon Feature,
a PassTicket data class profile (PTKTDATA) must be defined on the host

system.

To automate your login using the Express Logon Feature:
Do one of the following:

. Create an ELF macro using the macro record function. You can
record an ELF macro by performing your normal logon procedure and
entering the tags instead of your real username and password.

. Use the sample logon macro (ExpressLogonTSO0. ebs) that is
installed in your Macro folder. You may need to change the logon
string for the application ID (APPLID) that the host server uses to
identify the application. Your host system administrator can provide
you with the Application ID.

For more information about the Express Logon Facility, refer to the
following IBM publications:

. IBM Z/OS Communications Server IP Configuration Guide V1R2
SC31-8775-01



. IBM Z/OS Communications Server IP Configuration Reference V1R2
SC31-8776-01

. IBM Host Access Client Package Update Redbook
SG24-6182-01 (Chapters 3.7, 11.8, 25.3)

Most publications are available in Adobe PDF format form:
http://www.ibm.com/servers/eserver/zseries/zos/bk:

http://www.redbooks.ibm.com/

Related Topics

Connection Folder—LU Category

Automating Login Using Quick-Keys (3270 and 5250)
Automating Login Using Quick-Keys (VT)
Automating Login Using Quick Scripts



http://www.ibm.com/servers/eserver/zseries/zos/bkserv/
http://www.redbooks.ibm.com/

Logging Session Activity

If you encounter problems related to PC-to-host interactions, you can use
either the Trace utility or a command-line trace to find a solution.



Creating and Enabling a Trace

Atrace is a diagnostic tool that logs PC-to-host interactions to the
hetrace. txt file located in the user's My Documents directory. The
trace utility captures all keystrokes, commands, and selections on menus
and in dialog boxes. It also records all communication activity. After you
have reproduced the steps that caused the problem, you can view and
analyze the logged data.

To enable a trace, press Ctrl+Shift+T. This key combination starts
recording events to the hetrace. txt file.
Note: If you modified default keyboard mappings, this procedure may not work. To reset the default

settings, open the Keyboard Mapping dialog box, select the letter T on the keyboard and press
Default.



Starting a Command Line Trace

To start a command line trace:

1

2.

On the Windows Start menu, click Run.
Browse to the following location:
C:\Program Files\Hummingbird\Connectivity\versic

where version is the version number of your Hummingbird
product.

Add the following command line option:

-d

To run the trace with an existing profile, add the following
command line option:

-p

. Add the profile name and folder name separated by a dot. For

example:

profile.folder

The following is an example of the full command line syntax:

“C:\Program Files\Hummingbird\Connectivity\vers:
-d -p profile.folder



HostExplorer Menu Descriptions
3270 5250 VT

Click one of the following links to view the default menu descriptions:

« File Menu « Edit Menu

« Transfer Menu « Fonts Menu

=« Options Menu = JTools Menu

=« View Menu « Window Menu
« Help Menu

Note: If you are running a web-deployed installation of HostExplorer, some menu commands may be
unavailable. Availability of menu commands depends on which commands and options your
administrator has enabled.



Session Options
3270 5250 VT

You can make changes to session profiles that are not available through
the GUI. You can make these changes by adding/changing an entry in
the [PROFILE] section of a session profile with an . hep extension.
Session profiles are located in the Profile directory where the user
files are stored on your machine. To access the User Files folder,
double-click the User Files shortcut in the Hummingbird Connectivity
program group.

You can change the following parameters:
. Auto End Quick-Key/Quick Script/Macro—Enables HostExplorer to

save the macro, Quick-Key, or Quick Script and launch it
automatically each time you close a session.

. Clear Buffer On Connect—Enables or prevents the screen from being
cleared on reconnect.

. Disable Replies—Disables any specific 3270 structured field support.

. Display Field Info—Prevents HostExplorer from updating the Numeric
Field and Operator Selectable Field in the OIA each time you move
the cursor.

. Max Hosts History—Limits the number of host names that display in
the Open Session dialog box and the New Profile Host Name list.

. ReRun Auto Quick-Key—Disables the Auto Quick-Key/Macro when a
session is reconnected.

. Show Maximized—Opens all session windows in the maximized
state.

. Scroll SSCP _Screens—~Prevents scrolling of SSCP screens when in
SSCP_LU mode.

. TN5250E—Disables support for the TN5250E protocol.

. Use Single Font Name—Retains the font name of a restored session
when a session is maximized.

. VT Reset ISO Colors—Changes how the emulator reacts to a SGR 0
command.




Related Topics
User Environment Customization
HostExplorer Functions




Quick-Key System Commands
3270 5250 VT

There are special System Commands which function only in Quick-Keys.
You can use these commands to automate Quick-Key operations.

IPause—Synchronizes AID generating keys. This command causes the
Quick-Key to pause until the keyboard is unlocked for up to a five-second
interval. This can be useful if you want a Quick-Key to press multiple AID
generating keys. This function is only available in TN3270 and TN5250
sessions.

Jump-To-Session—Jumps to any session window directly. The window
session short name is entered immediately after the Jump-To-Session
command. For example:

Jump-To-Session "A"

Pause—Pauses for a ¥2 second interval. Use this command to
synchronize with events on the host system.

Password—Types the contents of the Password edit field stored in the
session profile. Therefore, you can save a password (encrypted) in a
profile and use it without knowing its contents. The program enters the
password text only if the current field is a non-display field.

Prompt-Password—Prompts the user for a password. The contents of
the password are stored in an internal variable that you can enter in a
hidden field using the Password command described in this topic. For
example, if you wanted to create a script that logged you into CMS
automatically, your Quick-Key may look like this:

Home Prompt-Password "CMSUSER" Tab Password Enter

This Quick-Key presses the Home key, prompts for the password, enters
a user ID called CMSUSER, presses the Tab key, enters the password

contents, and presses the Enter key. This function is only available in
TN3270 sessions.

Run—Runs an external program directly. The command and options are



passed by entering text immediately after the Run command in a Quick-
Key. For example:

Run "notepad.exe C:\\config.sys"

When using the Run command, a text string must follow the Run
command. The text string contains the full command name and any
command line options. HostExplorer ignores any other commands
entered after the string.

Start-Session—Starts a new terminal session. You send the command
by entering text immediately after the Start-Session command in a Quick-
Key. For example:

Start-Session '"profilename.folder"

When using the Start-Session command, a text string must follow the
Start-Session command. The text string contains the profile name
followed by its folder. Any other commands entered after the string are
ignored.

Related Topics
HostExplorer Functions
Command Line Options




Command Line Options
3270 5250 VT

You can use the Command Line options to automate certain tasks such
as starting a single connection or loading a specific profile. At the
command prompt, add the following options to the end of the command
line. Use spaces between each option. For example:

"c:\hostex32.exe" -P VMCMS.Startup

If the first word does not begin with a dash, HostExplorer assumes that it
is the host IP name or address.

You can set the following command line options:

-D—Lets you write additional detailed debugging information to the
hetrace. txt file.

-H hostname—Overrides the gateway name or host address when
creating a window with a specific profile using the -p option. You can
specify the port number by appending it to the end of the host address.
For example:

hostex32.exe -h 1.2.3.4,1023

Make sure there are no intervening spaces between the command and
the port number.

To initiate connections from programs such as Gopher, use the following
format:

hostex32.exe -H ipaddr, port

Substitute ipaddr with the host IP address or name and, if required,
append the port number.

-P profname.folder—Begins a session using the profile and folder
specified. This is useful if you want to create icons that connect to
specific hosts. For example:



hostex32.exe -P VMTCP.Startup

-*—Automatically starts all profiles located in the Startup folder.



Clipboard Format Description
3270 5250 VT

HostExplorer uses a private clipboard format that is dynamically
registered with the Windows operating system. Therefore, there is no
pre-assigned type for this format. The only way to check the format is to
get the format value and call GetClipboardFormatName and see if the
name is WIN3270.

To prevent any conversion problems, all normal screen data is stored in
EBCDIC. Therefore, it is your responsibility to convert the data to ASCII.



WIN3270 Clipboard Format

Index Type Description

+0 Word Number of Rows in Clipboard Image (RR)
+2 Word Number of Columns in Clipboard Image (CC)
+4 PSCHAR || Character at Row 1, Column 1

+6 PSCHAR || Character at Row 1, Column 2

+4+(CC*2) || PSCHAR || Character at Row 2, Column 1

+6+(CC*2) || PSCHAR || Character at Row 2, Column 2

Related Topics
Type Formats

Buffer Contents

TN3270 Host Graphic Configuration




OEM Data Stream Format
3270

You can use the Write Structured Field Read Partition Query command to
determine if HostExplorer is connected to your system. Refer to the
source supplied for PCPRINT if you want to add the support to your own
application. HostExplorer adds the following reply type when it is present.
(The data is in hexadecimal and EBCDIC).



OEM Auxiliary Device Reply

Field Name | OffSet || Description

SFLEN +0 Structured field length.

X'818F' +2 Structured field ID.

x'0000' +4 Reserved field.

TCP3270 +6 Device Type. This field always contains the value TCP3270 with a trailing
blank in EBCDIC.

OSID +14 O/S Type. This field contains the operating system name padded with
blanks in EBCDIC. The current values are: DOS3, WIN3, and OS/2.

x'04010000" || +22 Reserved field.

SUBLEN +26 Subfield length. This contains the length of the subfield that follows. The
field will usually have a minimum length of 12.

X'FF' +27 Subfield ID. This value identifies the subfield as a HOSTEX type.

MAJ_VER +28 Major Version Number. This 1 byte value identifies the major version
number.

MIN_VER +29 Minor Version Number. This 1 byte value identifies the minor version
number.

SYSFLG1 +30 System Flag 1. All reserved for future use.

SYSFLG2 +31 System Flag 2. All reserved for future use.

NETADDR +32 Network Address. This field contains the TCP/IP network address of the
workstation in network byte order. Although the field is 10 bytes long, only
the first 4 bytes are used.

LOGINNAME || +42 Not used.

X'00 +42+LL || Null terminator. This null byte terminates the LOGINNAME field and is
always present.

Related Topics
Clipboard Format Description

HostExplorer Functions




Supported SCS Control Sequences

The following is a list of supported SNA Character String (SCS) control
sequences:

Function (| Code Description

BEL Ox2F Bell

CR 0x0D Carriage return

FF 0x0C Form feed

GE 0x08xx Graphic escape

HT 0x05 Horizontal tab

IRS Ox1E Interchange record separator
LF 0x25 Line feed

NL 0x15 New line

NUL 0x00 Null

RFF 0x3A Required form feed
RNL 0x06 Required new line

SA 0x28+ Set attribute

SHF 0x2BC1+ Set horizontal format
SLD 0x2BC6+ Set line density

SPD 0x2B+ Set print density

SVF 0x2BC2+ Set vertical format
TRN 0x35+ Transparency block
ATRN 0x36 Absolute transparency
VT 0x0B Vertical tab

SHM || 0x2BD2nn11+ || Set horizontal margins



SVM 0x2BD2nn49+ || Set vertical margins

SPPS 0x2BD2nn40+ || Set presentation page size

SLS 0x2BD20309+ || Set line spacing

SSLD 0x2BD20415+ || Set single line distance

SIC 0x2BD20345+ || Set initial conditions

STO 0x2BD3nnF6+ || Set text orientation

AHPP 0x34CO0+ Absolute horizontal presentation position

AVPP 0x34C4+ Absolute vertical presentation position
0x03nn+ ASCII Transparent

Related Topics
Special Characters




Special Characters
3270 5250 VT

You can enter Escape and binary codes in 'C' style syntax using the
backslash character ('\'). HostExplorer treats inline spaces as part of the
sequence.

\a—-Bell (alert)
\b—Backspace
\e—Escape

\f—Formfeed
\n—Newline

\r—Carriage return
\t—Horizontal tab
\v—Vertical tab

\ '—Single quotation mark
\""—Double quotation mark
\\—Backslash
\xhh—ASCII character in hexadecimal notation

Using the sequence \xhh, you can specify any ASCII character as a

hexadecimal character code. For example, you can set the ASCII
backspace character as the normal C escape sequence (\b), or you can

code it as \x08 hexadecimal.

You must use at least one digit for a hexadecimal escape sequence, but
you can omit the second digit. Therefore, you can specify the
hexadecimal escape sequence for the backspace as either \x8 or
\Xx08.

You can enter control sequences using the caret format. For example, to
enter a Ctrl+A value, you would type MA. To enter a caret, enter the caret

character twice, for example: AN



Related Topics
Clipboard Format Description




Keystroke Mhemonics—3270 and 5250 SendKey

Functions
3270 5250

You can use the following Special Key strings to create key strings using
the ESC character.

These mnemonics are used by EHLLAPI/WinHLLAPI SendKey (3), DDE
Poke Keystroke item, and Host Keys method to press special 3270
functions keys. All special keys are available by using the command
delimiter @ (the ESC character). For example, you can send an Enter
command to the host by sending the @E string and you can send a
normal @ symbol by sending two @@ symbols.

Mnenomic || Description (| Mnenomic (| Description
@B Backtab @k PF20

@C Clear Display || @I PF21

@D Delete @m PF22

@E Enter @n PF23

@F Erase EOF @o PF24

@H 5250Help @u Roll Up

@I Insert @v Roll Down
@J Next-Session || @x PA1l

@L Cursor Left @y PA2

@N Newline @z PA3

@P 5250Print @AQ@E Field Exit
@R Reset @AQ@F Erase Input
@T Tab @A@H Test Request
@UuU Cursor Up @A@J Cursor Select




| @V Cursor Down “ @A@L | Fast Left
@z Cursor Right || @A@Q Attention
@0 Home QA@- Field Minus
@1 PF1 @A@+ Field Plus
@2 PF2 @A@< Record Backspace
@3 PF3 @A@Z Fast Right
@4 PF4 @At Print Screen
@5 PF5 @A@Y Next Word
@6 PF6 @A@z Prev Word
@7 PF7 @S@x Duplicate
@8 PF8 @S@y Field Mark
@9 PF9 @i PF18
@a PF10 @j PF19
@b PF11 @k PF20
@c PF12 @l PF21
@d PF13 @m PF22
@e PF14 @n PF23
@f PF15 @o PE24
@g PF16 @u Roll Up
@h PF17 @v Roll Down
@i PF18 @x PAl
Q@j PF19

Related Topics




Keystroke Mnemonics—VT SendKey Functions




Keystroke Mnemonics—VT SendKey Functions
VT

You can use the following Special Key to create key strings using the
ESC character.

These mnemonics are used by EHLLAPI/WinHLLAPI SendKey (3), DDE
Poke Keystroke item, and Host Keys method to press special 3270
functions keys. All special keys are available by using the command
delimiter @ (the ESC character). For example, you can send an Enter
command to the host by sending the @E string and you can send a
normal @ symbol by sending two @@ symbols.

The EHLLAPI and WIinHLLAPI Interfaces provide increased support for
certain sequences using the SendKey (3) Function. The following
sequences are now supported when the session (PS) is in VT Mode.
Certain keys, such as F16 through F20, are only valid in VT220 mode or
higher.

Mnemonic || Description || HexByte Pseudo Code

@B Backtab 1B 5B 5A (Esc[2)

@cC Clear Display

@D Delete 7F

@E Enter 1B 4F 4D (Esc O M)

@L Cursor Left 1B 5B 44 or 1B 4F 44 || (Esc [ D or Esc O A)

@N Newline OA

@R Return

@T Tab 09 (HT)

@uU Cursor Up 1B5B41or1B 4F 41 || (Esc[Aor Esc O A)

@V Cursor Down |[ 1B 5B 42 or 1B 4F 42 || (Esc [ B or Esc O B)

@z Cursor Right || 1B 5B 43 or 1B 4F 43 || (Esc [ C or Esc O C)
I | | I




@1 PF1 1B 4F 50 (Esc 0 P)
@2 PF2 1B 4F 51 (Esc 0 Q)
@3 PF3 1B 4F 52 (EscO0R)
@4 PF4 1B 4F 53 (Esc0YS)
@6 F6 1B 5B 3137 7E (Esc[17~)
@7 F7 1B 5B 31 38 7E (Esc[18~)
@8 F8 1B 5B 31 39 7E (Esc[19~)
@9 F9 1B 5B 31 30 7E (Esc[20~)
@a F10 1B5B 3131 7E (Esc[21~)
@b F11 1B 5B 31 33 7E (Esc[23~)
@c F12 1B 5B 32 34 7E (Esc[24~)
@d F13 1B 5B 32 35 7E (Esc[25~)
@e F14 1B 5B 32 36 7E (Esc[26~)
of F15 1B 5B 32 38 7E (Esc[28~)
@g F16 1B 5B 32 39 7E (Esc[29~)
@h F17 1B 5B 32 31 7E (Esc[31~)
@i F18 1B 5B 32 32 7E (Esc[32~)
Q@j F19 1B 5B 32 33 7E (Esc[33~)
@k F20 1B 5B 32 34 7E (Esc[34~)
@A@< Backspace 08 (BS)

Related Topics

Keystroke Mnemonics—3270 and 5250 SendKey Functions




Keyboard Emulation Tables
3270 5250 VT

The following are the PC Keys, Terminal Function, and function
descriptions for TN3270, TN5250, Telnet, and Linux keyboards:

. TN3270 Keyboard Emulation Tables
. TN5250 Keyboard Emulation Tables
. Telnet Keyboard Emulation Tables

. Linux Keyboard Emulation Tables

Related Topics
Mouse Customization
Keyboard Customization




TN3270 Keyboard Emulation Tables
3270

The following are the keys and functions for the TN3270 Keyboard:



PC Key—TN3270 Function

Key Function

Cursor Keys Normal cursor movement

Cursor Keys (Keypad) Normal cursor movement

End Moves cursor to end of field

Ins Toggle Insert Mode

Ins (Keypad) Toggle Insert Mode

Del Deletes character at cursor location
Del (Keypad) Deletes character at cursor location
Ctrl-Enter New line

Ctrl-Enter (Keypad) New line

* (Keypad) New line

Home Moves cursor to Home position
Home (Keypad) Moves cursor to Home position
Tab Moves cursor to next field

Shift-Tab Moves cursor to previous field
Ctrl-Left-Arrow Previous word

Ctrl-Left-Arrow (Keypad) || Previous word

Ctrl-Right-Arrow Next word

Ctrl-Right-Arrow (Keypad) || Next word

Esc Reset (Unlock keyboard and clear Insert)
Ctrl-End Erase to End of Field (Erase EOF)
Ctrl-End (Keypad) Erase to End of Field (Erase EOF)




Ctrl-Home

Erase all Input Fields (Erinp)

Ctrl-Home (Keypad)

Erase all Input Fields (Erinp)

Ctrl-Del

Delete word

Ctrl-Del (Keypad)

Delete word

Backspace

Move cursor left and delete character

Alt-Backspace

Toggle APL input mode

- (EBCDIC Not Sign)
(Hat over '6' on PC Keyboard)

| (EBCDIC Vertical Bar)
(Split Bar on PC Keyboard)

Ctrl-6

¢ (EBCDIC Cent Sign)

Enter

Enter

Enter (Keypad)—Enter

(101/102-key Keyboards)

- (Keypad) PA1
+ (Keypad) PA2
/ (Keypad) PA3
Pause Clear
Page Up PF7
Page Up (Keypad) PF7
Page Down PF8
Page Down (Keypad) PF8

F1-F12 PF1-PF12 (101/102-key Keyboards)
Shift F1-F12 PF13-PF24 (101/102-key Keyboards)
F1-F10 PF1-PF10 (84-key Keyboards)

Shift F1-F10 PF11-PF20 (84-key Keyboards)




Ctrl F1-F4

PF21-PF24 (84-key Keyboards)

F13-F15

PF13-PF15




PC Key—Function Description

PC Key Function Description

Ctrl-A Create a new session

Ctrl-B Close the current session

Ctrl-C Copy highlighted text to clipboard

Ctrl-D Duplicate

Ctrl-E Enable/Disable Entry Assist Mode

Ctrl-F Field mark

Ctrl-G Enable/Disable Attribute Display

Ctrl-H Clear Type Ahead buffer

Ctrl-l Insert text from clipboard

Ctrl-N Jump to next session

Ctrl-P Print the current screen

Ctrl-Q Terminate all sessions and exit HostExplorer
Ctrl-R Receive a file from the host

Ctrl-S Send a file to the host

Ctrl-T Toggle crosshair cursor

Ctrl-Shift-T Toggle stack tracing

Ctrl-v Paste text from clipboard to cursor location
Ctrl-w Enable/Disable WordWrap mode

Ctrl-X Copy highlighted text to clipboard and delete
Ctrl-Y Redo

Ctrl-Z Undo




Ctrl Numpad-5

Select entire screen

Ctrl-Ins

Copy highlighted text to clipboard

Ctrl-Ins (Keypad)

Copy highlighted text to clipboard

Shift-Ins

Paste text from clipboard to cursor location

Shift-Ins (Keypad)

Paste text from clipboard to cursor location

Shift-Del

Copy highlighted text to clipboard and delete

Shift-Del (Keypad)

Copy highlighted text to clipboard and delete

Shift-Down-Arrow

Extend the selection down 1 line

Shift-Down-Arrow (Keypad)

Extend the selection down 1 line

Shift-Left-Arrow

Extend the selection left 1 column

Shift-Left-Arrow (Keypad)

Extend the selection left 1 column

Shift-Right-Arrow

Extend the selection right 1 column

Shift-Right-Arrow (Keypad)

Extend the selection right 1 column

Shift-Up-Arrow

Extend the selection up 1 line

Shift-Up-Arrow (Keypad)

Extend the selection up 1 line

Ctrl-Shift-Left

Extend the selection to include the previous word

Ctrl-Shift-Left (Keypad)

Extend the selection to include the previous word

Ctrl-Shift-Right

Extend the selection to include the following word

Ctrl-Shift-Right (Keypad)

Extend the selection to include the following word




TN5250 Keyboard Emulation Tables
5250

The following are the keys and functions for the TN5250 Keyboard:



PC Key—5250 Function

PC Key 5250 Function

Cursor Keys Normal cursor movement

Cursor Keys (Keypad) Normal cursor movement

End Move cursor to end of field

End (Keypad) Move cursor to end of field

Ins Toggle Insert mode

Ins (Keypad) Toggle Insert mode

Del Delete character at cursor location
Del (Keypad) Delete character at cursor location
Ctrl-Enter New line

Ctrl-Enter (Keypad) New line

* (Keypad) New line

Home Move cursor to Home position
Home (Keypad) Move cursor to Home position
Tab Move cursor to next field

Shift-Tab Move cursor to previous field
Ctrl-Left-Arrow Previous word

Ctrl-Left-Arrow (Keypad) || Previous word

Ctrl-Right-Arrow Next word

Ctrl-Right-Arrow (Keypad) || Next word

Esc Reset (Unlock keyboard and clear Insert)
Ctrl-End Erase to End of Field (Erase EOF)




Ctrl-End (Keypad)

Erase to End of Field (Erase EOF)

Ctrl-Home

Erase all Input fields (Erinp)

Ctrl-Home (Keypad)

Erase all Input fields (Erinp)

Ctrl-Del

Erase word

Ctrl-Del (Keypad)

Erase word

Backspace Move cursor left and delete character
A - (EBCDIC Not Sign)
(Caret over '6' on PC Keyboard)
: | (EBCDIC Vertical Bar)
(Split Bar on PC Keyboard)
Ctrl-6 ¢ (EBCDIC Cent Sign)
Enter Enter
Enter (Keypad) Field-Exit (101/102-key Keyboards)
- (Keypad) Field-Minus
+ (Keypad) Field-Plus
Pause Clear
Page Up Roll down
PgUp (Keypad 9) Roll down
Page Down Roll up
PgDn (Keypad 3) Roll up

Ctrl-F1 5250 Help Function

Shift-Esc System Request

F1-F12 PF1-PF12 (101/102-key Keyboards)
Shift F1-F12 PF13-PF24 (101/102-key Keyboards)
F1-F10 PF1-PF10 (84-key Keyboards)




Shift F1-F10

PF11-PF20 (84-key Keyboards)

Ctrl F1-F4

PF21-PF24 (84-key Keyboards)




PC Key—Function

PC Key Function

Ctrl-A Create a new session

Ctrl-B Close the current session

Ctrl-C Copy highlighted text to clipboard

Ctrl-D Duplicate

Ctrl-E Enable/Disable Entry Assist Mode

Ctrl-F Field mark

Ctrl-G Enable/Disable Attribute Display

Ctrl-H Clear Type Ahead buffer

Ctrl-l Insert text from clipboard

Ctrl-N Jump to next session

Ctrl-P Print the current screen

Ctrl-Q Terminate all sessions and exit HostExplorer
Ctrl-T Toggle crosshair cursor

Ctrl-Shift-T Toggle stack tracing

Ctrl-v Paste text from clipboard to cursor location
Ctrl-w Enable/Disable WordWrap mode

Ctrl-X Copy highlighted text to clipboard and delete
Ctrl-Y Redo

Ctrl-Z Undo

Ctrl Numpad-5 Select entire screen

Ctrl-Ins Copy highlighted text to clipboard




Ctrl-Ins (Keypad)

Copy highlighted text to clipboard

Shift-Ins

Paste text from clipboard to cursor location

Shift-Ins (Keypad)

Paste text from clipboard to cursor location

Shift-Del

Copy highlighted text to clipboard and delete

Shift-Del (Keypad)

Copy highlighted text to clipboard and delete

Shift-Down-Arrow

Extend the selection down 1 line

Shift-Down-Arrow (Keypad)

Extend the selection down 1 line

Shift-Left-Arrow

Extend the selection left 1 column

Shift-Left-Arrow (Keypad)

Extend the selection left 1 column

Shift-Right-Arrow

Extend the selection right 1 column

Shift-Right-Arrow (Keypad)

Extend the selection right 1 column

Shift-Up-Arrow

Extend the selection up 1 line

Shift-Up-Arrow (Keypad)

Extend the selection up 1 line

Ctrl-Shift-Left

Extend the selection to include the previous word

Ctrl-Shift-Left (Keypad)

Extend the selection to include the previous word

Ctrl-Shift-Right

Extend the selection to include the following word

Ctrl-Shift-Right (Keypad)

Extend the selection to include the following word




Telnet Keyboard Emulation Tables
VT

The following are the keys and functions for the telnet Keyboard:



PC Key—VT Function

PC Key VT Function

Cursor Keys Normal cursor movement
Cursor Keys (Keypad) Normal cursor movement
Backspace Backspace or Delete, depending on Keyboard Options settings
Tab Send Tab character
Ctrl-Backspace Delete

Esc Send Escape character
Ctrl-Esc Send Del character
Enter Return

Enter (Keypad) Return

Ctrl-Enter New line

Ctrl-Enter (Keypad) New line

Ins Insert Here

Ins (Keypad) Insert Here

Home Home

Home (Keypad 7) Home

PageUp Prev

PgUp (Keypad 9) Prev

Del Remove

End End

End (Keypad) End

Page Down Next




Pg Dn (Keypad 3)

Next

Ctrl-Space Send null byte

Ctrl-Shift-T Toggle stack tracing

Ctrl-1 PF 1

Ctrl-2 PF 2

Ctrl-3 PF 3

Ctrl-4 PF 4

NumLock PF 1

/ (Keypad) PF 2

* (Keypad) PF 3

- (Keypad) PF 4

F1-F12 F1 through F12 (VT220 and higher)
Shift F1 - F8 F13 through F20 (VT220 and higher)
F1 Hold

F2 Toggle Auto-Print

Ctrl-F2 Print-Raw

F3 Show Session Profile Dialog Box
Ctrl-F3 Power-On Reset

F4 Toggle Scrollback

F5 Send telnet Break Signal

Ctrl-F5 Send Answerback Message
Alt-F8 Compose

Ctrl-Ins Copy highlighted text to clipboard

Ctrl-Ins (Keypad)

Copy highlighted text to clipboard




Shift-Ins

Paste text from clipboard to cursor location

Shift-Ins (Keypad)

Paste text from clipboard to cursor location

Shift-Down-Arrow

Extend the selection down 1 line

Shift-Down-Arrow (Keypad)

Extend the selection down 1 line

Shift-Left-Arrow

Extend the selection left 1 column

Shift-Left-Arrow (Keypad)

Extend the selection left 1 column

Shift-Right-Arrow

Extend the selection right 1 column

Shift-Right-Arrow (Keypad)

Extend the selection right 1 column

Shift-Up-Arrow

Extend the selection up 1 line

Shift-Up-Arrow (Keypad)

Extend the selection up 1 line

Ctrl-Shift-Left

Extend the selection to include the previous word

Ctrl-Shift-Left (Keypad)

Extend the selection to include the previous word

Ctrl-Shift-Right

Extend the selection to include the following word

Ctrl-Shift-Right (Keypad)

Extend the selection to include the following word




APL Default Keyboard Table
3270

HostExplorer fully supports the APL/APL2 character sets for data entry
and display. To enter APL characters, press the default APL toggle key or
Alt-Backspace. The default keyboard mapping is nearly identical to the
mapping on a real IBM 3179G Display terminal.

APL Character EBCDIC Value (| Default Keystroke
A Underbar 41 Alt + A
Alpha BO Shift + A
B Underbar 42 Alt + B
C Underbar 43 Alt+C
Circle 9D Shift + O
Circle Bar ED Alt +7
Circle Slope CF Alt + 6
Circle Star FD Alt + 8
Circle Stile CD Alt +5

D Underbar 44 Alt + D
Del BA Shift + G
Del Stile DC Alt + 3
Del Tilde FB Alt + 2
Delta BB Shift + H
Delta Stile DD Alt+4
Delta Underbar FC Alt +\
Dieresis 72 Shift + 1
Dieresis Dot EC Alt + ]




Divide B8 Shift + =
Down Arrow 8B Shift + U
Down Caret 78 Shift + 9
Down Caret Tilde CB Alt+9
Down Shoe AB Shift + V
Down Stile 8E Shift + D
Down Tack AC Shift + B
Down Tack Jot FE Alt +;
Down Tack Up Tack DA Alt+1

E Underbar 45 Alt+ E
Epsilon B1 Shift + E
Epsilon Underbar 75 Shift + ]
Equal Underbar EO ]

F Underbar 46 Alt + F
G Underbar 47 Alt+ G
H Underbar 48 Alt + H

| Underbar 49 Alt + 1
lota B2 Shift + |
lota Underbar 74 Alt + F3
J Underbar 51 Alt +J
Jot AF Shift +J
K Underbar 52 Alt + K
L Underbar 53 Alt + L




Left Arrow 9F [

Left Brace Co

Left Bracket AD

Left Bracket Right Bracket | CC Alt + F2
Left Paren C1

Left Shoe 9B Shift+ Z
M Underbar 54 Alt + M
N Underbar 55 Alt + N
Not Equal BE Shift + 8
Not Greater 8C Shift + 4
Not Less AE Shift + 6
O Underbar 56 Alt+ O
Omega B4 Shift + W
Overbar A0 Shift + 2
P Underbar 57 Alt + P
Q Underbar 58 Alt+Q
Quad 90 Shift + L
Quad Divide EE Alt + =
Quad Jot 73 Alt + F1
Quad Quote DE Alt + [
Quote Dot DB Alt + - (Minus sign)
R Underbar 59 Alt + R
Rho B3 Shift + R
Right Arrow 8F Shift + [




Right Brace DO

Right Bracket BD ' (Single Quote)
Right Paren D1

Right Shoe 9A Shift + X
S Underbar 62 Alt+S
Slash Bar EA Alt +/
Slope B7 Shift +/
Slope Bar EB Alt + . (Period)
Stile BF Shift + M
Superscript 0 FO

Superscript 1 F1

Superscript-2 F2

Superscript-3 F3

Superscript-4 F4

Superscript-5 F5

Superscript-6 F6

Superscript-7 F7

Superscript-8 F8

Superscript-9 F9

T Underbar 63 Alt+T
Tilde 80 Shift+ T
Times B6 =

U Underbar 64 Alt + U




Up Arrow 8A Shift + Y

Up Caret 71 Shift + 0 (Zero)
Up Caret Tilde CA Alt + 0 (Zero)
Up Shoe AA Shift + C

Up Shoe Jot DF Alt +, (Comma)
Up Stile 8D Shift+ S

Up Tack BC Shift + N

Up Tack Jot EF Alt +' (Quote)
V Underbar 65 Alt +V

W Underbar 66 Alt + W

X Underbar 67 Alt + X

Y Underbar 68 Alt +Y

Z Underbar 69 Alt+Z

Related Topics

Mouse Customization

Keyboard Customization




Linux Keyboard Emulation Tables

Linux support is also available in the form of built-in functions, which you
can access in the Keyboard Map dialog box. To access built-in functions,
do the following:

1. On the Options menu, select Session Properties.

2. Open the Terminal Folder, VT Category, and then select Linux
Console in the Terminal Model box. Click OK.

3. On the Options menu, select Keyboard Mapping. The Keyboard Map
opens.

4. Click Action Keys (in the Function Group box), or the List Assigned
Functions button, to see the available Linux functions.

The following are the keys and functions for the Linux Keyboard:

VirtualKeyCode VirtualKeyState Function
VK_SCROLL 0 VK3_VTHOLD
VK_ESCAPE 0 VK3_ESCAPE
VK_BACK 0 VK3_ANSIDELETE
VK_TAB 0 VK3_TAB
VK_RETURN 0 VK3_RETURN
VK_ENH_LEFT 0 VK3 _LEFT
VK_ENH_RIGHT 0 VK3_RIGHT
VK_ENH_UP 0 VK3 _UP
VK_ENH_DOWN |0 VK3 _DOWN
VK_ENH_INSERT || 0 VK3_INSERT
VK_ENH_DELETE || 0 VK3_DELETE
VK_ENH_HOME |0 VK3_HOME

I I




VK_ENH_END

VK3_VTEND

VK_ENH_PRIOR

VK3_VTPAGEUP

VK_ENH_NEXT

VK3_VTPAGEDOWN

VK_LEFT VK3_LEFT
VK_RIGHT VK3_RIGHT

VK_UP VK3_UP

VK_DOWN VK3_DOWN
VK_INSERT VK3_ANSIINSERT
VK_DELETE VK3_DELETE
VK_HOME VK3_HOME

VK_END VK3_VTEND
VK_PRIOR VK3_VTPAGEUP
VK_NEXT VK3_VTPAGEDOWN
VK_CLEAR VK3_ANSIPAGEDOWN
VK_NUMPADO VK3_VTNUMPADO
VK_NUMPAD1 VK3_VTNUMPAD1
VK_NUMPAD?2 VK3_VTNUMPAD2
VK_NUMPAD3 VK3_VTNUMPAD3
VK_NUMPAD4 VK3_VTNUMPADA4
VK_NUMPAD5 VK3_VTNUMPAD5
VK_NUMPAD6 VK3_VTNUMPAD6
VK_NUMPAD7 VK3_VTNUMPAD7
VK_NUMPADS VK3_VTNUMPADS

VK_NUMPAD9

VK3_VTNUMPAD9




VK_BACK VK3_SHIFT VK3_ANSIDELETE
VK_TAB VK3_SHIFT VK3_LINUXBACKTAB
VK_RETURN VK3_SHIFT VK3_RETURN
VK_ENH_INSERT | VK3_SHIFT IDM_E_PASTE
VK_INSERT VK3_SHIFT IDM_E_PASTE
VK_BACK VK3_CTRL VK3_ANSIDELETE
VK_PAUSE VK3_CTRL VK3_PAUSE
VK_SPACE VK3_CTRL VK3_VTSENDNULL
VK_ENH_INSERT || VK3_CTRL IDM_E_COPY
VK_INSERT VK3_CTRL IDM_E_COPY
VK_BACK VK3_ALT VK3_BACKSPACE
VK_A VK3_ALT IDM_E_SELECTALL
VK_J VK3_ALT VK3_VTCLEARDISPLAY
VK_S VK3_CTRL | VK3_SHIFT || VK3_RUNSCRIPT
VK_F1 0 VK3_LINUXF1

VK_F2 0 VK3_LINUXF2

VK_F3 0 VK3_LINUXF3

VK_F4 0 VK3_LINUXF4

VK_F5 0 VK3_LINUXF5

VK_F6 0 VK3_LINUXF6

VK_F7 0 VK3_LINUXF7

VK_F8 0 VK3_LINUXF8

VK_F9 0 VK3_LINUXF9




VK_F10 0 VK3_LINUXF10
VK_F11 0 VK3_LINUXF11
VK_F12 0 VK3_LINUXF12
VK_F1 VK3_SHIFT VK3_LINUXF13
VK_F2 VK3_SHIFT VK3_LINUXF14
VK_F3 VK3_SHIFT VK3_LINUXF15
VK_F4 VK3_SHIFT VK3_LINUXF16
VK_F5 VK3_SHIFT VK3_LINUXF17
VK_F6 VK3_SHIFT VK3_LINUXF18
VK_F7 VK3_SHIFT VK3_LINUXF19
VK_F8 VK3_SHIFT VK3_LINUXF20
VK_F9 VK3_SHIFT VK3_LINUXF21
VK_F10 VK3_SHIFT VK3_LINUXF22
VK_F11 VK3_SHIFT VK3_LINUXF23
VK_F12 VK3_SHIFT VK3_LINUXF24
VK_F1 VK3_CTRL VK3_LINUXF25
VK_F2 VK3_CTRL VK3_LINUXF26
VK_F3 VK3_CTRL VK3_LINUXF27
VK_F4 VK3_CTRL VK3_LINUXF28
VK_F5 VK3_CTRL VK3_LINUXF29
VK_F6 VK3_CTRL VK3_LINUXF30
VK_F7 VK3_CTRL VK3_LINUXF31
VK_F8 VK3_CTRL VK3_LINUXF32
VK_F9 VK3_CTRL VK3_LINUXF33




VK_F10 VK3_CTRL VK3_LINUXF34

VK_F11 VK3_CTRL VK3_LINUXF35

VK_F12 VK3_CTRL VK3_LINUXF36

VK_F1 VK3_CTRL+VK3_SHIFT || VK3_LINUXF37

VK_F2 VK3_CTRL+VK3_SHIFT || VK3_LINUXF38

VK_F3 VK3_CTRL+VK3_SHIFT || VK3_LINUXF39

VK_F4 VK3_CTRL+VK3_SHIFT || VK3_LINUXF40

VK_F5 VK3_CTRL+VK3_SHIFT || VK3_LINUXF41

VK_F6 VK3_CTRL+VK3_SHIFT || VK3_LINUXF42

VK_F7 VK3_CTRL+VK3_SHIFT || VK3_LINUXF43

VK_F8 VK3_CTRL+VK3_SHIFT || VK3_LINUXF44

VK_F9 VK3_CTRL+VK3_SHIFT || VK3_LINUXF45

VK_F10 VK3_CTRL+VK3_SHIFT || VK3_LINUXF46

VK_F11 VK3_CTRL+VK3_SHIFT || VK3_LINUXF47

VK_F12 VK3_CTRL+VK3_SHIFT || VK3_LINUXF48

VK_LEFT VK3_SHIFT VK3_SELECTEXTENDLEFT
VK_ENH_LEFT VK3_SHIFT VK3_SELECTEXTENDLEFT
VK_RIGHT VK3_SHIFT VK3_SELECTEXTENDRIGHT
VK_ENH_RIGHT || VK3_SHIFT VK3_SELECTEXTENDRIGHT
VK_UP VK3_SHIFT VK3_SELECTEXTENDUP
VK_ENH_UP VK3_SHIFT VK3_SELECTEXTENDUP
VK_DOWN VK3_SHIFT VK3_SELECTEXTENDDOWN
VK_ENH_DOWN | VK3_SHIFT VK3_SELECTEXTENDDOWN




VK_LEFT

VK3 _CTRL+VK3_SHIFT

VK3_SELECTWORDLEFT

VK_ENH_LEFT

VK3 _CTRL+VK3_SHIFT

VK3_SELECTWORDLEFT

VK_RIGHT

VK3 _CTRL+VK3_SHIFT

VK3_SELECTWORDRIGHT

VK_ENH_RIGHT

VK3 _CTRL+VK3_SHIFT

VK3_SELECTWORDRIGHT

VK_F VK3_CTRL+VK3_SHIFT | VK3_FULLSCREEN
VK_SCROLL 0 VK3_VTHOLD
VK_ESCAPE 0 VK3_ESCAPE
VK_BACK 0 VK3_ANSIDELETE
VK_TAB 0 VK3_TAB
VK_RETURN 0 VK3_RETURN
VK_ENH_LEFT 0 VK3_LEFT
VK_ENH_RIGHT |0 VK3_RIGHT
VK_ENH_UP 0 VK3_UP
VK_ENH_DOWN |0 VK3_DOWN
VK_ENH_INSERT || 0 VK3_INSERT
VK_ENH_DELETE || 0 VK3_DELETE
VK_ENH_HOME |0 VK3_HOME
VK_ENH_END 0 VK3_VTEND
VK_ENH_PRIOR |0 VK3_VTPAGEUP
VK_ENH_NEXT |0 VK3_VTPAGEDOWN
VK_LEFT 0 VK3_LEFT
VK_RIGHT 0 VK3_RIGHT

VK_UP 0 VK3_UP

VK_DOWN 0 VK3_DOWN




VK_INSERT 0 VK3_ANSIINSERT
VK_DELETE 0 VK3_DELETE
VK_HOME 0 VK3_HOME

VK_END 0 VK3_VTEND
VK_PRIOR 0 VK3_VTPAGEUP
VK_NEXT 0 VK3_VTPAGEDOWN
VK_CLEAR 0 VK3_ANSIPAGEDOWN
VK_NUMPADO 0 VK3_VTNUMPADO
VK_NUMPAD1 0 VK3_VTNUMPAD1
VK_NUMPAD?2 0 VK3_VTNUMPAD2
VK_NUMPAD3 0 VK3_VTNUMPAD3
VK_NUMPAD4 0 VK3_VTNUMPADA4
VK_NUMPAD5 0 VK3_VTNUMPAD5
VK_NUMPAD6 0 VK3_VTNUMPAD6
VK_NUMPAD7 0 VK3_VTNUMPAD?
VK_NUMPADS 0 VK3_VTNUMPADS
VK_NUMPAD9 0 VK3_VTNUMPAD9
VK_BACK VK3_SHIFT VK3_ANSIDELETE
VK_TAB VK3_SHIFT VK3_LINUXBACKTAB
VK_RETURN VK3_SHIFT VK3_RETURN
VK_ENH_INSERT | VK3_SHIFT IDM_E_PASTE
VK_INSERT VK3_SHIFT IDM_E_PASTE
VK_BACK VK3_CTRL VK3_ANSIDELETE




VK_PAUSE VK3_CTRL VK3_PAUSE
VK_SPACE VK3_CTRL VK3_VTSENDNULL
VK_ENH_INSERT || VK3_CTRL IDM_E_COPY
VK_INSERT VK3_CTRL IDM_E_COPY
VK_BACK VK3_ALT VK3_BACKSPACE
VK_A VK3_ALT IDM_E_SELECTALL
VK_J VK3_ALT VK3_VTCLEARDISPLAY
VK_S VK3_CTRL | VK3_SHIFT || VK3_RUNSCRIPT
VK_F1 0 VK3_LINUXF1
VK_F2 0 VK3_LINUXF2
VK_F3 0 VK3_LINUXF3
VK_F4 0 VK3_LINUXF4
VK_F5 0 VK3_LINUXF5
VK_F6 0 VK3_LINUXF6
VK_F7 0 VK3_LINUXF7
VK_F8 0 VK3_LINUXF8
VK_F9 0 VK3_LINUXF9
VK_F10 0 VK3_LINUXF10
VK_F11 0 VK3_LINUXF11
VK_F12 0 VK3_LINUXF12
VK_F1 VK3_SHIFT VK3_LINUXF13
VK_F2 VK3_SHIFT VK3_LINUXF14
VK_F3 VK3_SHIFT VK3_LINUXF15
VK_F4 VK3_SHIFT VK3_LINUXF16




VK_F5 VK3_SHIFT VK3_LINUXF17
VK_F6 VK3_SHIFT VK3_LINUXF18
VK_F7 VK3_SHIFT VK3_LINUXF19
VK_F8 VK3_SHIFT VK3_LINUXF20
VK_F9 VK3_SHIFT VK3_LINUXF21
VK_F10 VK3_SHIFT VK3_LINUXF22
VK_F11 VK3_SHIFT VK3_LINUXF23
VK_F12 VK3_SHIFT VK3_LINUXF24
VK_F1 VK3_CTRL VK3_LINUXF25
VK_F2 VK3_CTRL VK3_LINUXF26
VK_F3 VK3_CTRL VK3_LINUXF27
VK_F4 VK3_CTRL VK3_LINUXF28
VK_F5 VK3_CTRL VK3_LINUXF29
VK_F6 VK3_CTRL VK3_LINUXF30
VK_F7 VK3_CTRL VK3_LINUXF31
VK_F8 VK3_CTRL VK3_LINUXF32
VK_F9 VK3_CTRL VK3_LINUXF33
VK_F10 VK3_CTRL VK3_LINUXF34
VK_F11 VK3_CTRL VK3_LINUXF35
VK_F12 VK3_CTRL VK3_LINUXF36
VK_F1 VK3_CTRL+VK3_SHIFT || VK3_LINUXF37
VK_F2 VK3_CTRL+VK3_SHIFT || VK3_LINUXF38
VK_F3 VK3_CTRL+VK3_SHIFT || VK3_LINUXF39




VK_F4

VK3 _CTRL+VK3_SHIFT

VK3_LINUXF40

VK_F5 VK3_CTRL+VK3_SHIFT || VK3_LINUXF41

VK_F6 VK3_CTRL+VK3_SHIFT || VK3_LINUXF42

VK_F7 VK3_CTRL+VK3_SHIFT || VK3_LINUXF43

VK_F8 VK3_CTRL+VK3_SHIFT || VK3_LINUXF44

VK_F9 VK3_CTRL+VK3_SHIFT || VK3_LINUXF45

VK_F10 VK3_CTRL+VK3_SHIFT || VK3_LINUXF46

VK_F11 VK3_CTRL+VK3_SHIFT || VK3_LINUXF47

VK_F12 VK3_CTRL+VK3_SHIFT || VK3_LINUXF48

VK_LEFT VK3_SHIFT VK3_SELECTEXTENDLEFT
VK_ENH_LEFT VK3_SHIFT VK3_SELECTEXTENDLEFT
VK_RIGHT VK3_SHIFT VK3_SELECTEXTENDRIGHT
VK_ENH_RIGHT || VK3_SHIFT VK3_SELECTEXTENDRIGHT
VK_UP VK3_SHIFT VK3_SELECTEXTENDUP
VK_ENH_UP VK3_SHIFT VK3_SELECTEXTENDUP
VK_DOWN VK3_SHIFT VK3_SELECTEXTENDDOWN
VK_ENH_DOWN | VK3_SHIFT VK3_SELECTEXTENDDOWN

VK_LEFT VK3_CTRL+VK3_SHIFT || VK3_SELECTWORDLEFT
VK_ENH_LEFT VK3_CTRL+VK3_SHIFT || VK3_SELECTWORDLEFT
VK_RIGHT VK3_CTRL+VK3_SHIFT (| VK3_SELECTWORDRIGHT

VK_ENH_RIGHT

VK3 _CTRL+VK3_SHIFT

VK3_SELECTWORDRIGHT

VK_F

VK3 _CTRL+VK3_SHIFT

VK3_FULLSCREEN




Graphic Configuration Errors
3270

You may encounter the following graphical errors:
Message: ADMO275 E GRAPHICS CANNOT BE SHOWN

Several factors can cause this GDDM error message when attempting to
display graphics. Check each of the following items carefully in the order
listed and take corrective action:

1. The host (VTAM) logmode you are using must be a queriable
logmode. By default, your host LU is assigned a logmode which
defines screen size and queriability features. If you have a non-
gueriable logmode, HostExplorer cannot display the graphics. Check
with your VTAM systems programmer if you think your logmode is not
defined as queriable; tell them that the PSERVIC parameter must
start with '028' or '02C".

2. If your host uses a session manager such as CA-Supersession or
TPX, the session manager must be configured such that device query
is supported. Otherwise, HostExplorer cannot display the graphics
because all host graphics applications perform a device query before
sending its graphics data.

Related Topics
Clipboard Format Description
TN3270 Host Graphic Configuration




TN3270 Host Graphic Configuration
3270

HostExplorer fully supports TN3270 host graphics by emulating the
following terminals: 3179G, 3192G, 3472G, and 3279 S3G. The system
supports all vector graphics commands and 6 Program Symbol Sets.
Each terminal session can perform independent vector graphics,
however, the Program Symbol Sets Memory is common to all sessions.

The system has been tested with popular host graphics packages such
as IBM's GDDM ICU, AS, GDQF, CADAM, SAS/GRAPH, CA-
TELLAGRAF, CA-DISSPLA, EIA, ATREMIS, NOMAD, FOCUS, RTPMS,
and ACS graphics, as well as customized GDDM applications.

The system does not require any special configuration options to use
graphics. The graphics .d11 is loaded automatically as soon as
HostExplorer detects the first graphics data-stream.

You can save host images with graphics to a file or copy them to the
clipboard in the standard placeable Windows MetaFile format. You can
also print host images to any Windows printer.

Warning! You should disable ToolTips when you use mainframe graphics.

Related Topics
Clipboard Format Description




Mainframe Graphics Configuration

SASIGRAPH—TOo display SAS/GRAPH graphics on your PC screen,
include either of the following GOPTIONS statements in your SAS
program:

GOPTIONS DEVICE=IBM3179

GOPTIONS DEVICE=GDDM79

Note: If you are using the SAS Display Manager with the graphics cursor, specify
Resolution of TERMINAL in CONFIG option under Display.

CA-TELLAGRAF—To display CA-TELLAGRAF graphics on your PC
screen, include the following statements in your TAGPRO file:

PRIMARY DEVICE IS IBM.
PRIMARY DEVICE MODEL IS 3179.

CA-DISSPLA—To use HostExplorer with CA-DISSPLA, you must use
the IBM 3179G device driver for displaying graphics to your screen.

Boeing EIS—To use HostExplorer with EIS, you must use the IBM 3279
device driver for displaying graphics to your screen. To do this, include
the following statement in your data file:

OUTPUT 3279:

Note: When using EIS with HostExplorer, use a Model 3 terminal emulator for best
results.

UNIRAS—To use HostExplorer with Uniras, you need to use the device
driver for the IBM 3179G or another GDDM device driver.

Related Topics

GDDM Error Messages
SAS Error Message
Potential Graphic Problems




GDDM Error Messages

The following are potential GDDM error messages and their
explanations:

. The host logmode does not support extended data
stream.

Contact the VTAM systems programmer to have extended data
stream turned on.

. The query failed.

Contact the VTAM systems programmer.

. The graphics DLL is not in the application
directory or in the path.

You should have received a warning that graphics were not
available. For Windows 98/Me/2000, the file is NT3179G.DLL.

Related Topics
Mainframe Graphics Configuration




SAS Error Message

The following is a potential SAS error message and its explanation:
. ADMASPT NOT FOUND

This commonly occurs in VM/CMS when you specify the GDDM79
device driver and the program is not accessing the GDDM
TXTLIBs in the VM/CMS session. SAS requires the GDDM
TXTLIBs ADMGLIB and ADMRLIB. Use the IBM3179 device
driver instead of the GDDM79 device driver—the GDDM TXTLIB's
are not necessary.

Related Topics
Mainframe Graphics Configuration




Potential Graphic Problems

You may encounter the following two graphic problems:

. HostExplorer displays the graph, but not in graphics mode. For
example, it uses alphanumeric characters to approximate the picture.

This usually indicates that there is a logmode problem. The
mainframe application software thinks that the device cannot
display graphics so it sends alphanumeric data instead. Make sure
the logmode is queriable (PSERVIC="'028...").

- When displaying CA-TELLAGRAF, CA-DISSPLA, or Boeing EIS
graphics, the screen seems smaller.

This can occur when the CA-TELLAGRAF, CA-DISSPLA, and
Boeing EIS graphics packages make internal adjustments when
using a TN3270 screen size other than Mod 3 (32 x 80). Change
the logmode to Mod 3 and retry, or set the value of the Resolution
option to TERMINAL instead of HIGH in CONFIG.

Related Topics
Mainframe Graphics Configuration




General Accessibility

Hummingbird products are accessible to all users. Wherever possible,
our software adheres to Microsoft Windows interface standards and
contains a comprehensive set of accessibility features.

Access Keys All menus have associated access keys (mnemonics) that
let you use the keyboard, rather than a mouse, to navigate the user
interface (Ul). These access keys appear as underlined letters in the
names of most Ul items. (If this is not the case, press Alt to reveal them.)
To open any menu, press Alt and then press the key that corresponds
with the underlined letter in the menu name. For example, to access the
File menu in any Hummingbird application, press Alt+F.

Once you have opened a menu, you can access an item on the menu by
pressing the underlined letter in the menu item name, or you can use the
arrow keys to navigate the menu list.

Keyboard Shortcuts Some often-used menu options also have shortcut
(accelerator) keys. The shortcut key for an item appears beside it on the
menu.

Directional Arrows Use the directional arrows on the keyboard to
navigate through menu items or to scroll vertically and horizontally. You
can also use the directional arrows to navigate through multiple options.
For example, if you have a series of radio buttons, you can use the arrow
keys to navigate the possible selections.

Tab Key Sequence To navigate through a dialog box, press the Tab key.
Selected items appear with a dotted border. You can also press Shift+Tab
to go back to a previous selection within the dialog box.

Spacebar Press the Spacebar to select or clear check boxes, or to
select buttons in a dialog box.

Esc Press the Esc key to close a dialog box without implementing any
new settings.

Enter Press the Enter key to select the highlighted item or to close a
dialog box and apply the new settings. You can also press the Enter key
to close all About boxes.



ToolTips ToolTips appear for all functional icons. This feature lets users
use Screen Reviewers to make interface information available through
synthesized speech or through a refreshable Braille display.



Microsoft Accessibility Options

Microsoft Windows environments contain accessibility options that let you
change how you interact with the software. These options can add
sound, increase the magnification, and create sticky keys.

To enablel/disable Accessibility options:
1. In Control Panel, double-click Accessibility Options.

2. In the Accessibility Options dialog box, select or clear the option
check boxes on the various tabs as required, and click Apply.

3. Click OK.

If you installed the Microsoft Accessibility components for your Windows
system, you can find additional accessibility tools under Accessibility on

the Start menu.



Technical Support

You can contact the Hummingbird Technical Support department Monday
to Friday between 8:00 a.m. and 8:00 p.m. Eastern Time.

Hummingbird Ltd.
1 Sparks Avenue, Toronto, Ontario, Canada M2H 2W1

Canada and the USA || International

Technical Support: || 1-800-486-0095 +1-416-496-2200

General Enquiry: || 1-877-FLY-HUMM +1-416-496-2200

Main: || +1-416-496-2200

Fax: || +1-416-496-2207

E-mail: || support@hummingbird.com

FTP: || ftp.hummingbird.com

Web Support: || support.hummingbird.com/customer

Web Site: || www . hummingbird.com
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Open Session Dialog Box
3270 5250 VT

To access

The Open Session dialog box lists all session profiles and provides
information about these profiles. You can also create new profiles in this
dialog box, create folders in which to store the profiles, and reconfigure
existing profiles.

Note: Each button in the Open Session dialog box has an associated keyboard shortcut. #

Folder—Displays the location of profiles displayed in the dialog box.
Up One Level—Navigates from a subfolder to its parent folder.

Create New Profile button—Opens the New Profile dialog box, which
lets you creates a new session profile.

Note: When creating a profile, the profile name cannot contain any of the following characters:
\/:*¥2%<>|

Create New Profile Folder button—Lets you create and name a new

profile folder.

Profile list—Lists the available folders and their profiles. This box also
provides information about each profile, such as its name, its type of
connection, the host it connects to, and its port. You can double-click a
profile to connect, or you can right-click a profile and select an option
from the context menu.

Host Name—Displays the host name (IP address) of the selected profile.
You can edit the host name in this box.

TCP Port—Specifies the host port or socket number to use for the Telnet
session. You can specify a number between 0 and 65535. The default for
this option depends on the parameters you set in the profile you select.

Connect—Launches the selected profile to attempt to connect to the
host. You must select a profile with a valid host name to launch a
connection.

Related Topics
Overview—Session Profiles
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Creating a Session Profile
Managing Session Profiles
Open Session Dialog Box

New Profile Dialog Box




Save Profile Dialog Box
3270 5250 VT

To access
The Save Profile dialog box lets you save changes to a session profile.
Folder—Shows the location of profiles displayed in the dialog box.
Up One Level—Navigates from a subfolder to its parent folder.

Create New Profile button—Creates a new session profile. You must
enter a profile name, the profile type, and the host name.

Note: When creating a profile, the profile name cannot contain any of the following characters:
\/1*x2%<>|

Create New Profile Folder button—Creates a new folder once you
supply a folder name.

Profile list—Lists the available folders and their profiles.
Profile Name—Specifies a new name for the profile.

Save—Saves the profile with the name you specify.

Related Topics
Saving Session Profiles
Running Quick-Keys, Quick Scripts, or Macros at Startup
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Session Window Folder—General Category
3270 5250 VT

In the General category, you can set options for the session window.

Save Profile on Window Close—Determines whether HostExplorer
automatically saves changes made to settings for the current profile
when you close the session. By default, this option is selected.

Save Font and Window Info on Exit—Determines whether
HostExplorer automatically saves changes made to the font or the
window size for the current profile. By default, this option is selected.

Session Long Name—Lets you enter an easily identifiable name that
displays in the Operator Information Area (OIA). The session long name
may contain up to eight characters (including letters, numbers or other
characters).

Window Title—Specifies the information that displays in the title bar of
the session window. By default, the equation is %s-%p (%h). To change
the information that displays in the window title, replace one or more of
the variables. If you change a replacement variable, the change affects
the current session. When you close the session, the modified
configuration is saved to the session profile.

Click the arrow next to the Windows Title box to view the complete list of
variables. Click a variable in this list to add it to the box. »
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Session Lockout Options

Enable Session Lockout—Lets you enable or disable the Session
Lockout option, which locks a session if it is left idle for a specified period
of time. By default, this option is selected.

Use Default Session Lockout Time—Uses the default session
lockout time of 30 minutes. By default, this option is selected.

Lockout Session After the Following Number of Idle Minutes
—Lets you specify a session lockout time. This option is available
if Use Default Session Lockout Time is cleared.

Related Topics

User Environment Customization

Specifying Text for the Title Bar

Terminal Folder—API Category

Removing the Save Profile on Window Close Function




File Menu
3270 5250 VT

The File menu contains the following items:

New Session—Opens the New Profile dialog box, used to create or
change a session profile.

Duplicate Session—Opens a new connection from an existing one.

Open Session—Opens the Open Session dialog box, used to connect to
a host.

Open Session in Same Window—Opens the Open Session dialog box,
which lets you open multiple sessions (for any terminal type) in the same
session window. Only one session is visible at a time. You can view a
different session by selecting it on the Window menu.

Note: Printer controls do not open in the same session frame.

Save Session Profile—Opens the Save Profile dialog box, used to save
the current session profile.

Close Session—Closes the current connection and closes the session
window.

Open Layout—Opens the Open Layout dialog box, used to open an
existing layout.

Save Layout—Opens the Save Layout dialog box, used to save your
working environment as a layout.

Connect—Connects to the host if the session is discontinued.

Disconnect—Closes the host's network connection while leaving the
window open. Once you have disconnected from a host, you can
reconnect by selecting Connect.

Print Screen—Takes a snapshot of the current screen and sends it to a
printer or file. You can specify the destination in the Host Printing
category of the Print folder in the Session Properties dialog box.

Print Multiple Screens—Opens the Print Multiple Screens dialog box,
used to specify the multiple host screens that you want to print.



Report Wizard (3270, 5250 only)—Opens the Report Wizard dialog box,
used to select and execute an existing print area scheme. You can also
open the Report Wizard, used to edit existing schemes or create new
ones.

Save Screen to Disk—Saves an image of the current screen to a file.

Send Screen—Lets you send the contents of the screen as a mail
message.

Screen Capture—Toggles the capturing of screen data. When toggled is
selected, all updated/new screens are captured and saved to the file
specified in the General category located in the Capture folder of the
Session Profile dialog box.

Recent Sessions—Displays a list of up to four of the most recent
session connections and lets you establish a connection to any of the
items in the list immediately.

Exit All—Closes all open sessions and exits HostExplorer.

Related Topics

Open Session Dialog Box

Save Profile Dialog Box

Open Layout Dialog Box

Save Layout Dialog Box

Save Screen to Disk Dialog Box
Print Multiple Screens Dialog Box
Capture Folder—General Category




Connection Folder—TN3270 Category
3270

In the TN3270 category, you can set general connection parameters that
HostExplorer uses to connect to a TN3270 host through TCP/IP.

Note: These options are visible but dimmed when you connect to a session. To be able to set these
options, you must disconnect from the session and access the Session Profile dialog box again.



Hosts
The Hosts area consists of the following:

Note: All the buttons in the dialog box have an associated keyboard shortcut. =

Host Name—Specifies the name of the host or gateway to which you will
be connecting. You specify this name when you create a new session
profile using the Open Session dialog box or when you add a host in the
Add New Host dialog box. You can edit this name in the Edit Host Info
dialog box.

Port—Specifies the host port or socket number to be used for the VT
session. You specify this port number when you create a new session
profile using the Open Session dialog box or when you add a host in the
Add New Host dialog box. You can edit this port number in the Edit Host
Info dialog box.

Telnet Name Override—Specifies the name used during Telnet
negotiation with the host system.

Add New Host—Opens the Add New Host dialog box in which you can
specify the host name, telnet name override, port number, and HTTP
proxy host URL for a new host that will be associated with the current
session profile.

Edit Host Info—Opens the Edit Host Info dialog box in which you can
modify the host name, telnet name override, and port number for an
existing host that is associated which the current session profile.

Delete—Removes the selected host from the Hosts list.
Delete All—Removes all the hosts from the Host list.
Copy—Copies the properties of the selected host.
Paste—Pastes the copied host to the Hosts pane.

Move Up/Move Down—Moves the selected host up or down a row in the
Hosts pane. The position of the hosts determine the order in which the
HostExplorer session connects to multiple hosts.
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List Retries
The List Retries area consists of the following:

Enable Infinite List Retries—Select this check box if you want
HostExplorer to continually attempt to connect to all the hosts listed in the
Hosts pane until a host becomes available. When you select this option,
the Number of Retries option becomes unavailable.

Number of Retries—Specifies the number of times that HostExplorer
attempts to connect to all the hosts listed in the Hosts pane until a host
becomes available. This option is available only when the Enable Infinite
List of Retries option is cleared.

Delay Between Hosts (Secs)—Specifies the delay (in seconds) before
HostExplorer attempts to connect to another host after attempting to
connect to an unavailable one.

Connection Timeout (Secs)—Specifies the number of seconds that
HostExplorer will attempt to establish a connection before aborting the
operation. The default is 30.

Related Topics

Add New Host Dialog Box

Edit Host Info Dialog Box

Connecting to a Host

Disconnecting from a Host

Connection Folder—5250 Advanced Category
Connection Folder—NVT Category
Connection Folder—Other Category




Connection Folder—TN5250 Category
5250

In the TN5250 category, you can set general connection parameters that
HostExplorer uses to connect to a TN5250 host through TCP/IP.

Note: These options are visible but dimmed when you connect to a session. To be able to set these
options, you must disconnect from the session and access the Session Profile dialog box again.



Hosts
The Hosts area consists of the following:

Note: All the buttons in the dialog box have an associated keyboard shortcut. =

Host Name—Specifies the name of the host or gateway to which you will
be connecting. You specify this name when you create a new session
profile using the Open Session dialog box or when you add a host in the
Add New Host dialog box. You can edit this name in the Edit Host Info
dialog box.

Port—Specifies the host port or socket number to be used for the Telnet
session. You specify this port number when you create a new session
profile using the Open Session dialog box or when you add a host in the
Add New Host dialog box. You can edit this port number in the Edit Host
Info dialog box.

Telnet Name Override—Specifies the name used during Telnet
negotiation with the host system.

Add New Host—Opens the Add New Host dialog box in which you can
specify the host name, telnet name override, port number, and HTTP
proxy host URL for a new host that will be associated with the current
session profile.

Edit Host Info—Opens the Edit Host Info dialog box in which you can
modify the host name, telnet name override, and port number for an
existing host that is associated which the current session profile.

Delete—Removes the selected host from the Hosts list.
Delete All—Removes all the hosts from the Host list.
Copy—Copies the properties of the selected host.
Paste—Pastes the copied host to the Hosts pane.

Move Up/Move Down—Moves the selected host up or down a row in the
Hosts pane. The position of the hosts determine the order in which the
HostExplorer session connects to multiple hosts.
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List Retries
The List Retries area consists of the following:

Enable Infinite List Retries—Select this check box if you want
HostExplorer to continually attempt to connect to all the hosts listed in the
Hosts pane until a host becomes available. When you select this option,
the Number of Retries option becomes unavailable.

Number of Retries—Specifies the number of times that HostExplorer
attempts to connect to all the hosts listed in the Hosts pane until a host
becomes available. This option is available only when the Enable Infinite
List of Retries option is cleared.

Delay Between Hosts (Secs)—Specifies the delay (in seconds) before
HostExplorer attempts to connect to another host after attempting to
connect to an unavailable one.

Connection Timeout (Secs)—Specifies the number of seconds that
HostExplorer will attempt to establish a connection before aborting the
operation. The default is 30.

Related Topics

Add New Host Dialog Box

Edit Host Info Dialog Box

Connecting to a Host

Connection Folder—5250 Advanced Category
Connection Folder—NVT Category
Connection Folder—Other Category




Connection Folder—Telnet Category
VT

In the Telnet category, you can set general connection parameters that
HostExplorer uses to connect to a VT host through TCP/IP.

Note: These options are visible but dimmed when you connect to a session. To be able to set these
options, you must disconnect from the session and access the Session Profile dialog box again.



Hosts
The Hosts area consists of the following:

Note: All the buttons in the dialog box have an associated keyboard shortcut. =

Host Name—Specifies the name of the host or gateway to which you will
be connecting. You specify this name when you create a new session
profile using the Open Session dialog box or when you add a host in the
Add New Host dialog box. You can edit this name in the Edit Host Info
dialog box.

Port—Specifies the host port or socket number to be used for the Telnet
session. You specify this port number when you create a new session
profile using the Open Session dialog box or when you add a host in the
Add New Host dialog box. You can edit this port number in the Edit Host
Info dialog box.

Telnet Name Override—Specifies the name used during Telnet
negotiation with the host system.

HTTP Proxy URL—Specifies the URL for a proxy host that will be
associated with the current session profile.

Add New Host—Opens the Add New Host dialog box in which you can
specify the host name, telnet name override, port number, and HTTP
proxy host URL for a new host that will be associated with the current
session profile.

Edit Host Info—Opens the Edit Host Info dialog box in which you can
modify the host name, telnet name override, HTTP proxy host URL, and
port number for an existing host that is associated which the current
session profile.

Delete—Removes the selected host from the Hosts list.
Delete All—Removes all the hosts from the Host list.
Copy—Copies the properties of the selected host.
Paste—Pastes the copied host to the Hosts pane.

Move Up/Move Down—Moves the selected host up or down a row in the
Hosts pane. The position of the hosts determine the order in which the
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HostExplorer session connects to multiple hosts.



List Retries
The List Retries area consists of the following:

Enable Infinite List Retries—Select this check box if you want
HostExplorer to continually attempt to connect to all the hosts listed in the
Hosts pane until a host becomes available. When you select this option,
the Number of Retries option becomes unavailable.

Number of Retries—Specifies the number of times that HostExplorer
attempts to connect to all the hosts listed in the Hosts pane until a host
becomes available. This option is available only when the Enable Infinite
List of Retries option is cleared.

Delay Between Hosts (Secs)—Specifies the delay (in seconds) before
HostExplorer attempts to connect to another host after attempting to
connect to an unavailable one.

Connection Timeout (Secs)—Specifies the number of seconds that
HostExplorer will attempt to establish a connection before aborting the
operation. The default is 30.

Related Topics

Add New Host Dialog Box

Edit Host Info Dialog Box

Connecting to a Host

Connection Folder—Telnet Advanced Category
Connection Folder—Other Category




Connection Folder—Modem Category
VT

In the Modem category, you can set the general connection parameters
that HostExplorer for connecting to a host using a modem or serial port.

Note: These options are visible but dimmed when you connect to a session. To be able to set these

options, you must disconnect from the session and access the Session Profile dialog box again.
Telephone Number—Type the modem number that you want to call.
This option is not available if you have not installed a modem.

Use Area Code and Country Code—Determines whether HostExplorer
uses the settings that you provided in the Windows Dialing Properties
dialog box while installing the modem. With this option selected,
HostExplorer will automatically add the area code, country code, "8", "9",
or calling card numbers, if applicable. By default, this option is selected.
Clear this option if you want to bypass the Windows automatic dialing
system.

Country—Enter the name of the country that you want to call.

Area Code—Enter the number of the area code that you want to
call. This option is not available if you have not installed a modem.
HostExplorer automatically retrieves the area code from the
information you provided while configuring the modem.

Note: The modem number cannot contain spaces, brackets, or hyphens.

Modem—Select the modem you are using to connect to the host.

Always Show Connect Dialog—Determines whether HostExplorer
displays the Connection dialog box prompting you to verify the modem
properties. By default, this option is selected.

Configure Line—Displays the Windows Configure Line dialog box which
lets you modify the modem hardware settings.

Related Topics
User Environment Customization




Host Connections Using a Modem




Add New Host Dialog Box
3270 5250 VT

To access

Use this dialog box to specify the general properties of a new host to
which the session can connect.

Host Name—Specifies a name for the new host. The name can be a fully
gualified domain name, a humeric address, an Internet address, or an
Internet Node Name.

Telnet Name Override—Specifies a name to override the name used
during Telnet negotiation with the host system. You can enter any valid
terminal name that your host system recognizes. (For example, you can
enter IBM-3278-2 to override the name that is generated from the

TN3270 settings.)

Warning! Entering a name in the Telnet Name Override field without fully understanding this function
may cause connection failures.

TCP Port—Specifies the host port or socket number to use for the Telnet

session. You can specify a number between 0 and 65535. By default, this

option is set to 23.

HTTP Proxy URL—Specifies the URL for a proxy host that will be
associated with the current session profile.

Related Topics

Connection Folder—TN3270 Category
Connection Folder—TN5250 Category
Connection Folder—Telnet Category
Edit Host Info Dialog Box
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Microsoft SNA Server

You can establish communication with mainframes via Microsoft SNA
Server using LU application (LUA), display, or printer logical units (LUS).
Using configurable LUs in Microsoft SNA Server, you can run primary
LUO, LU1, LU2, and LU3 sessions that emulate 3270 data stream.

Before you can access the host, you or your system administrator must
configure Microsoft SNA Server connections on the link service, configure
LUs, and assign them to users, groups, workstations, and printers. You
must also install Microsoft SNA Server Client software on your
workstation.

You can connect with an IBM mainframe via Microsoft SNA Server. This
connection offers full support of Display and Printer Types, on single or
multiple hosts and INDS$FILE transfers.



Microsoft SNA Server System Requirements
To run Microsoft SNA Server, you need the following:

. Microsoft SNA Client software running on each client workstation.
One client can run on Windows NT 4.0 or higher, while the other client
must be configured to run under Windows NT.

. TCP/IP, or MS Networking transport protocol installed on the SNA
Server and on each client workstation.

You can find out more about configuring a Microsoft SNA Server at the
following web site:

www.microsoft.com/SNA/




Configuring a Microsoft SNA Server Connection

After you have installed the necessary software, you can configure a
connection using the Microsoft SNA Server.

To configure a Microsoft SNA Server connection:

1.
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Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Click the Create New Profile button. The
New Profile dialog box opens.

In the Profile Name box, type a name for the new profile.
In the Profile Type list, select 3270.
In the Connect By list, select Microsoft SNA Server.

In the LU or Pool Name box, type the logical unit (LU) nhame to use for
the host connection. You can type the individual LU name or the
name of an LU pool. The LU contains the necessary configuration
information needed to connect to a host. The LU name can contain up
to eight characters, must start with a letter, and cannot contain any
spaces.

Select Connect, and then click OK to close the New Profile dialog
box.

When the host logon screen displays, you can log on and start working.

Related Topics
Open Session Dialog Box

Connection Folder—Microsoft SNA Server Category




Novell NetWare for SAA

You can establish communication with mainframes through Novell's
NetWare for SAA Server using 3270/LUx logical units (LUS). Using
configurable 3270/LUx LUs, you can use the NetWare for SAA server to
run primary LUO, LU, LU2, and LU3 sessions that emulate 3270 data
stream.

Before you can access the host, you need to configure 3270/LUx LUs on
the server using Novell Directory Services (NDS) configuration tools and
assign them to users, groups, workstations, and printers. NDS
configuration works only with NetWare for SAA server versions 2.2 or
later, with the client running over a NetWare IPX/SPX stack. You must
also install NetWare for SAA Client software on your workstation.

To run Novell NetWare for SAA, you need the following:

. Client Service for NetWare and transport compatible with IPX/SPX
(Internetwork Packet Exchange/Sequenced Packet Exchange).
. A LAN adapter that supports IPX (Internetwork Packet Exchange).

. Novell NetWare Client for Windows NT.

To find out more about configuring Novell NetWare for SAA, refer to the
following web sites:

http://www.novell.com/

http://www-
4.ibm.com/software/network/commserver/library/
publications/nwsaa.html



http://www.novell.com/
http://www-4.ibm.com/software/network/commserver/library/publications/nwsaa.html

Novell NetWare for SAA System Requirements

To run Novell NetWare for SAA, you require the following:
. Client Service for NetWare and transport compatible with IPX/SPX
(Internetwork Packet Exchange/Sequenced Packet Exchange).
. A LAN adapter that supports IPX (Internetwork Packet Exchange).
. Novell NetWare Client for Windows NT.



Configuring a Novell NetWare for SAA Server Connection

After you have installed the necessary software, you can configure a
connection using the Novell NetWare for SAA Server.

To configure a Novell NetWare for SAA Server connection:

1. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Click the Create New Profile button. The
New Profile dialog box opens.

In the Profile Name box, type a name for the new profile.
In the Profile Type list, select 3270.
In the Connect By list, select NetWare for SAA.
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In the LU or Pool Name box, type the logical unit (LU) nhame to use for
the host connection. You can type the individual LU name or the
name of an LU pool. The LU contains the necessary configuration
information needed to connect to a host.

Note: The LU name can contain up to eight characters, must start with a letter, and cannot
contain any spaces.

6. Select Connect, and then click OK to close the New Profile dialog
box.

When the host logon screen displays, you can log on and start working.

Related Topics

Connecting to a Host

Open Session Dialog Box

Connection Folder—Netware for SAA Category




Connection Folder—Other Category
3270 5250 VT

In the Other category, you can specify how HostExplorer behaves when it
disconnects from the host, select auto-start or create a password for a
Quick-Key, Quick Script or macro, and specify Sleep request responses.

Upon Disconnect from Host—Select one of the following options:

Close Session Window—cCloses the session window when the
connection is terminated.

Keep Session Window Open—Keeps the session window open.
By default, this option is selected.

Restart Session—Forces HostExplorer to re-connect to the host.

Show 'Open Session' Dialog—Opens the Open Session dialog
box. You can use this option to reconnect to another session
without having to re-launch the program. This option works only if
the host terminates the only open window.

Session Password—Enter a password of up to 32 characters to use
when you create a Quick-Key. HostExplorer displays and saves the
password in encrypted format only.

Auto Start Quick-Key/Quick Script/Macro—Enter or browse for a
macro, Quick-Key, or Quick Script file name. HostExplorer saves the
macro, Quick-Key, or Quick Script and launches it automatically each
time the session connects to a host. See also ReRun Auto Quick-Key.

Always Prompt for Host Name—Select this check box if you want a
dialog box to appear prompting you for a host name each time you
attempt to connect to a host using this session profile.

Allow Sleep While Connected—Specifies how HostExplorer responds
to a sleep request from the system while a session is connected to the
host.



No—Ignores the Sleep request.
Yes—Always accepts the Sleep request.

Ask User—HostExplorer asks the user if they want to accept the
Sleep request. If the session is minimized or not visible, the
request is automatically refused. Ask User is the default value.

Disconnect on Sleep—Disconnects the session when the system goes
into Sleep mode. By default, this option is cleared.

Related Topics

User Environment Customization

Changing the Disconnect Action

Running Quick-Keys, Quick Scripts, or Macros at Startup
Automating Login Using Quick-Keys (3270 and 5250)
Automating Login Using Quick-Keys (VT)

Automating Login Using Quick Scripts

Connection Folder—Secure Shell Category




New Profile Dialog Box
3270 5250 VT

To access

The New Profile dialog box is used to enter the parameters for a new
session profile.

Profile Name—Specifies a name for the profile.

Profile Type—Specifies a profile type for the session. You can select a
display session profile (3270, 5250, or VT), a printer session profile (3270
or 5250), or a profile template (which specifies the type as well as other
parameters for a new session profile).

Theme—Specifies a (pre-configured or custom) theme to use for the
profile. You can create custom themes in the Themes category of the
Session Window folder in the Session Profile dialog box.

Connect By—Lets you specify a connection method. The connection
information options that follow are determined by the connection method
you select.

Note: The Secure Shell option is available only if you purchased and installed Connectivity Secure
Shell and selected VT Display as your profile type.

Host Name/LU or Pool Name/Telephone Number—Provides

connection information for the host to which you want to connect.

Tunnel Profile—Specifies a tunnel profile, or lets you browse to one.
This option is only available if you select Secure Shell as a connection
method.

Properties—Opens the Session Profile dialog box, where you can
configure options for the new profile. Do one of the following:

. Click Properties to open the Session Properties dialog box.

. Click the arrow to display a list of shortcuts to folders that are
appropriate for the connection profile type that you want to create.
Click a shortcut to go directly to the folder in the Session Properties
dialog box.

Connect—Establishes a connection to the specified host when you close
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the New Profile dialog box.

Related Topics

Creating a Session Profile

Open Session Dialog Box

User Environment Customization




Security Folder—SSLI/TLS Category
3270 5250 VT

In the SSL/TLS category, you can set security options specific to the
SSL/TLS protocol. You must first select SSL/TLS in the General category
of the Security folder and you must not currently be connected to a
session



SSLI/TLS Options

Version—Select the version of the SSL/TLS protocol that you want to
use for SSL/TLS connections to the server. The default version is Version
3. It is recommended that you do not use version 2 unless advised to do
SO.

Negotiate Via Telnet—Specifies how to initiate SSL/TLS connectivity.
Select this option to configure HostExplorer to negotiate Transport Layer
Security (TLS) options through Telnet. Clear this option to enable
HostExplorer to request SSL/TLS immediately without Telnet option
negotiation. By default, this option is cleared.

Close Connection if Negotiation Fails—Determines whether
HostExplorer should terminate the connection if the SSL/TLS negotiation
fails. By default, this option is cleared.

Accept Unverified Server Certificates—This option is available only if
you selected the Close Connection if SSL Negotiation Fails check box.
Determines whether HostExplorer accepts from the server only the
certificates that have been verified by a trusted certification authority
(CA). If this option is checked, certain certification errors are ignored such
as the certificate has expired, the certificate is not valid yet, and syntax
errors. By default, this option is cleared.

Accept Self-Signed Server Certificates—This option is available only if
you selected the Close Connection if SSL Negotiation Fails check box.
Determines whether HostExplorer accepts certificates that have been
signed by the organizations themselves rather than a CA. By default, this
option is cleared.

Cipher Suites—Opens the SSL/TLS Ciphers dialog box corresponding
to the SSL/TLS version that you specified in the Version list. In the dialog
box, you can specify the cipher suites that HostExplorer and the server
will use for data encryption.



User Authentication

Note: This area is only available if SSL/TLS is installed.
User Certificate Mode—Select from the following list of options:

Prompt for User Certificate—If you select this item, the User
Certificate Selection dialog box opens when you re-connect to the
server using this session. This dialog box lets you select or create
a user certificate for the SSL/TLS connection. This option is ideal
for administrators who want different users working on the same
machine to select their own user certificates.

Select User Certificate—Lets you select a user-specific
certificate that you created or imported in the User Certificates
store. Click Browse to specify a user certificate that you want to
use to connect to the host.

No User Certificate—Lets you connect without using a user
certificate. By default, this option is selected.

Certificates and Keys Manager—Opens the Certificates and Keys
Management Console which you can use to create and manage keys
and certificates.

Related Topics

Overview—Hummingbird Connectivity SSL
Negotiating SSL/TLS Communication
Selecting Cipher Suites

Certificate Information Window

About Certificates and Keys Manager




Display Folder—3270 General Category
3270

In the General category, you can set general display options for the 3270
terminal.

Display Nulls—Determines whether HostExplorer displays Null
characters located in unprotected fields as centered dots. This option is a
display feature only and does not affect how HostExplorer sends data to
the host system. By default, this option is cleared.

Display Blink as Italic—Maps the Blink Attribute to Italicized font so that
blinking text becomes non-blinking and italicized. This option provides an
alternative way of differentiating between blinking and non-blinking text.
This option is independent of the Cursor Mode. By default, this option is
cleared.

Display All Upper Case—Determines whether HostExplorer displays all
output in uppercase. By default, this option is cleared.



OIA Options

Display Row/Col Indicator—Determines whether HostExplorer displays
the Row and Column Indicator in the right-hand corner of the Operator
Information Area (OIA). By default, this option is selected.

OIA Line Mode—Select the type of OIA. Select whether you want
HostExplorer to display the Terminal Style OIA Line, the Windows Style
OIA Status Bar, or no status line at all. By default, the Windows Style OIA
Status Bar option is selected.

Display in OIA—Select whether you want HostExplorer to display the
host IP address or the host response time in the OIA. By default, the Host
IP Address option is selected.



Outlining Options

Field Outlining—Enables outlining input fields and indicates to the host
that the current session supports Field Outlining. The outline may not be
visible if the host does not also support this feature. Enable Always

Outline to ensure that input field outlines are visible. By default, this
option is cleared.

Always Outline—Forces outlining of all input fields even if the
host does not support field outlining. By default, this option is
cleared.

Outline Field Attribute Character—Includes the initial field
attribute character in the outline. By default, this option is cleared.

Related Topics
User Environment Customization




Display Folder—VT General Category
VT

In the General category, you can set general display options for the VT
terminal.

Display Blink as Italic—Maps the Blink Attribute to Italicized font so that
blinking text becomes non-blinking and italicized. This option provides an
alternative way of differentiating between blinking and non-blinking text.
By default, this option is cleared.

Note: This option is independent of the Cursor Mode.

Display Row/Col Indicator—Determines whether HostExplorer displays
the Row and Column Indicator in the right-hand corner of the Operator
Information Area (OIA). By default, this option is selected.

Compress Blank Lines in Scrollback—Prevents HostExplorer from
adding blank lines to the Scrollback buffer. Select this item if you want to
compress new lines to create more space in the buffer. By default, this
cleared.

Note: This option only affects new lines added to the Scrollback buffer.

Save Attributes in Scrollback—Saves the Telnet screen attributes
within data in the Scrollback buffer. By default, this option is selected.

Note: Selecting this option forces HostExplorer to use more memory for each line it saves.

Save Erased Screens—Determines whether you can save a screen to
the Scrollback buffer before performing the Erase-Screen Host
command. By default, this option is cleared.

Enable ISO Colors—Determines whether HostExplorer enables support
for ISO colors for ANSI color escape sequences when using VT100,
VT101, VT220, VT320, and VT420 models. By default, this option is
cleared.

Note: ANSI and SCO ANSI Models do not support this option.
Lines Available in Scrollback—Determines the number of lines

HostExplorer maintains within the Scrollback buffer. This number can
vary between 1 and 9,999. By default, this option is set to 100.



Note: To disable the Scrollback buffer, set the number to zero.



Status Line Options

Host Writable Status Line—Makes the status line available to the host
to display information.

Status Line Mode—Within VT, the bottom line in the terminal window is
a one-line status area that displays information about the current session.

No Status Line—Prevents HostExplorer from displaying a status
line.

Terminal Style Status Line—Indicates to HostExplorer to display
host information in the terminal status line.

Windows Style Status Bar—Indicates to HostExplorer to display
information in a Windows style status bar. By default, this option is
selected.

Related Topics
User Environment Customization
Searching and Disabling the Scrollback Buffer




SSL/TLS Ciphers Dialog Box
3270 VT

To access

Using this dialog box, you can specify cipher suites to use for data
encryption between HostExplorer and the server. When an SSL
connection is negotiated, HostExplorer sends a list of cipher suites to the
host. The host uses the first supported cipher suite in the list.

The SSL/TLS Ciphers dialog box varies, depending on the SSL/TLS
version that you selected in the Version list of the Session Profile dialog
box.

Ciphers—Lists all available cipher suites available for data encryption
and lets you select which ones to use for a session. To select multiple
items, hold down the Shift or Ctrl key while clicking ciphers.

Select All—Selects all cipher suites in the list.
Clear All—Clears all cipher suites in the list.

Use Default Ciphers—Lets the OpenSSL libraries select the list used for
negotiation. By default, this option is selected.

Related Topics
Selecting Cipher Suites
Security Folder—SSL/TLS Category
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Upload to Host Dialog Box
3270

To access

Use this dialog box to configure transfer settings.
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Send From

Source—Lets you specify the source location of the file that you
want to upload.

Disk—Transfers a file from disk.
Clipboard—Transfers data from the Clipboard.

Scheme—Selects a saved file transfer scheme. A file transfer
scheme is a collection of various file transfer settings.

Local File Name—Specifies the local file you want to upload.
Click Browse to search for it.



Send To

Host File Name—Specifies the name of the file as you want it to
appear on the remote host. This option varies according to the
scheme that you select (CICS, CMS, or TSO).

Minidisk—Specifies the intended mainframe location for the file.
This option is only available if you select a CMS scheme in the
Scheme list.

Dataset(TSO)—Specifies the intended mainframe location for the
file. This option is only available if you select a TSO scheme in the
Scheme list.



Transfer List
Status column—Displays the current status of the file transfer.

Local File Name column—Displays the name of the file being
transferred.

Host File Name column—Displays the name of the file as you
want it to appear on the remote host.

Scheme column—Displays the file transfer scheme you specified
in the Send From area.

Progress column—Displays the progress of the file transfer
process.

Add button—Adds a file transfer to the transfer list.
Update button—Updates the status of the file transfer.
Remove button—Removes a file transfer from the transfer list.

Remove All button—Removes all file transfers from the transfer
list.

Save List button—Saves a list as a Transfer List (.tlf) file.

Open List button—Launches the Open Transfer List dialog box,
where you can open a saved Transfer List (.tlf) file.

Templates button—Launches the File Transfer Name Templates dialog
box, where you can specify a template used to format the file being
transferred.



Options button—Launches the Session Profile dialog box, where you
can configure the File Transfer settings.

Related Topics

Overview—Transferring Files

User Environment Customization

Transferring Files to a Mainframe

HostExplorer File Transfer Name Templates Dialog Box




Download from Host Dialog Box
3270

To access

Use this dialog box to configure file transfer settings.
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Receive From

Host File Name—Specifies the name of the file that you want to
download. The specified name causes the scheme to change if it
matches an entry in the Templates list. This option varies according to the
scheme that you select (CICS, CMS, or TSO).



Receive To
Destination—Specifies the destination for the file.

Disk—Saves the received data in a file.
Clipboard—Saves the received data in the clipboard.

Scheme—Selects a saved file transfer scheme. A file transfer scheme is
a collection of various file transfer settings.

Local File Name—Displays the name of the file that you want to create
or overwrite on your PC. As you enter a name in the Host File Name box,
the local file name is automatically displayed. You can change the
extension by selecting an entry in the Templates list.



Transfer List
Status column—Displays the current status of the file transfer.

Local File Name column—Displays the nhame of the file you want to
create or overwrite your PC.

Host File Name column—Displays the name of the file you want to
download from the remote host.

Scheme column—Displays the file transfer scheme you specified in the
Receive To area.

Progress column—Displays the progress of the file transfer process.
Add button—Adds a file transfer to the transfer list.

Update button—Updates the status of the file transfer.

Remove button—Removes a file transfer from the transfer list,
Remove All button—Removes all file transfers from the transfer list.
Save List button—Lets you save a list as a Transfer List (.tlf) file.
Open List button—Launches the Open Transfer List dialog box, where
you can open a saved Transfer List (.tIf) file.

Templates button—Launches the File Transfer Name Templates dialog
box, where you can specify a template used to format the file being
transferred.

Options button—Launches the Session Profile dialog box, which lets
you configure the File Transfer settings.

Related Topics

HostExplorer File Transfer Name Templates Dialog Box
User Environment Customization
Overview—Transferring Files

Receiving Files from a VT Host




5250 Data Transfer Wizard—Welcome Page

Use Saved 5250 Data Transfer Wizard Profile—Select this option to
use an existing file transfer profile for the current transfer. If you do not
select this option, the wizard creates a new profile for you.

Saved 5250 Data Transfer Wizard Profiles—Type the path to an
existing file transfer profile or click Browse to search for one.
Note: You can use the Execute button to perform a transfer at any stage of the wizard process. The

Execute button becomes available when you have provided the minimum information required
to perform a transfer.

Related Topics
5250 Data Transfer Wizard—General Setup Page
5250 Data Transfer Wizard—Complete Page




Mouse Folder—General Category
3270 5250 VT

In the General category, you can configure mouse button actions within
HostExplorer.

Scheme—Lists the schemes available for use in the current session. You
can enter the name of a new scheme or select an existing scheme from
the list.

Save Scheme—Opens the Save Scheme As dialog box, which lets you
enter a name (or change the name of) a scheme.

Mouse Action—Lets you select a mouse action. Mouse actions are fully
configurable. For example, you can configure the Right-Single Click
action to any of the Function Groups and/or Functions available in the
drop-down lists.

Function Group—Lets you specify the group of functions that displays in
the function list.

Function—Lists functions that you can assign to a mouse action.

Text Selection Mode—Determines how HostExplorer selects text in the
terminal window.

Block—Indicates to HostExplorer to select a rectangular region of
the screen when you select text. By default, this option is selected.

Stream—Indicates to HostExplorer to select text in a stream-like
fashion when you select text.

Selection Display Mode—Determines how HostExplorer displays
selected text in the terminal window.

Rubber Band—Displays selected text as a rectangle with a thin
outline.

Reverse Video—Displays selected text in reverse colors from
unselected text. For example, if unselected text displays as black



text on a white background, the selected text displays as white text
on a black background.

Set—Saves changes and leaves the dialog box open.
Reset—Restores the original settings for the selected Mouse Action.

Reset All—Restores the original settings for all the Mouse Actions.

Related Topics

User Environment Customization
Mouse Customization

Dragging Text to a New Location
Remapping Mouse Buttons
Customizing the Track Menu




Edit Folder—Copy, Cut and Paste Category
3270 5250 VT

In the Cut & Paste category, you can set options for cutting and pasting
text.

Cut Mode (3270 and 5250 only)—Determines how HostExplorer
removes selected text from unprotected areas of the screen.

Replace with Spaces—Replaces selected text with spaces.
Replace with Nulls—Replaces selected text with nulls.

Delete Text—Deletes selected text. By default, this option is
selected.

Replace Field Attr with (3270 and 5250 only)—Indicates to
HostExplorer to replace field attributes with the option you select. By
default, the Comma option is selected.

Paste Mode (3270 and 5250 only)—Determines how HostExplorer
pastes the contents of the clipboard to the current cursor location.

Block Mode—Indicates to HostExplorer to stop pasting text upon
reaching a protected field on the screen. By default, this option is
selected.

Overlay Block Mode—Indicates to HostExplorer to paste over
protected fields on the screen.

Stream Mode—Pastes text one character at a time and stop upon
reaching a protected field.

Stream Mode with WordWrap—Pastes text using Word Wrap.
When using Word Wrap, HostExplorer pastes text, stops at a
protected field, and continues pasting at the next available
unprotected field.



Field Mode using Tab Character—Pastes text in a stream-like
fashion.

Tab to Next Field Using (3270 and 5250 only)—Indicates to
HostExplorer that, when you are pasting, it should continue pasting at the
next field when it sees the option you specify here. These options are
only valid if you choose the Field Mode Using Tab Character option as
the Paste Mode.

Auto Copy Selected Text—Determines whether HostExplorer
automatically copies text to the Clipboard as you select the text. By
default, this option is cleared.

Keep Selection After Copy—Determines whether HostExplorer
maintains the selection once you have copied the text. By default, this
option is cleared.

Note: For this option to function, you must select the Auto Copy Selected Text option.

Move Cursor After Paste (3270 and 5250 only)—Determines whether
HostExplorer automatically repositions the cursor after pasting text. By
default, this option is selected.

Remove Trailing Blanks on Copy—Determines whether HostExplorer
removes all blank characters at the end of the text when copying text. By
default, this option is selected.

Remove Trailing CR/LF on Copy—Determines whether HostExplorer
removes Carriage-Return Linefeed(CR-LF) sequence from copied data.

Related Topics
User Environment Customization
Enabling Auto Copy




Edit Folder—Entry Assist Category
3270 5250

In the Entry Assist category, you can set word-processing features for
editing text in memos, letters, and reports.

Entry Assist Enabled—Enables Entry Assist which lets you use Word
Wrap, Tab Stops, and Margin options. By default, this option is cleared.

Note: Press Ctrl+E to toggle this option on and off without opening this dialog box.
Word Wrap Enabled—Determines whether text is cut upon reaching the

end of a field or gets wrapped to the next available field. By default, this
option is selected.

Note: Press Ctrl+W to toggle this option on and off without opening the dialog box.
Margins—Determines margin values for the terminal screen. When you
set margins, you can enter a numeric value or click an area on the

screen. If you do not enter margins, HostExplorer automatically uses the
field width.

Left Margin—Sets the left margin. You can enter a numeric value
or click on an area of the screen.

Right Margin—Sets the right margin. You can enter a numeric
value or click on an area of the screen.

Bell Margin—Sets the bell margin. You can enter a numeric value
or click on an area of the screen. The bell margin is like the bell
setting on a typewriter. It specifies the column number that a
cursor must pass to initiate the sound of a bell.

Tab Stops—Determines the location of the tab stop(s). When you set tab
stops, you can enter a numeric value, or click an area on the screen.

Set—Saves changes and leave the dialog box open.
Clear—Resets the default setting for the selected item.

Clear All—Resets the default settings for all items in the dialog box.



Related Topics
User Environment Customization
Using Entry Assist and Word Wrap




Shortcuts Folder—General Category
3270 5250

In the General category, you can enable or disable the HostExplorer
Shortcuts option and select how you want HostExplorer to replace the
shortcut keywords.

Enable Shortcuts—Lets you enable or disable the Shortcuts option. By
default, this option is selected.

Shortcut Mode—Select one of the following:

Manual—Searches the current screen and replaces all enabled
keywords in the active scheme with their associated text.

Automatic—Replaces keywords with longform text as you type.
This option requires that you specify delimiters.

On Field Exit—Searches the current input field and replaces all
enabled keywords in the active scheme with their associated text.

Delimiters—Lets you specify one or more characters that you enter
before and after a keyword. Delimiters indicate to HostExplorer that
replacement text is required. For example, if your keyword is “key” and
you enter “@#” in the delimiters box, all of the following strings indicate
that text replacement is required:

. @key#
- @key@
. #key#

. #fkey@

This option is only available when you select the Automatic shortcut
mode.

Related Topics
Shortcuts Folder—Assignments Category




Creating a Shortcut Scheme
Using Shortcuts




Shortcuts Folder—Assignments Category
3270 5250

In the Assignments category, you can add, edit, or remove shortcuts in a
shortcut scheme. You can also delete and rename shortcut schemes.

Scheme—Lists the schemes available for use in the current session. You
can enter the name of a new scheme or select an existing scheme from
the list.

Save Scheme—Opens the Save Scheme As dialog box, which lets you
enter a name (or change the name of) a scheme.

Note: If you do not save the shortcuts in the list as a scheme, HostExplorer saves them in your
session profile.

Delete Scheme—Removes the selected scheme from the Scheme list.

Shortcuts—Lets you enable or disable shortcuts. You can also double-
click on a shortcut to open the Edit Shortcut Info dialog box.

Add New Shortcut—Opens the Add New Shortcut dialog box, which lets
you specify parameters for a new shortcut.

Edit Shortcut—Opens the Edit Shortcut Info dialog box, which lets you
modify the parameters of the selected shortcut.

Delete Shortcut—Deletes the selected shortcut in the Shortcuts list.
Delete All—Deletes all the shortcuts in the Shortcuts list.

Move Up/Move Down—Moves the selected shortcut up or down a row in
the Shortcuts list. The position of the shortcut in the list determines
replacement priority.

Related Topics

Shortcuts Folder—General Category
Creating a Shortcut Scheme

Using Shortcuts




Add New Shortcut Dialog Box
3270 5250 VT

To access
Use this dialog box to specify the parameters of a new shortcut.

Keyword—Specifies the letter, symbol, or word that you want to use to
represent the longform text.

Longform—Specifies the longform text that you want to associate with
the keyword.

Case Sensitive—Lets you enable or disable case-sensitive functionality.

Enabled—Enables the shortcut.

Related Topics

Creating a Shortcut Scheme

Using Shortcuts

Shortcuts Folder—General Category
Shortcuts Folder—Assignments Category
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Edit Shortcut Info Dialog Box
3270 5250 VT

To access
Use this dialog box to modify the parameters of the selected shortcut.

Keyword—Specifies the letter, symbol, or word that you want to use to
represent the longform text.

Longform—Specifies the longform text that you want to associate with
the keyword.

Case Sensitive—Lets you enable or disable case-sensitive functionality.

Enabled—Enables the shortcut.

Related Topics

Creating a Shortcut Scheme

Using Shortcuts

Shortcuts Folder—General Category
Shortcuts Folder—Assignments Category
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Capture Folder—General Category (VT)
VT

In the General category, you can set output options for VT sessions. This
option lets you capture scrolling data that displays in the session window.

Save Mode—Specifies the save mode.

Overwrite—HostExplorer deletes the existing file by overwriting
with the new information.

Append—HostExplorer adds the new file to the end of the existing
file. This option only affects screen saves since, by default,
HostExplorer saves screen captures in append mode. You can
override this option when you save the screen in the Save Screen
to Disk dialog box.

Capture Mode—Specifies how to capture selected text.

Raw—The system captures all data, including escape sequences,
received by the emulator.

Text—Removes escape sequences so that what appears on the
screen is what is sent to the printer. In this mode, the system
captures every line that is terminated by a line feed allowing you to
capture line by line output.



Save As Options

Confirm All Saves—Forces the "Save-Screen" command to prompt for a
filename. By default, this option is selected.

Default Save Filename—Specifies a default path and file name
HostExplorer uses for saved and captured files.

Capture Erased Screens—Lets you capture non-scrolling data before
the host sends a command to erase the screen (for example, data that
displays in a screen that clears in order to display more data). By default,
this option is cleared.

Related Topics
User Environment Customization
Saving Data to a File




Save Screen to Disk Dialog Box
3270 5250 VT
To access

You can save a snapshot of the current screen to a file. By default,
HostExplorer saves the file in ASCII format.

Save In—Specifies a drive and directory for the file.

Directory window—Opens directories by double-clicking them.
File Name—Specifies a filename for the screen file.

Save as Type—Specifies a file format for the file.

Save Mode—Specifies the save mode.

Overwrite—Indicates to HostExplorer to delete the existing file by
overwriting with the new information.

Append—Indicates to HostExplorer to add the new file to the end
of the existing file. This option only affects screen saves since by
default. HostExplorer saves screen captures in append mode. You
can override this option when you save the screen in the Save
Screen to Disk dialog box.

Save As—Specifies whether to save information in ASCII (DOS) or ANSI
(Windows) format.

Related Topics
Saving Data to a File
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Capture Folder—General Category
3270 5250

In the General category, you can set output options for 3270 and 5250
connections. This option lets you capture scrolling data that displays in
the session window.

Save Options—Specifies the save mode.

Overwrite—HostExplorer deletes the existing file by overwriting
with the new information.

Append—HostExplorer adds the new data to the end of the
existing file. This option only affects screen saves since, by
default, HostExplorer saves screen captures in append mode. You
can override this option when you save the screen in the Save
Screen to Disk dialog box.

Save As Options—Specifies the format of the saved capture file. You
can save the HECAPTURE file in Ascii (DOS), Ansi (Windows), or XML
format.

Confirm All Saves—Forces the Save-Screen command to prompt for a
filename. By default, this option is selected.

Default Save Filename—Specifies a default path and file name for
saved and captured files. Click Browse to change the location.

Related Topics
User Environment Customization
Saving Data to a File




Print Multiple Screens Dialog Box
3270 5250 VT

To access

This dialog box lets you specify the host screens that you want to print,
as well as the printer used to print these screens.

Note: All the buttons in the dialog box have an associated keyboard shortcut. =

Capture Screen—Captures the current host screen and adds it to the
Selected Host Screens list.

Properties—Opens the Session Profile dialog box with the Print Screen
category of the Print folder selected. You can use the Print Screen
category to specify options for the screens to be printed. You can click
the Print Screen-Advanced category to specify the number of host
screens that you want printed on each page.

Print—Opens the Print dialog box used to print the screens selected in
the Selected Host Screens list.

Selected Host Screens—Lists the host screens that you specified to be
printed using the Capture Screen button. Each host screen is identified
by the first line of text in the screen. By default, all screens are selected
to be printed. To indicate that you do not want a screen to be printed,
clear the check box next to it.

Note: The selected host screens in the Selected Host Screens list will be printed in the order in which
they appear.

View Screen—Opens the View Screen window, which shows a print
preview of the selected host screen.

Delete—Removes the selected host screen from the Selected Host
Screens list.

Delete All—Removes all of the host screens from the Selected Host
Screens list.

Copy—Copies the selected host screen.
Paste—Pastes the copied host screen to the Selected Host Screens list.

Move Up—Moves the currently selected item up one row in the Selected
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Host Screens list.

Move Down—Moves the currently selected item down one row in the
Selected Host Screens list.

Related Topics

Introducing Report Schemes

Print Folder—Print Screen Category

Print Folder—Print Screen Advanced Category




Print Folder—Print Screen Category
32705250 VT

In the Print Screen category, you can set general print screen options.

Add FormFeed After Raw Print Screen—Disables the automatic form
feed after HostExplorer sends a "screen image" to the printer. By default,
this option is selected.

Print Border—Prints a thick border around the printed screen image.
This option can only work if you select Centered On Page as the Print
Screen Location option. By default, this option is cleared.

Print Operator Information Area (OIA)—Prints the Operator Information
Area (OIA) on the print screen output. By default, this option is selected.

Print Screen Font—Opens the Font dialog box, which lets you change
the parameters of the default font or select a different font to use for the
print output. The default font is HE_ TERMINAL, 12.

PrintScreen Location—Specify how the screen appears on the printed
page.
Centered on page—Prints the screen image in the center of the
page.

Upper-Left hand corner—Prints the screen image in the upper
left-hand corner of the page.

Use Specific Printer—When selected, HostExplorer prints using the
printer displayed in the Select Printer Info area. When you clear the
option, HostExplorer uses the default printer. By default, this option is
cleared.

Selected Printer Info—Displays information about the current printer
and its settings. To change any of these settings, click Select Printer and
make your changes within the Print dialog box.

Select Printer—Select a printer. This button is enabled only when
you select the Use Specific Printer option.




Related Topics
User Environment Customization
Print Folder—Print Screen Advanced Category




Report Wizard Dialog Box
3270 5250

To access

Use this dialog box to select and execute an existing print area scheme
or to open the Report Wizard, which lets you edit existing an scheme or
create a new one.

Scheme Name—Lists available print area schemes. Select an existing
scheme for the current session, or click Edit to create a new scheme.

Delete Scheme—Deletes the selected scheme and clears the default
scheme in the current session profile.

Destination—Lets you change the current destination. This destination is
temporary and is not saved in the scheme.

Display Print Screen—Opens the standard Print Setup dialog
box, where you configure the destination printer. This button is
available only if you select Color Print in the Destination box.

Display Save Screen to Disk—Opens the Save Screen to Disk
dialog box, which lets you configure the setup parameters for
saving the file. This button is available only if you select File in the
Destination box.

Print—Executes the print report function.

Edit—Opens the Report Wizard, which lets you edit an existing scheme
or create a new one.

Related Topics
Introducing Report Schemes
Creating a Print Area Report Scheme



javascript:Dialogs99.Click();

Print Folder—Printer Session Category
3270 5250

In the Printer Session category, you can set options for your printer
session.

Base Printer Session Profile—Specifies the printer session profile
(. hep) you want to associate with the current session.

Browse Printer Session Profiles—Opens the Browse Printer
Session Profiles dialog box in which you can specify an existing
printer session profile.

Edit this Printer Session Profile—Opens the Printer Session
Profile dialog box in which you can modify the properties for the
specified profile. This button is enabled only when you specify a
profile in the Base Printer Session Profile box.

Create a New Printer Session Profile—Opens the Printer
Session Profile dialog box in which you can specify properties for
a new profile. The new printer session profile will be assigned a
unique number to the default name My Profile.hep (for

example, My Profile 53.hep).

Start Printer Session Automatically—Starts a printer session as soon
as you launch a display session. This check box is enabled only when
you specify a profile in the Base Printer Session Profile box.

Limit to Single Instance—If you launch more than one instance
of a display session, the associated printer session starts only
once. This check box is enabled only when you specify a profile in
the Base Printer Session Profile box and when Start Printer
Session Automatically is selected.

Close Printer Session Automatically—Closes the printer session as
soon as you terminate the session. This check box is enabled only when
you specify a profile in the Base Printer Session Profile box.



Note: If you connect to more than one printer session using the same display session profile, and
more than one printer session launches automatically, when you select the Close Printer
Session Automatically option, all of the printer sessions terminate as soon as you disconnect
from the last display session.

Host Name—Specifies the host name or IP address of which the printer
session will establish a connection.

Printer LU Settings—Specifies how the logical unit (LU) is determined.

Use profile LU—Uses the LU name specified in the base printer
session profile.

Automatic LU (Associate)—The LU name is assigned by the
host.

Specific Printer LU—Determines the LU name for the current
print session. When you specify this setting, the Specific Printer
LU box is enabled in which you can specify an LU name.

Related Topics

User Environment Customization

Printer Session Profiles

General Page (Printer Session Properties Dialog Box)

LU1 Settings Page (Printer Session Properties Dialog Box)
LU3 Settings Page (Printer Session Properties Dialog Box)




Keyboard Map Dialog Box
3270 5250 VT
To access

By creating Keyboard Mappings, you can map or assign the keys on your
PC keyboard to different values, Functions, Quick-Keys, Quick Scripts,
and Macros.

Keyboard Image—Sets options for the clicked key in the Selected Key
area.

Selected Key—Configures settings for the key that you clicked on the
keyboard image.

Normal—Used to remap a key in Normal mode. You can also view
the current value for a key mapped to Normal mode.

Shift—Used to remap a key in Shift mode. You can also view the
current value for a key mapped to Shift mode.

Control—Used to remap a key in Ctrl mode. You can also view
the current value for a key mapped to Ctrl mode.

Control+Shift—Used to remap a key in Ctrl+Shift mode. You can
also view the current value for a key mapped to Ctrl+Shift mode.

Alt—Used to remap a key in Alt mode. You can also view the
current value for a key mapped to Alt mode.

Alt+Shift—Used to remap a key in Alt+Shift mode. You can also
view the current value for a key mapped to Alt+Shift mode.

Alt+Control—Used to remap a key in Alt+Control mode. You can
also view the current value for a key mapped to Alt+Control mode.

Default—Resets the currently selected key to its original default
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mapping.
Clear Entry—Maps the currently selected key to do nothing.

Set—Reconfigures the selected keyboard mapping to perform the
selected function.

List Assigned Functions—Displays the Keyboard Assignments dialog
box, which lists the currently assigned keyboard mappings for
consultation purposes. You can also print this list.

Reset All—Resets all keys to their original default mappings.

Function Group—Specifies the type of action the new key mapping
performs (for example, System Commands).

Function—Specifies the function the new mapping performs (for
example, Disconnect or Pause).

Save—Displays the Save Keymap dialog box, where you can save the
current set of keyboard mappings using a name you supply.

Load—Loads a previously saved set of keyboard mappings.

Related Topics

Keyboard Assignments Dialog Box
Save Keymap Dialog Box
Keyboard Customization
Reconfiguring an Existing Keyboard
Enabling a Keyboard File




Keyboard Assighments Dialog Box
3270 5250 VT

To access
You can use this dialog box to keep track of existing key mappings.
Function list—Lists all current functions.
Assigned Key list—Lists the key assigned to each function.

Print—Prints the contents of the dialog box.

Related Topics
Keyboard Customization
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Customize Session Properties Dialog Box—

Scheme Tab
3270 5250 VT

To access

Use the Scheme tab to create, manage, and modify session properties
schemes.

Scheme—Lists existing session properties schemes.

New—Opens the New Scheme dialog box, where you can enter a name
for a new session properties scheme and choose to use the default
session properties configuration as a basis for the scheme that you want
to create.

Save As—Lets you save a copy of the session properties scheme with a
different name.

Rename—Lets you rename an existing session properties scheme.
Delete—Deletes the selected session properties scheme.
Reset—Resets the selected scheme to the default scheme settings.

Apply—Saves any changes to the selected session properties scheme
and applies this scheme to the active session window.

Related Topics
Customize Session Properties Dialog Box—Customize Tab
User Environment Customization
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Customize Session Properties Dialog Box—

Customize Tab
3270 5250 VT

To access

Use the Customize tab to select session folders and categories to add to
or remove from a Session Properties scheme. You can also create new
categories, rename property captions, and delete properties from the
selected scheme.

Note: You can use the Session Profile dialog box to select which categories to display.
Scheme Name—Lists the session properties of the selected scheme.

You can modify the scheme by selecting an option in the context menu,
or you can drag and drop properties to the selected scheme.

Default Scheme Name—Lists the session properties in the default
scheme.

Note: All available categories for a specific terminal type display in the Default Scheme box. However,
only relevant categories display in a specific profile.

For example, if your profile uses a modem connection, the Telnet category does not appear in
the Session Profile dialog box, even if you added it to your customized scheme.

Apply—Saves any changes to the selected session properties scheme
and applies this scheme to the active session window.

Related Topics
Customize Session Properties Dialog Box—Scheme Tab
User Environment Customization



javascript:Dialogs24.Click();

Tools Menu
3270 5250 VT

The Tools menu contains the following items:
Macro—Used to access macro features.

Edit—Opens Hummingbird Basic Workbench, which you can use
to write macro scripts.

Run—Used to select and run a macro.

Start Recording—Begins recording your actions.
Pause Recording—Suspends the macro recording.
Resume Recording—Restarts the macro recording.

Stop Recording—Stops the macro recording and opens the Save
Recorded Macro File dialog box.

Cancel Recording—Cancels the current recording session.

Quick Script—Used to access Quick Script features.

Edit—Opens the Quick Script Editor that you can use to write
Quick Scripts.

Run—Used to select and run a Quick Script.
Stop—Terminates the Quick Script.
Start Recording—Begins recording your actions.

Pause Recording—Suspends the Quick Script recording.



Resume Recording—Restarts the Quick Script recording.

Stop Recording—Stops the Quick Script recording and opens the
Save Recorded Quick Script File dialog box.

Cancel Recording—Cancels the current recording session.

Customize Toolbars—Opens the Customize Toolbars dialog box, which
lets you create, manage, and modify toolbar schemes. You can also
create new toolbar configurations and enable one or more toolbars to
display in the Session Window.

Customize Menus—Opens the Customize Menus dialog box, which lets
you create, select, rename and save menu schemes. You can also add
or delete menu functions, rename menus and create new submenus to a
menu scheme.

Customize Session Properties—Opens the Customize Session
Properties dialog box, which lets you create, select, rename and save
session properties schemes. You can also create new categories,
rename property captions, and delete properties from a scheme.

Related Topics

Menu Folder—General Category

Toolbar Folder—General Category

Toolbar Customization

Customize Toolbars Dialog Box—Scheme Tab
Customize Toolbars Dialog Box—QOptions Tab
Customize Toolbars Dialog Box—Functions Tab
Customize Session Properties Dialog Box—Scheme Tab
Customize Session Properties Dialog Box—Customize Tab
Customize Menus Dialog Box—Scheme Tab

Customize Menus Dialog Box—Customize Tab
Overview—Quick Scripts

Recording, Editing, and Running Macros




Themes Folder—General Category
3270 5250 VT

In the Themes category, you can select multiple profile settings schemes
(such as color, event, and menu schemes) and save them as a theme.

Theme—Lets you select from the list to specify the theme that you want
to apply to the current session.

Note: When you create a theme, make sure to click Save As to save it.
Save As—Lets you name and save the new theme.
Delete—Deletes a selected theme.

Schemes List—Specifies a scheme element and its assignment. Lets
you change the assignment for a scheme. Double-click on the scheme
name to display a list of existing schemes.

Note: You can create new schemes using the Session Properties dialog box or the HostExplorer
session menu. (For example, you can create a new color scheme in the color folder.)

Apply—Applies the revised theme. The schemes you select in the theme
box override schemes in the profile.

Related Topics

User Environment Customization

Revising the Session Window with Customized Schemes
Creating Themes

New Profile Dialog Box

Open Session Dialog Box




HostExplorer Functions
3270 5250 VT

The following HostExplorer functions, part of the System Commands,
Action Keys, and Editing Keys function groups, can be used when setting
items such as keyboard mappings, mouse actions, toolbar buttons, track
menu, Quick-Keys, Quick Scripts, macros, and events. The availability of
these functions vary depending on whether you are working with a 3270,
5250, or VT terminal.



Function—Description

Ansi-Center—Ansi Center function.
Ansi-Delete—Ansi Del function.

Ansi-End—Ansi End function.

Ansi-Home—Ansi Home function.
Ansi-Insert—Ansi Insert function.
Ansi-Page-Down—Ansi Page Down function.
Ansi-Page-Up—Ansi Page Up function.

Ansi-F1 -> F12—Ansi F1-F12 function.
Ansi-Ctrl-F1 -> F12—Ansi Ctrl F1-F12 function.
Ansi-Shift-F1 -> F12—Ansi Shift F1-F12 function.
Ansi-Ctrl-Shift-F1 -> F12—Ansi Ctrl Shift F1-F12.
Attention—Presses the SNA Attention Key.
Back-Tab—Tabs backward to the previous field.

Backspace—Moves the cursor back one position and delete the
character.

Cancel-Macro-Recording—Cancels the recording of a macro.
Cancel-Recording-QuickScript—Cancels the recording of a Quick Script.

Capture-Screen—With Screen Capture mode toggled on, captures the
current screen and saves it to the specified file.

Cascade-Session-Windows—Cascades the display of all session
windows.

Change-Graphics-Cursor—Toggles the graphics cursor.
Clear—Clears the screen.

Clear-Buffer—Clears the VT Scrollback buffer and display.
Clear-Display—Clears the VT display.

Close-Window—Closes the current terminal window.



Color-Blue—Sets the extended color attribute to Blue.
Color-Field-Inherit—Sets the extended color attribute to Field Inherit.
Color-Green—Sets the extended color attribute to Green.
Color-Pink—Sets the extended color attribute to Pink.
Color-Red—Sets the extended color attribute to Red.
Color-Turquoise—Sets the extended color attribute to Turquoise.
Color-White—Sets the extended color attribute to White.
Color-Yellow—Sets the extended color attribute to Yellow.
Compose—VT Compose function.

Connect—Reconnects the current terminal session to the host.
Cursor-EOF—Moves cursor to last position in the current field.
Cursor-EOL—Moves cursor to end of text in the current field.
Cursor-Select—Cursor-Select (light pen).

Dead-Key—Does nothing.

Delete—Deletes the character at the cursor location.
Delete-Line—Deletes the line at the cursor location.
Delete-Word—Deletes the word at the cursor location.
Disconnect—Disconnects the current terminal session from the host.
DIg-API-Settings—Opens the API Global Settings dialog box.
Dlg-Close-Session—Opens the Close Current Session dialog box.
Dlg-Close-Window—Opens the Close Frame dialog box.
Dlg-Customize-Menus—Opens the Customize Menus dialog box.

Dlg-Customize-Session-Properties—Opens the Customize Session
Properties dialog box.

Dlg-Download—Opens the Download from Host dialog box (3270) or
Download Files dialog box (VT).

Dlg-Edit-Macro—Opens the Macro editor.



Dlg-Edit-Session-Profile—Opens the Session Profile dialog box.
Dlg-Exit—Opens the Exit HostExplorer dialog box.
Dlg-Find—Opens the Find dialog box.

Dlg-Font-Select—Opens the Session Font dialog box.
Dlg-Global—Opens the HostExplorer Global Features console.

Dlg-Hotspots—Opens the Assignments category of the Hotspots folder in
the Session Profile dialog box.

Dlg-Keyboard-Assignments—Opens the Keyboard Assignments dialog
box.

Dlg-Keyboard-Mapper—Opens the Keyboard Map dialog box.
Dlg-New-Session—Opens the Create New Profile dialog box.
Dlg-Open-Layout—Opens the Open Layout dialog box.
DIg-Open-Session—Opens the Open Session dialog box.

Dlg-Open-Session-In-Same-Window—Opens the Open Session dialog
box, which lets you select a session to open in the same window as the
currently active session.

Dlg-Options-Color-General—Displays the General category of the Color
folder in the Session Properties dialog box.

Dlg-Options-Connection-Other—Displays the Other category of the
Connection folder in the Session Properties dialog box.

Dlg-Options-Connection-Telnet—Displays the category specific to the
profile telnet type of the Connection folder in the Session Properties
dialog box.

Dlg-Options-Cut-Copy-Paste—Displays the Cut, Copy, and Paste
category of the Edit folder in the Session Properties dialog box.

Dlg-Options-Display-General—Displays the General category of the
Display folder in the Session Properties dialog box.

Dlg-Options-Edit-General—Displays the General category of the Edit
folder in the Session Properties dialog box.

Dlg-Options-Event-General—Displays the General category of the



Events folder in the Session Properties dialog box.

Dlg-Options-File-Transfer-General—Displays the General category of the
File Transfer folder in the Session Properties dialog box.

Dlg-Options-Font-General—Displays the General category of the Font
folder in the Session Properties dialog box.

Dlg-Options-Hotspots-General—Displays the General category of the
Hotspots folder in the Session Properties dialog box.

Dlg-Options-Keyboard-General—Displays the General category of the
Keyboard folder in the Session Properties dialog box.

Dlg-Options-Mouse-General—Displays the General category of the
Mouse folder in the Session Properties dialog box.

DIg-Options-Print-Screen-Advanced—Displays the Print Screen
Advanced category of the Print folder in the Session Properties dialog
box.

DIg-Options-Security-General—Displays the General category of the
Security folder in the Session Properties dialog box.

Dlg-Options-Session-Window-General—Displays the General category of
the Session Window folder in the Session Properties dialog box.

Dlg-Options-Shortcuts-General—Displays the General category of the
Shortcuts folder in the Session Properties dialog box.

DIg-Options-Sound-General—Displays the General category of the
Sound folder in the Session Properties dialog box.

Dlg-Options-Terminal-API—Displays the API category of the Terminal
folder in the Session Properties dialog box.

DIg-Options-Terminal-Graphics—Displays the Graphics category of the
Terminal folder in the Session Properties dialog box.

Dlg-Options-Terminal-Type—Displays the item specific to the profile
telnet type of the Terminal folder in the Session Properties dialog box.

Dlg-Options-Track-Menu-General—Displays the General category of the
Track Menu folder in the Session Properties dialog box.

Dlg-Print-Multiple-Screens—Opens the Print Multiple Screens dialog box.



Dlg-Print-Screen—Opens the Print dialog box.
Dlg-Prompt-Demo-File—Opens the Select 3270 Demo File dialog box.
Dlg-Prompt-Password—Opens the Enter Password dialog box.
Dlg-Report-Wizard—Opens the Report-Wizard.
Dlg-Quick-Key-Editor—Opens the Quick-Key Editor dialog box.
DIg-QuickScript-Editor—Opens the Quick Script Editor.
Dlg-Run-Macro—Opens the Browse Macro Files dialog box.
Dlg-Run-Program—Opens the Run dialog box.
DIg-Run-QuickScript—Opens the Browse Quick Script Files dialog box.

Dlg-Save-Demo-File—Opens the Enter Demo Filename to Save dialog
box.

Dlg-Save-Layout—Opens the Save Layout dialog box.
Dlg-Save-Profile—Opens the Save Profile dialog box.
Dlg-Save-Screen—Opens the Save Screen to Disk dialog box.

Dlg-Save-Shortcut—Opens the Save Shortcut dialog box in a web-
deployed session.

Dlg-Toolbars—Opens the Toolbars dialog box.

Dlg-Upload—Opens the Upload to Host dialog box (3270) or Upload Files
dialog box (VT).

Do—VT F16 function.

Down—Moves the cursor down one line.

Duplicate—Performs the 3270 duplicate.

Duplicate Session—Opens a new connection from an existing one.
Edit-Copy—Copies the selected text to the clipboard.
Edit-Copy-Append—Appends the selected text to the clipboard.

Edit-Copy-Paste—If an area is selected, copies the selected text to the
clipboard, otherwise, pastes the data in the clipboard to the screen.



Edit-Cut—Cuts the selected text to the clipboard.
Edit-Delete—Deletes the selected text.

Edit-Insert—Inserts the text in from the clipboard.
Edit-Paste—Pastes the text from the clipboard.
Edit-Paste-Block—Pastes the clipboard contents in Block mode.
Edit-Paste-Continue—Continues pasting data from the clipboard.

Edit-Paste-Field—Pastes clipboard contents in Field mode using the Tab
character.

Edit-Paste-Overlay—Pastes the buffer to the screen overlaying each
position.

Edit-Paste-Special—Opens the Paste Special dialog box.
Edit-Paste-Stream—~Pastes clipboard contents in Stream mode.

Edit-Paste-StreamWordWrap—Pastes clipboard contents in Stream
mode using WordWrap.

Edit-Redo—Performs a redo of the last edit change.
Edit-SelectAll—Selects the entire screen.
Edit-Undo—Performs an undo of the last edit change.
End—Presses the VT End key function.

End-Recording—Terminates recording of a macro and display the
recorded macro.

Enter—Presses the Enter key.

Entry-Assist-Backspace—If Entry-Assist is enabled, performs a
destructive backspace, otherwise, performs a cursor left.

Erase-EOF—Erases the current field from the cursor location.
Erase-EOL—Erases the current line from the cursor location.
Erase-EOP—Erases the current page from the cursor location. (VT only).
Erase-Field—Erases the current unprotected field.

Erase-Input—Erases all unprotected fields.



Erase-Line—Erases the current input line.
Euro-Symbol—Appends a highlighted rectangle to the clipboard.
Escape—Sends the Escape character (VT Mode).

F1 -> F36—Presses the VT function key.

Fast-Down—Moves the cursor down 2 rows.

Fast-Left—Moves the cursor left 2 columns.

Fast-Right—Moves the cursor right 2 columns.

Fast-Up—Moves the cursor up 2 rows.

Field-Exit—Performs the 5250 Field Exit function.
Field-Mark—Enters the 3270 Field Mark character.
Field-Minus—Performs the 5250 Field Minus function.
Field-Plus—Performs the 5250 Field Plus function.
Find—Performs the VT420 Find function.

Font-Larger—Selects the next larger font.
Font-Smaller—Selects the next smaller font.

Help—Performs the 5250 or VT Help function.
Help-About—Displays the About HostEXxplorer screen.
Help-Index—Opens the HostExplorer help.

Help-Keys—Shows the default keyboard mapping.
Highlighting-Blink—Sets the extended attribute to Blink.
Highlighting-Field-Inherit—Sets the extended attribute to Field-Inherit.
Highlighting-Reverse—Sets the extended attribute to Reverse.
Highlighting-Underscore—Sets the extended attribute to Underscore.
Hold—Puts the VT emulator in Hold State.

Home—Moves the cursor to the topmost unprotected field.

Insert-Field-Attribute—Inserts a Field Attribute at the cursor position.



Insert-Here—Presses the VT Insert-Here key.
Insert-Line—Inserts a null line at the cursor location (VT only).

IPause—Pauses Quick-Key execution until keyboard unlocks for up to 1
second.

Jump-Partition—Moves the cursor to the next partition (VT only).

Jump-To-Session—Jumps to the session specified in the following string
(Quick-Keys only).

Kill-Macro—Terminates the macro that is currently running.
Left—Moves the cursor left one column.

Left-Tab—Moves the cursor left and backtab if at beginning of field.
LinuxF1 -> LinuxF48—Performs the LinuxF1 to LinuxF48 functions.
LinuxBackTab—Performs the Linux Back function.
List-Of-Sessions—Displays a list of currently running sessions.
Maximize-Font—Maximizes the font within the current window frame.

Mouse-To-Cursor—Moves the cursor position to the current mouse
pointer location.

Move-Cursor-Cursor-Select—Moves the cursor to the current mouse
pointer location and presses Cursor Select (Light Pen emulation).

Move-Cursor-Enter—Moves the cursor to the current mouse pointer
location and presses Enter.

Newline—Moves the cursor to the first column on the next unprotected
field.

Next—Presses the VT Next key.
Next-Session—Jumps window to next active session.
Num-Pad-xxx—Presses the VT numpad key.
Pal—Presses the PAL key.

Pa2—Presses the PA2 key.

Pa3—Presses the PA3 key.



Page-Down—Presses the VT Page Down key
Page-Up—Presses the VT Page Up key.

Password—Types the password variable.

Pause—Pauses Quick-Key execution for 1/2 second.
Pause-Recording-QuickScript—Pauses recording a Quick Script.
Pfl -> Pf24—Presses PF1 to PF24.

Power-On-Reset—Performs a VT420 power on reset.
Prev—Presses the VT Previous key.

Prev-Session—Jumps to the previous active session.
Print—Performs the 5250 Print command.
Print-Multiple-Screens—Prints multiple screens to the default printer.

Print-Raw—~Prints the current screen to the default Windows printer, in
raw mode.

Print-Raw-LPT1—Prints the current screen to LPT1 directly in ASCII
(CR-LF) format.

Print-Raw-LPT2—Prints the current screen to LPT2 directly in ASCII
(CR-LF) format.

Print-Raw-LPT3—Prints the current screen to LPT3 directly in ASCII
(CR-LF) format.

Print-Screen—Immediately prints the screen.

Recent-Sessions—Displays a list of the most recent sessions. Create a
submenu, and then add this function to it.

Record-Backspace—Performs the 5250 Record-Backspace function.
Record-Macro—Starts recording a macro.
Record-QuickScript—Starts recording a Quick Script.
Remove—Presses the VT Remove key.

Replace-Shortcuts—Searches the current screen and replaces all
shortcut text when the Manual mode of the shortcuts function is selected.



Reset—Unlocks the 3270 keyboard.
Reset-Type-Ahead—Clears the Type Ahead buffer.
Restore-Cursor-Position—Restores the saved cursor position.

Resume-Recording-Macro—Resumes recording a macro after a
recording pause.

Resume-Recording-QuickScript—Resumes recording a Quick Script after
a recording pause.

Return—Presses the Return key.

Right—Moves the cursor right one column.
Roll-Down—Presses the 5250 Roll Down action key.
Roll-Up—Presses the 5250 Roll Up action key.

Run—Runs a program. Can only be used in a Quick-Key.
Run-Macro—Runs the script specified.
Save-Cursor-Position—Saves the cursor position.
Save-Screen—Immediately saves the screen to disk.
Scroll-Bottom—Scrolls to bottom of Scrollback buffer.
Scroll-Down-1—Scrolls down 1 line.
Scroll-Page-Up—Scrolls up 1 page.
Scroll-Page-Down—Scrolls down 1 page.
Scroll-Top—Scrolls to top of Scrollback buffer.
Scroll-Up-1—Scrolls up 1 line.

Select—Presses the VT Select key.
Select-Extend—Extends the current selection using the mouse.
Select-Extend-Down—Extends the selection down 1 line
Select-Extend-Left—Extends the selection left 1 column.
Select-Extend-Right—Extends the selection right 1 column.

Select-Extend-Up—Extends the selection up 1 line.



Select-Line—Selects the current line (at the pointer location).
Select-Word—Selects the current word (at the pointer location)
Select-Word-Enter—Selects the current word and press Enter.
Select-Word-Left—Extends the selection to include the previous word.
Select-Word-Right—Extends the selection to include the following word.
Send-Answerback-Msg—Sends the Answerback message.
Send-Line—Sends the Send Line AID to the host system.
Send-Message—Sends the Send Message AID to the host system.
Send-Screen—Sends the current screen to a mail recipient.

Shift-F1 to F20—Presses the VT Shifted function key.
Shift-Num-Pad-xxx—Presses the VT shift numpad key.

Show-Clipboard—Displays the Windows clipboard and any data copied
to it.

Show-Demo-File—Opens a demo file (Quick-Keys only).

Show-Track-Menu—Opens the Track Menu at the current mouse pointer
location.

Space-EOF—Replaces all characters to the end of the current field with
spaces.

Space-Field—Replaces all characters in the current field with spaces.

Start-Session—Starts a new terminal session. For more information, see
Quick-Key System Commands.

Stop-QuickScript—Stops an executing Quick Script.
Stop-Recording-QuickScript—Stops recording a Quick Script.
System-Request—Performs the 3270 or 5250 System Request function.
Subscript—Allows subscripts to be entered (VT only).
Substitute—Enters the 3270 substitute character.

Superscript—Allows superscripts to be entered (VT only).



Tab—Moves the cursor to the next unprotected field.
Telnet-Abort-Output—Sends telnet Abort Output command.
Telnet-Are-You-There—Sends telnet, "Are You There?" command.
Telnet-Break—Sends telnet Break command.
Telnet-Interrupt-Process—Sends telnet Interrupt Process command.
Telnet-Erase-Character—Sends telnet Erase Character command.
Telnet-Erase-Current-Line—Sends telnet Erase Current Line command.
Testreq—Presses the Test Request key.
Toggle-APL-Keyboard—Switches APL input mode On and Off.
Toggle-Attribute—Switches Show Attributes mode On and Off.
Toggle-Auto-Print—Switches the VT Auto Print mode On and Off.
Toggle-Capture—Switches the Capture option On and Off.
Toggle-Connection—Switches the connection status.

Toggle-CrossHair-Cursor—Switches the vertical and horizontal
crosshairs On and Off.

Toggle-Cursor—Toggles the cursor type.
Toggle-Entry-Assist—Switches Entry Assist Mode On and Off.
Toggle-Event—Toggles the event.
Toggle-Full-Screen—Toggles full screen mode.
Toggle-Insert—Switches Insert Mode On and Off.
Toggle-Line-Draw—Toggles line-drawing mode.
Toggle-Message—Toggles the OlA type (3151 only).

Toggle-Recording-Pause—Switches the macro recording between
Paused/Record.

Toggle-Row-And-Column-Indicator—Displays or hides the row and
column indicator in the OIA.

Toggle-Scrollback—Switches the Scrollback buffer.



Toggle-Tracing—Switches stack level tracing On and Off.
Toggle-View-Hotspots—Toggles the view hotspots mode.

Toggle-VT-CursorKey-Mode—Switches the Cursor Key mode setting
between Application and Normal. (VT only)

Toggle-VT-KeypadKey-Mode—Switches the Keypad mode setting
between Application and Numeric. (VT only)

Toggle-Word-Wrap—Switches Word Wrap Mode.
Up—Moves the cursor up one row.
VT-Send-Null—Sends a null byte (0x00) to the host.
Word-Left—Moves the cursor left one word.

Word-Right—Moves the cursor right one word.

Related Topics

User Environment Customization
Menu Customization

Toolbar Customization




Customize Menus Dialog Box—Scheme Tab
3270 5250 VT
To access

You can use the Scheme tab on the Menus dialog box to create, select,
and manage menu schemes.

Scheme—Specifies the menu scheme to customize or apply. Select a
scheme from the drop-down list.

New—Opens the New Scheme dialog box, which lets you enter a name
for a new menu scheme and choose to use the default menu
configuration as a basis for the custom menu that you want to create.

Note: Use the Customize tab on the Customize Menus dialog box to add functions to the new menu.

Save As—Lets you save a copy of the customized menu scheme with a
different name.

Rename—Opens the Rename Scheme dialog box, which lets you enter
a new name for an existing menu scheme.

Delete—Deletes the selected menu scheme.

Reset—Restores default settings to the selected menu scheme in the
Scheme list.

Apply—Saves any changes to the selected menu scheme and applies
this scheme to the active session window.

Related Topics

Menu Customization

Creating Menu Schemes

Customize Menus Dialog Box—Customize Tab
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Customize Menus Dialog Box—Customize Tab
3270 5250 VT

To access

You can use the Customize tab to add or delete menu functions to a
menu scheme. You can also rename menus and create new submenus
using the context menu.

Menus—Displays the default settings of the selected menu scheme. You
can modify the scheme by selecting an option in the context menu, or
you can drag and drop functions to the selected scheme.

Function Group—Selects the type of action the new menu item
performs (for example, System Commands).

Function—Selects the function the new menu item performs.

Selected Function Description—Describes the currently selected
function.

Apply—Saves any changes to the selected menu scheme and applies
this scheme to the active session window.

Related Topics

Customize Menus Dialog Box—Scheme Tab
Creating Menu Schemes

HostExplorer Functions
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Customize Toolbars Dialog Box—Scheme Tab
3270 5250 VT

To access

Use the Scheme tab to create, manage, and modify toolbar schemes.
You can also create new toolbar configurations and you can enable one
or more toolbars to display in the session window.

Scheme—Lists available toolbar schemes. Select an existing scheme (if
available) for the current session.

Save Scheme As—Saves all the toolbars in the Toolbars list as a
scheme.

Delete Scheme—Deletes the selected scheme.

Toolbars—Lists existing toolbar configurations. In this list, you can
enable toolbars that you want to display in the session window.

New—Opens the New Toolbar dialog box, where you can enter a name
for a new toolbar configuration and choose to use the default toolbar
configuration as a basis for the custom toolbar that you want to create.

Note: The Functions tab on the Customize Toolbars dialog box lets you add functions to the new
toolbar.

Rename—Lets you rename an existing toolbar.
Delete—Deletes the selected toolbar.

Reset—Resets the toolbar configuration to the default settings.

Related Topics

Toolbar Customization
Tools Menu

New Toolbar Dialog Box
Rename Toolbar Dialog Box
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New Scheme Dialog Box
3270 5250 VT
To access

The New Scheme dialog box lets you create a scheme for the session
window.

Name—Specifies a name for the new scheme. The default name is
Custom #.

Start with Defaults—Uses the default configuration as a basis for the
custom scheme that you want to create.

Related Topics

Revising the Session Window with Customized Schemes
Creating Menu Schemes

Customize Menus Dialog Box—Scheme Tab

Customize Session Properties Dialog Box—Scheme Tab
Rename Scheme Dialog Box
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Customize Toolbars Dialog Box—Options Tab
3270 5250 VT

To access
Use the Options tab to customize the toolbar button and toggle ToolTip
visibility.
Show ToolTips On Toolbars—Lets you enable or disable ToolTips,

which display when you hover the cursor over a toolbar button. By
default, this option is selected.

Large Icons—Displays toolbar buttons in a larger format.

User Customized Image File—Lets you browse to the image file that
you want to use for the selected toolbar button.

Apply—Applies the changes you have made to the toolbar to the active
session window.

Related Topics

Toolbar Customization

New Scheme Dialog Box

Customize Toolbars Dialog Box—Functions Tab
Customize Toolbars Dialog Box—Scheme Tab
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Edit Caption Dialog Box
3270 5250 VT
To access

The Edit Caption dialog box lets you edit toolbar button captions (also
known as ToolTips).

Name—Specifies a new caption for the toolbar button.

Related Topics
Customize Toolbars Dialog Box—QOptions Tab
Maodifying the Button Caption
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Connection Folder—Microsoft SNA Server

Category
3270

In the Microsoft SNA Server category, you can set the general connection
parameter that HostExplorer uses to connect to a host through a
Microsoft SNA Server gateway.

LU or Pool Name—Type the logical unit (LU) name to use for the host
connection. You can type the individual LU name or the name of an LU
pool. The LU contains the necessary configuration information needed to
connect to a host. The LU name can contain up to eight characters, must
start with a letter, and cannot contain any spaces.

This option is visible but dimmed when you connect to a session. To be
able to set this options, you must disconnect from the session and
access the Session Profile dialog box again.

Related Topics

Connection Folder—LU Category

Connection Folder—Microsoft SNA Server Category
Configuring a Microsoft SNA Server Connection




Connection Folder—Netware for SAA Category
3270

In the Netware for SAA category, you can set the general connection
parameter that HostExplorer uses to connect to host through a Novell
Netware for SAA gateway.

Session Name (NDS)—Type the name of the Novell Directory Services
(NDS) configuration record for this session. You can create NDS
configuration records using Netware Administrator for Windows
(NWADMIN or NWADMIN32). HostExplorer supports connections to
Netware for SAA 3.0 and higher running on NetWare 4.0 and higher.
HostExplorer does not support Bindery-based authentication.

This option is visible but dimmed when you connect to a session. To be
able to set this options, you must disconnect from the session and
access the Session Profile dialog box again.

Related Topics
Connection Folder—Other Category
Novell NetWare for SAA




Connection Folder—3270 Advanced Category
3270

In the Advanced category, you can set advanced connection parameters
for connecting to a TN3270 host.
TN3270 Specific—These options are valid only for non-TN3270E hosts.

Enable SYSREQ Key as IAC IP—Enables the SYSREQ Key as
the Telnet IAC IP sequence. This option is valid only for various
non-TN3270E hosts. By default, this option is cleared.

Attention Key Type—Select the sequence of bytes transmitted to
the host upon pressing the Attention key. Each option provides
different sequences so try the one that works best with your host.
The default sequence is IAC BRK (*).

Note: The Attention Key is valid only when connected to SNA hosts.

Telnet—These options are valid for Telnet connections.

Send Keep Alive Packets—Sends a message to the host to
confirm that the session is still alive after a period of inactivity
longer than the Keep Alive Timeout value.

None—Does not send a Keep Alive packet. This is the default
value.

System—Uses the Windows TCP/IP stack Keep Alive interval.

Send NOP Packets— Sends a No Operation packet (NOP)
after the Keep Alive Timeout value is reached.

Send Timing Mark Packets—Sends a Timing Mark packet
after the Keep Alive Timeout value is reached.

Keep Alive Timeout—Specifies the time interval in minutes to



send the Keep Alive packet to the host. This option is only
available when the Send NOP Packets or the Send Timing Mark

Packets option is selected. The default Keep Alive value is 30
minutes.

Related Topics

User Environment Customization

Host Connections from the Desktop
Configuring a Microsoft SNA Server Connection




Connection Folder—5250 Advanced Category
5250

In the Advanced category, you can set advanced connection parameters
for connecting to a TN5250 host.

Device Name—Type a name (of a maximum of 10 characters) that
defines the terminal device that HostExplorer will use when connecting to
an AS/400 machine. This option is visible but dimmed when you are
connected to a session. To access this option, disconnect from the
session, and then reopen the Session Profile dialog box.

Note: 5250 device names cannot start with a digit, exceed 10 characters, contain spaces, or contain
any of the following characters:
CUIN & <S[{Y% =, ~1A() 02
If you enter a device name, the host either uses an existing device with
the specified name or, depending on the system settings, creates a new
device using the new name. If you leave the box blank, the host
automatically defines a device name for the current session.

Note: If the host setting for Auto Device Name is disabled, a session must have an explicit device
name in order to establish a connection.

You can use replacement variables to configure the device name for the
5250 connection. If you change a replacement variable, the change

affects the current session. When you close the session, the modified
configuration is saved to the session profile.

View the complete list of variables »

Only one session can use a specific device name at a time. HostExplorer
uses the “%+”" replacer to provide a mechanism, called Collision Avoiding
ID (CAID), for avoiding device name collisions (for example, when two
sessions attempt to connect to the host using the same device name).

More about CAID »
Auto Sign On—Lets you type an AS/400 user ID and password that will

be used to automatically log on to the host, allowing you to bypass the
sign-on screen when a connection to the host is established.

User ID—This box is enabled only when you select the Auto Sign
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On check box. Type an AS/400 user ID. Providing a valid user ID
allows HostExplorer to negotiate with the host to automatically
validate you as a user and bypass the sign-on screen. If you leave
this field blank, HostExplorer will not negotiate with the host and
the sign-on screen will appear when a connection is established.
This screen will prompt you to enter a user ID and password to
access the system.

Password—This box is enabled only when you select the Auto
Sign On check box. This box is enabled only when you select the
Auto Sign On check box. Type an AS/400 password. Providing a
valid password allows HostExplorer to negotiate with the host to
automatically validate you as a user and bypass the sign-on
screen.

Send Keep Alive Packets—Sends a message to the host to confirm that
the session is still alive after a period of inactivity longer than the Keep
Alive Timeout value.

None—Does not send a Keep Alive packet. This is the default
value.

System—Uses the Windows TCP/IP stack Keep Alive interval.

Send NOP Packets— Sends a No Operation packet (NOP) after
the Keep Alive Timeout value is reached.

Send Timing Mark Packets—Sends a Timing Mark packet after
the Keep Alive Timeout value is reached.

Keep Alive Timeout—Specifies the time interval in minutes to send the
Keep Alive packet to the host. This option is only available when the
Send NOP Packets or the Send Timing Mark Packets option is selected.
The default Keep Alive value is 30 minutes.

Related Topics



User Environment Customization

Connection Folder—TN5250 Category
Connection Folder—5250 Advanced Category
Connection Folder—NVT Category
Connection Folder—Other Category




Connection Folder—Telnet Advanced Category
VT

In the Advanced category, you can set advanced connection parameters
for connecting to a Telnet host.

Note: These options are visible but dimmed when you connect to a session. To be able to set these

options, you must disconnect from the session and access the Session Profile dialog box again.
Linemode—Select how and/or whether HostExplorer stores characters
in a buffer until you send a carriage return to the host. When enabled,
Linemode forces HostEXxplorer to send characters one line at a time
rather than as individual characters.

Note: Linemode is useful when trying to reduce costs on networks that charge per packet, or when
dealing with long network delays.

Don't Do Linemode—Disables Linemode. By default, this option
Is selected.

Always—Enables Linemode continuously.

During Local Echo—Enables Linemode when the host tells
HostExplorer to do the echoing.

When Not in SGA—Enables Linemode when the host does not
Suppress Go Ahead (SGA).

Local Echo or Not SGA—Enables Linemode when the host tells
HostExplorer to do the echoing or when the host does not
Suppress Go Ahead (SGA).

Automatic (RFC Compliant)—Linemode is enabled automatically
by the host.

Telnet Echo—Determines how HostExplorer will respond to remote echo
negotiation with a Telnet host.

No—HostExplorer negotiates remote echo with the host and



responds without echo.

Yes—HostExplorer negotiates local echo with the host and
responds with echo.

Automatic—HostExplorer uses Host Commands negotiating the
remote echo. By default, this option is selected.

Initiate Option Negotiation—Determines whether HostExplorer
negotiates connection options upon establishing a Telnet connection. By
default, this option is selected.

Note: Clearing this option may increase the connection speed to certain hosts.

Set Host Window Size—Determines whether HostExplorer sends a
change in the number of rows or columns to the Telnet host. By default,
this option is selected.

Note: This option is useful when using UNIX editors (Jove, VI, and Emacs) because it lets the host
adjust control of the cursor in the event that the window size changes.

Send Keep Alive Packets—Sends a message to the host to confirm that
the session is still alive after a period of inactivity longer than the Keep
Alive Timeout value.

None—Does not send a Keep Alive packet. This is the default
value.

System—Uses the Windows TCP/IP stack Keep Alive interval.

Send NOP Packets— Sends a No Operation packet (NOP) after
the Keep Alive Timeout value is reached.

Send Timing Mark Packets—Sends a Timing Mark packet after
the Keep Alive Timeout value is reached.

Keep Alive Timeout—Specifies the time interval in minutes to send the
Keep Alive packet to the host. This option is only available when the
Send NOP Packets or the Send Timing Mark Packets option is selected.



The default Keep Alive value is 30 minutes.

Related Topics

User Environment Customization

Terminal Folder—Size Category
Connection Folder—Other Category
Connection Folder—Secure Shell Category




Connection Folder—NVT Category
3270 5250

In the NVT category, you can set options that determine how
HostExplorer interprets the Enter key and Backspace keys, as well as
how HostExplorer stores characters in the buffer.

Enter Key Interpretation—Determines whether pressing the Enter key
will send a Carriage-Return (CR) or Carriage-Return Linefeed (CR-LF)
sequence command to the host.

Carriage Return and Linefeed—Sends a CR-LF sequence
command to the host when you press the Enter key. A CR-LF
seguence command refers to sending a blank line to the host and
then positioning the cursor at the beginning of the next line. By
default, this option is selected.

Carriage Return—Sends a CR sequence command to the host
when you press the Enter key. A CR sequence command refers to
positioning the cursor at the beginning of the next line.

Backspace Key Interpretation—Determines whether pressing the
Backspace key will send a true Backspace character or the Delete
character command to the host.

Delete—Sends a Delete character to the host upon pressing the
Backspace key. This involves moving the cursor back one
character and deleting that character. By default, this option is
selected.

Backspace—Sends a true Backspace character to the host when
you press the Backspace key. This involves moving the cursor
back one character without deleting that character.

Keyboard Buffer Mode—Determines how HostExplorer stores
characters in a buffer until they are sent to the host.



Character Mode—Forces HostExplorer to send each character
immediately to the host. By default, this option is selected.

Line Mode—Forces HostExplorer to send characters one line at a
time until you press the Enter key. This is useful when trying to
reduce costs on networks that charge per packet, or when dealing
with long network delays.

Related Topics

Connection Folder—TN3270 Category
Connection Folder—TN5250 Category
Connection Folder—3270 Advanced Category
Connection Folder—5250 Advanced Category
Connection Folder—Other Category
Connection Folder—Secure Shell Category




Connection Folder—Secure Shell Category
VT

In the Secure Shell category, you can:

. Set connection parameters by specifying a tunnel profile.

. Override the specified tunnel’s connection settings for the
HostExplorer session profile.

Tunnel Profile—Specifies the tunnel profile that you want to use for the
connection.

Browse Tunnel Profiles button—Opens the Open Tunnel dialog box,
which lets you browse for a Tunnel profile to use for the connection.

Edit this Tunnel Profile button—Opens the Tunnel Profile -
ProfileName dialog box, which lets you edit the properties of the selected
tunnel profile.

Create a New Tunnel Profile button—Opens the Add New Tunnel
dialog box, which lets you create a new tunnel profile.

Reload button—Resets the connection parameters as specified in the
selected profile.

Host Name, Port, User Name—Specifies the authentication connection
settings.

Authentication—Lists authentication methods available for the session
profile.

Authentication Settings—Opens the Authentication Settings dialog box,
which lets you select or change the priority of authentication methods for
the session profile.

Enable X11 Port Forwarding—Instructs the SSHD server on the remote
host to allow X11 forwarding through the Secure Shell tunnel. The X11
client applications within the HostExplorer session are tunnelled back to
the workstation.

Related Topics
Creating a Session Profile




Connecting to a Host
Overview—Connectivity Secure Shell




Connection Folder—LU Category
3270

TN3270 Enhanced Protocol—These options are valid only for TN3270E
hosts.

Use TN3270E When Supported—Determines whether
HostExplorer connects to a host using the TN3270E protocol. By
default, this option is selected.

Note: Clear this option if you are experiencing problems connecting to a host.

LU Name—Lets you enter multiple LU names that are available
for a host. (The LU contains the necessary information needed to
connect to an SNA network.) When connecting, HostExplorer tries
each LU name in the list (starting at the top) until it finds one that
Is not in use. If all the names in the list are in use, the connection
Is refused.

This option is only available if the host supports TN 3270E
enhanced protocol.

Note: The LU name can contain up to 32 characters, must start with a letter, and
cannot contain any spaces.

Add New LU name—Opens the Add New LU Name dialog box,
which lets you specify or select an LU name to add to the list.

Edit LU name—Opens the Edit New LU Name dialog box, which
lets you edit the selected LU name.

Delete LU name—Deletes the selected name.
Delete All LU names—Deletes all the names in the list.

Copy LU name—Copies the selected name to the clipboard.



Paste LU name—Pastes the copied name to the list.

Move Up LU name/Move Down LU name—Changes the position
of the selected name. HostExplorer checks for the name at the top
of the list first.

Express Logon Feature (ELF)—The Express Logon Feature lets a 3270
user play a macro that securely logs the user on to a host application
without the transmission of a host user ID and password. The host
session must be configured for SSL with client authentication in order to
use the Express Logon Feature. For more information, see Automating
Login Using the Express Logon Feature.

A sample Express Logon Macro for TSO (ExpressLogonTS0.ebs)is
installed in your Macro folder. You may need to edit the macro and
change the logon string for your application ID (APPLID).

Application ID—Enter the Application ID that the host server uses to
identify the application. Ask your host system administrator for this ID.

Related Topics

Automating Login Using the Express Logon Feature
Connection Folder—Microsoft SNA Server Category
Connection Folder—Microsoft SNA Server Category




Security Folder—General Category
3270 5250 VT

In the General category, you can set general security options.

Security Options—Select a method for securing your session between
the server and client.

No Security—There is no security of traffic between the server
and the client.

SSL ITLS—Encrypts all traffic between the server and the client
on 3270, 5250 and VT terminals. For this option to be active, you
must not be connected to a session.

Kerberos (3270 and VT only)—Provides authentication and
encrypts all traffic between the server and the client. For this
option to be active, you must not be connected to a session.

Related Topics

User Environment Customization

Initiating SSL/TLS Connectivity

Security Folder—SSL/TLS Category
Overview—Hummingbird Connectivity Kerberos
Security Folder—Kerberos Category




Security Folder—Kerberos Category
3270 VT

In the Kerberos category, you can set security options specific to
Kerberos. You must first select Kerberos in the General category of the
Security folder and you must not currently be connected to a session.

Kerberos Version—Select the version of the Kerberos server to use for
the current session.

Version 4—Uses Version 4.

Version 5—Uses Version 5. This version supports forwardable,
renewable, and postdatable tickets.

Common Kerberos Options—Configures options that are common to
Kerberos Version 4 and Kerberos Version 5.

Authentication—Determines whether HostExplorer initiates
negotiation for Kerberos authentication.

Encryption—Determines whether HostExplorer initiates
negotiation for a Data Encryption Standard (DES) encrypted
session.

Kerberos Client—Specifies Hummingbird Connectivity Kerberos
or MIT Kerberos to generate credentials for the user and the
remote service.

Import Windows Tickets—Imports Kerberos tickets (for Kerberos
client authentication) from the Microsoft ticket store to the
Kerberos ticket store.

Kerberos 5 Options—Configures options that are specific to Kerberos
Version 5.

Forwarding—Enables ticket forwarding. Each ticket contains the



IP address of the client. With forwarding enabled on a ticket, you
can use the ticket to request a new ticket but with a different IP
address. Therefore, you can apply your current credentials to
another machine.

Alternate User Name—Sends authentication to the Kerberos
realm as the specified alternate user.

Related Topics

User Environment Customization

Security Folder—General Category
Overview—Hummingbird Connectivity Kerberos
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Terminal Folder—3270 Category
3270

In the 3270 category, you can set general terminal options.

Note: These options (except for Detect Chained 1/0O) are visible but dimmed when you connect to a
session. To be able to set these options, you must disconnect from the session and access the
Session Profile dialog box again.

3270 Type—Select the 3270 model type to use for the next session.
3278—HostExplorer supports basic 3270 features.

3279—HostExplorer supports Extended Attributes. By default, this
option is selected.

3270 Model—Select the model of mainframe terminal you want
HostExplorer to emulate during the next session. If the following models
can not provide you with the proper dimensions, select Custom, then
enter the proper Row and Column values.

Model 2—HostExplorer uses 24 lines by 80 columns for the next
session. By default, this option is selected.

Model 3—HostExplorer uses 32 lines by 80 columns for the next
session.

Model 4—HostExplorer uses 43 lines by 80 columns for the next
session.

Model 5—HostExplorer uses 27 lines by 132 columns for the next
session.

Custom—Enables the Rows and the Columns boxes.
Rows (20 to 72)—Enter the number of rows to use for the

screen for the next session. You can enter a number between
20 and 72.



Columns (80 to 200)—Enter the number of columns to use for
the next session. You can enter a number between 80 and 200.



Other Options

Enable Extended Attributes—Determines whether HostExplorer
enables Extended Attributes when you have selected 3279 as the 3270
Type. Extended Attributes are the mainframe application codes used to
display various colors, highlighting, reverse images, and blinking.
HostExplorer enables Extended Attributes by sending "IBM-327-x-y-E"
as the IBM terminal type in place of "IBM-327-x-y". This lets your PC
fully emulate the mainframe screen. By default, this option is selected.

Note: If you clear this option, HostExplorer may disable Extended Attributes. Consequently,

HostExplorer may also disable some of the replies sent for the Read Partition Query command.
Send OEM Reply to RPQ—Determines whether HostExplorer sends an
OEM reply field back to the host in response to receiving a Read Partition
Query. If sent, the OEM reply would contain information about the
terminal session and features available for the host to use. By default,
this option is cleared.

Warning! Note: Clear this option if you experience difficulty starting GDDM, SAS, or other mainframe
application.

Force Alternate Size—Changes the window to the alternate size in the
event that the host receives an Erase Write command. By default, this
option is cleared.

Note: Select this option if you want the screen to always open in the alternate (larger) screen size.

Detect Chained I/O—Determines whether HostExplorer enables the
automatic detection of chained Write/Read commands. By default, this
option is selected.

Related Topics
User Environment Customization




Terminal Folder—5250 Category
5250

In the 5250 category, you can set general terminal options.
5250 Model—Select the 5250 model type to use for the next session.

Note: This option is visible but dimmed when you connect to a session. To be able to set this option,
you must disconnect from the session and access the Session Profile dialog box again.

Model 2—Indicates to HostExplorer to use 24 lines by 80 columns
for the next session.

Model 5—Indicates to HostExplorer to use 27 lines by 132
columns for the next session. By default, this option is selected.



Other Options

Color Display—Determines whether HostExplorer uses 5250 color
mapping for Color Attributes. By default, this option is selected.

Note: Clear this option if you want the 5250 terminal to display green and white colors only.

Related Topics
User Environment Customization




Terminal Folder—VT Category
VT

In the VT category, you can set general terminal options.

Terminal Model—Lets you select the terminal model to use for the
current session. This option is dimmed when you are connected to a
session. To change your terminal model, you must be disconnected from
the host.

Note: Use VT320 or VT420 only if you have proper termcap entries on your host system. Use SCO

Ansi when connecting to SCO UNIX systems. Use Linux Console when connecting to Linux
systems.

Terminal ID—Specifies the terminal ID or Device Attribute (DA) response
HostExplorer sends to the host. The Device Attribute contains the control
sequences that define the terminal and its configuration and identifies the
particular type of terminal to the host.

Note: If you select Linux Console as the terminal model, the Terminal ID is automatically set to VT
102.

Communication Mode—Determines the communication mode that
HostExplorer will use to connect to the host system.

7 Bit—Transfers all data using 7-bit bytes. By default, this option is
selected.

8 Bit—Supports 7-bit and 8-bit data formats.



Other Options

Always Allow 8-Bit Data—Determines whether HostExplorer supports
8-bit data transfers even when NRC support is enabled. Usually the high-
order bit of incoming data is stripped when NRC is enabled. By default,
this option is cleared.

Related Topics
User Environment Customization




Terminal Folder—Graphics Category
3270
In the Graphics category, you can set general graphic options.

Graphics Model—Select the graphics terminal model to use during the
next session.

No Graphics—HostExplorer does not support graphics. With this
option selected, HostExplorer will only display text.

3179G or 3192G—HostExplorer displays the IBM 3179G or
3192G graphics terminal model.

3472G—HostExplorer displays the IBM 3479G graphics terminal
model.

3270PCG—HostExplorer displays the IBM 3270PCG graphics
terminal model. By default, this option is selected.

Graphics Cursor Appearance—Determines how the cursor will appear
in the terminal window.

Small Cross, White—Displays the cursor as a small, white cross.
By default, this option is selected.

Large Cross, White—Displays the cursor as a large white cross.
Small Cross, Green—Displays the cursor as a small green cross.
Large Cross, Green—Displays the cursor as a large green cross.

Character Cell Size—Select the cell size when HostExplorer reports a
fixed coordinate space to the host. Since several host applications are
cell-size sensitive, be sure to select the appropriate size.

Automatic—Select this option to display the highest-quality



graphics. If you have problems using this option, you may have to
select a specific cell size. When this option is selected,
HostExplorer reports a Presentation Space size equal to the actual
window size. Use this option if you have a maximized or large
window to yield higher quality graphic images. By default, this
option is selected.

9x12—Select this option if you are using an application written for
3279 S3G, 3179G/3192G (32x80).

9x16—Select this option if you are using an application written for
3179G/3192G (24X80) and 3472G (32x80).

9x21—Select this option if you are using an application written for
3472G (24x80) and Japanese 3270PC.

13x22—Select this option if you want to use a new size.

13x29—Select this option is you are using an application written
for Japanese 3270PC.

Support Program Symbols—Determines whether HostExplorer
supports Program symbols. Also referred to as Graphic Symbol Sets,
HostExplorer treats these symbols as individual bitmaps. By default, this
option is selected.

Note: Symbols that appear in the text layer are known as Program symbols and are used as
customizable text.

Support Lightpen—You can use the keyboard and/or mouse to emulate
lightpen functionality — a light-sensitive device that lets you select screen
fields. By default, this option is selected.

Support APL—Determines whether HostExplorer supports A
Programming Language (APL). By default, this option is selected.

Related Topics
User Environment Customization




TN3270 Host Graphic Configuration




Terminal Folder—Advanced Category
VT

You can use the Advanced category to set advanced terminal options:



General Options

Auto Wrap—Determines whether HostExplorer automatically wraps text
around the screen. Text wrapping occurs when the terminal attempts to
display a character beyond the last column of the emulator. By default,
this option is cleared.

Note: If this option is cleared, data sent beyond the last column is lost and does not displayed in the
terminal window.

Local Echo—Determines whether HostExplorer enables local echo of

characters typed in the emulator. This option is also referred to as

Keyboard Echo.

Terminal is Online—Used to type and move the cursor around the
screen without sending data to the host. By default, this option is
selected.

Note: Clear this option if you want to take the terminal off-line.
Control Codes—Determines whether HostExplorer acts upon control
codes or displays them using a special character set.

Interpret—Used to act upon, or interpret, all CO/C1 control
characters. By default, this option is selected.

Display—Select this option if you are trying to debug a host data
stream.

Scrolling and Display—Choose a scrolling and display mode.

Optimized—Indicates to HostExplorer to perform 'bulk’ updates to
the screen. Typically, the emulator performs bulk updates at the
end of a data stream. By default, this option is selected.

Realistic - Normal—Indicates to HostExplorer to update the
screen as it receives new characters. Although this is a much
slower option, it allows for smoother scrolling.

Realistic - Smooth—Indicates to HostExplorer to scroll one pixel



at a time, so that the line at the top of the screen slowly
disappears.

Pixels—In the Pixels box, type the number of pixels (between 1
and 99) that you want HostExplorer to scroll at a time.

Answerback Message—Enter an Answerback message. You can use
special character sequences when entering text in this field.

Note: The Pixel box is available when you select one of the realistic display options.
Conceal—Conceals the Answerback string in this dialog box after

you type the string in the above box. By default, this option is
cleared.

Related Topics
User Environment Customization




Terminal Folder—3270 and 5250 Character Set

Category
3270 5250

You can use the Character Set category to change the host code page
used to display data received from the host. Since mainframe systems
and midrange systems (AS/400) support many host languages, you must
select the correct translation table (host code page) to display host data
properly.

Note: HostExplorer supports all the languages in the list regardless of the version or language of your
client PC.

Host Code Page—Select the host code page that will be used to display
data received from the host.

Related Topics
User Environment Customization
Changing the Language




Terminal Folder—VT Character Set Category
VT

You can use the Character Set category to set general terminal options:

UPS Set—Sets the Host Character Set (User Preferred Supplemental
Character Set).

NRC Set—Sets the National Replacement Character (NRC) set, used by
7-bit operating systems. Each NRC set replaces specific characters
within the ASCII set with characters that the selected language set uses.

Use NRC Set (7 bit)—Forces the NRC set in 7-bit mode regardless of
the parity of the host. The host can reset this option automatically if it
sends the DECNRCM control sequence.

Related Topics
User Environment Customization
Changing Character Sets




Terminal Folder—Size Category
VT

You can use the Size category to set the general size options for the VT
terminal.

Default Screen Width—Specify the default screen width HostExplorer
will use upon launching a new session.

80 Columns—Indicates to HostExplorer to use 80 columns as the
default screen width upon launching a new session. By default,
this option is selected.

132 Columns—Indicates to HostExplorer to use 132 columns as
the default screen width upon launching a new session.

Custom—Type a number between 20 and 300. HostExplorer will
use the number you enter as the default screen width upon
launching a new session.

Default Screen Height—Specify the default screen height HostExplorer
will use upon launching a new session. You can type any number
between 10 and 200. By default, the screen height is 24.

Related Topics
User Environment Customization
Modifying Screen Dimensions




Terminal Folder—API Category
3270 5250 VT

You can use the API category to set the session identifier used by
HLLAPI applications.

Session Short Name—Enter the identifier that HLLAPI applications use
to access a particular session.

Related Topics
User Environment Customization
Session Window Folder—General Category




Display Folder—5250 General Category
5250

In the General category, you can set general display options for the 5250
terminal.

Display Nulls—Determines whether HostExplorer displays Null
characters located in unprotected fields as centered dots. This option is a
display feature only and does not affect how HostExplorer sends data to
the host system. By default, this option is cleared.

Display Blink as Italic—Maps the Blink Attribute to Italicized font so that
blinking text becomes non-blinking and italicized. This option provides an
alternative way of differentiating between blinking and non-blinking text.
By default, this option is cleared.

Note: This option is independent of the Cursor Mode.

Display All Upper Case—Determines whether HostExplorer displays all
output in uppercase. By default, this option is cleared.



OIA Options

Display Row/Col Indicator—Determines whether HostExplorer displays
the Row and Column Indicator in the right-hand corner of the Operator
Information Area (OIA). By default, this option is selected.

OIA Line Mode—Select the type of OIA. Select whether you want
HostExplorer to display the Terminal Style OIA Line, the Windows Style
OIA Status Bar, 5250 Terminal Style Status Line, or no status line at all.
By default, the Windows Style OIA Status Bar option is selected.

Display in OIA—Select whether you want HostExplorer to display the
host IP address or the host response time in the OIA. By default, the Host
IP Address option is selected.

Column Separator Style—Select the 5250 column separators. None
indicates to HostExplorer not to display separators between characters of
fields with the Column Separator host attribute. Dots indicates to
HostExplorer to display column separators as dots on the terminal
window. By default, this option is selected. Lines indicates to
HostExplorer to display column separators as lines on the terminal
window.

Related Topics
User Environment Customization




Display Folder—Cursor Category
3270 5250 VT

In the Cursor category, you can set general cursor options.
Cursor Type—Select the cursor type to use for the current session.

Vertical Bar—Displays the cursor as a vertical line.
Underscore—Displays the cursor as an underscore.

Block—Displays the cursor as a block. By default, this option is
selected.

Cursor Mode—Select the cursor mode to use for the current session.

Solid—Displays the cursor as a solid character.

Blink—Displays the cursor as blinking characters. By default, this
option is selected.



Other Options

Display Cross-hair Cursor—Displays the cursor as a cross-hair cursor,
which consists of two "cross-hair" lines that span across the screen and
intersect at the cursor. By default, this option is cleared.

Shape Change On Insert (3270 and 5250 only)—Lets you use the
Insert button as a toggle to change the shape of the cursor.

Move Cursor On Mouse Click (VT only)—When using a full-screen text
editor such as VI Editor, lets you move the cursor to a specific location by
clicking the mouse.

Related Topics
User Environment Customization
Modifying the Cursor




Color Folder—General Category
3270 5250 VT

You can use the General category to set general color options.

Scheme—Select the color scheme to use for the current session. You
can enter the name of a new color scheme or select an existing scheme
from the drop-down list.

Note: When you create a scheme, be sure to click Save to save it.

Save As—Lets you enter and save a new color scheme.
Delete—Deletes an existing color scheme.

Screen Element List—Select a screen element and view the currently
associated color in the Sample Color bar. The available screen elements
may vary according to the specific host.

Note: To change a color, select either Foreground or Background, then select a new color from the

color blocks located at the bottom of the dialog box. HostExplorer automatically updates any
changes you make to the Sample Color bar.



Selected Color Item

Reflects the background and foreground color associated with the
highlighted screen element. Click OK to automatically update any
changes you make.

Foreground Color—Changes the foreground color of the item you have
selected from the Screen Element list.

Background Color—Changes the background color of the item you
have selected from the Screen Element list.

Uniform—Sets the foreground or background colors of all the
screen elements.

Note: This option is useful if you need to provide a consistent color for all the host
screen elements.

Apply—Implements the changes you have made to the current color
scheme.

Advanced/Basic (3270 and 5250)—Click to alternate between basic
color mode and advanced color mode. The list of Screen Elements in the
drop-down lists varies between Basic and Advanced mode. In basic color
mode, you can change the basic field types and the seven extended
colors.

In advanced mode, you can change the color for any specific field type
such as the Unprotected Alphanumeric Non-Display.

Note: Making changes within the Advanced mode without fully understanding TN3270 fields or
TN5250 attributes can cause display problems.

MonoChrome—Changes all the color selections to monochrome
settings.

Note: This option is useful when using a laptop with a monochrome LCD.
Reset—Restores the original settings for the selected Screen Elements.
Reset All—Restores the original settings for all the Screen Elements.

Reset Color—Restores the Foreground and Background colors to the
original settings.




Related Topics
User Environment Customization
Modifying Session Component Colors




Color Folder—Palette Category
3270 5250 VT

In the Palette category, you can change the color mix for the 16 system
color blocks. The sample block displays the current color. All changes
update automatically. This feature affects all sessions.

System Colors—Select the color block. Once you have selected a color
block, HostExplorer displays the current color in the Sample Color Bar.

Note: To change a system color, modify the red, green, and blue color mixes located at the bottom of
the dialog box.

Sample Color bar—Displays the current system color. Any changes you

make to a system color automatically updates the Sample Color bar.

Color Mix—Creates a customized color for any of the 16 system color
blocks listed at the top of the dialog box. HostExplorer automatically
updates any changes you make to the Sample Color bar.

Red—Changes the percentage of red in the selected system color
block. HostExplorer automatically updates any changes you make
to the Sample Color bar.

Green—Changes the percentage of green in the selected system
color block. HostExplorer automatically updates any changes you
make to the Sample Color bar.

Blue—Changes the percentage of blue in the selected system
color block. HostExplorer automatically updates any changes you
make to the Sample Color bar.

Reset All—Restores the original settings for all the system colors.

Reset Color—Resets the selected system color to its original setting.

Related Topics
User Environment Customization
Modifying Session Component Colors




Fonts Folder—General Category
3270 5250 VT

In the General category, you can set general font options.

Scheme—Lists the schemes available for use in the current session. You
can enter the name of a new scheme or select an existing scheme from

the list.

Save Scheme—Opens the Save Scheme As dialog box, which lets you
enter a name (or change the name of) a scheme.



Choose the Display Font

Select Font—Opens the Session Font dialog box, which lets you choose
the display font.

Related Topics

Session Font Dialog Box

User Environment Customization

Modifying Font Attributes

Assigning a Windows Bitmap Pattern

Eliminating the Border between Window and Screen




Keyboard Folder—General Category
3270 5250 VT

In the Keyboard category, you can customize keyboard options.

Keymap—Select a keyboard map to use for the current session. You can
select a different keyboard map by selecting it from the list.

PC Keyboard Type—Select the type of keyboard to use for the current
session.

Note: Select Enhanced-104 Keys if you are using a modern or relatively modern keyboard. Only
European or older keyboard may prove incompatible. By default, this option is selected.

Keyboard Mapping—Opens the Keyboard Map dialog box. You can use

this dialog box to remap keys on the keyboard to create a customized
keyboard map.

Note: To save any changes to a new or current map, click Save when you finish remapping the
keyboard. If you do not click Save, changes you make are lost when you end the session.

Ignore NumLock State—Determines whether you want to retain the use
of the numeric keypad, regardless of the NumLock mode. By default, this
option is selected.

Allow Mapping of /, *, -, +, Keys in NumLock—Maps the /, *, -, and +
key while in NumLock mode. By default, this option is cleared.

Automatic Diacritic Composition (3270 and 5250 only)—Determines
whether HostExplorer supports the composition of accented and/or
special characters. By default, this option is cleared.

Note: When attempting to compose an accented character, HostExplorer displays the diacritic symbol
in the status bar located in the bottom of the terminal screen. When this option is disabled,
HostExplorer can not compose accented and special characters correctly unless you have
remapped the keyboard to include these characters.

Allow Repeating AID keys (3270 and 5250 only)—Determines whether
HostExplorer can send multiple Function Key commands to the host

without having to lift and press the Function key again. By default, this
option is cleared.

Lock Keyboard on Attention Key (3270 only)—Locks the terminal
keyboard when you press the Attention Key. By default, this option is
cleared.



Note: The keyboard is unlocked upon receiving an unlock command from the host.

Type Ahead (3270 and 5250 only)—You can continue typing even when
the keyboard is locked. HostExplorer does this by buffering typed
characters. By default, this option is selected. This option is available
only for TN3270 and TN5250 sessions.

Timeout Value (msecs) (3270 and 5250 only)—Type the number of
milliseconds HostExplorer will wait for a host response before aborting
the attempt and clearing the Type Ahead keyboard queue. By default,
this option is set to 0 which means infinite timeout. This option is
available only for TN3270 and TN5250 sessions.

Related Topics
User Environment Customization
Keyboard Folder—Device Category

Remapping Keys
Enabling a Keyboard File




Keyboard Folder—Advanced Category
3270 5250

In the Advanced Keyboard category, you can customize advanced
keyboard options for the 3270 and 5250 terminal.

Ctrl/Alt Processing—Determines whether an action that is mapped to a
specific key is performed when you press or when you release the key.

Process on Key Down—Citrl activates when the key is pressed. If
Ctrl or Alt are mapped, they cannot act as modifiers. Ctrl and Alt
auto-repeat if the key is held down. Other keys activate on press.

Process on Key Up—When selected, the Ctrl or Alt key is
processed when the key is released. This lets the Ctrl and Alt keys
to act as modifiers even when Ctrl and Alt are mapped
independently. Mapped Crtl and Alt keys do not auto-repeat when
held down. Other keys are processed when the key is pressed.

Related Topics
User Environment Customization




Keyboard Folder—Advanced Category
VT

In the Advanced Keyboard category, you can customize advanced
keyboard options for the VT terminal.

Ctrl/Alt Processing—Determines whether an action that is mapped to a
specific key is performed when you press or when you release the key.

Process on Key Down—Citrl activates when the key is pressed. If
Ctrl or Alt are mapped, they cannot act as modifiers. Ctrl and Alt
auto-repeat if the key is held down. Other keys activate on press.

Process on Key Up—When selected, the Ctrl or Alt key is
processed when the key is released. This lets the Ctrl and Alt keys
to act as modifiers even when Ctrl and Alt are mapped
independently. Mapped Crtl and Alt keys do not auto-repeat when
held down. Other keys are processed when the key is pressed.

Shortcuts—Enables shortcut functions for the VT terminal session.

Standard File and Edit Menu Shortcuts—Lets you use standard
File and Edit menu shortcuts for certain terminal functions. By
default, this option is cleared. »

Hold Screen Shortcuts—Enables the user to start and stop the
processing of data from the host. By default, this option is
selected. »

Related Topics
User Environment Customization
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Keyboard Folder—Device Category
VT

In the Keyboard Device category, you can customize keyboard device
options for the VT terminal.

Enter Key Mode—Determines whether pressing the Enter key will send
a Carriage-Return (CR) or Carriage-Return Linefeed (CR-LF) sequence
command to the host.

CR—Sends a CR sequence command to the host when you press
the Enter Key. By default, this option is selected.

CR-LF—Sends a CR-LF sequence command to the host when
you press the Enter Key.

Backspace Key Mode—Determines whether pressing the Backspace
key will send a true Backspace character or the Delete character
command to the host.

True Backspace—Sends a true Backspace character to the host
when you press the Backspace key. By default, this option is
selected.

Del—Sends a Delete character to the host upon pressing the
Backspace key.

Cursor Key Mode—Determines the cursor key mode. The Cursor Key
Mode affects the sequences HostExplorer sends to the host.

Normal—Sets the cursor key mode to Normal. By default, this
option is selected.

Application—Sets the cursor key mode to Application.

Keypad Mode—Determines the default Keypad Mode. The Keypad
Mode affects the sequences HostExplorer sends to the host.



Numeric—Indicates to HostExplorer to send numeric sequences
to the host. By default, this option is selected.

Application—Indicates to HostExplorer to send application
seguences to the host.

Enable Break—Enables the Break key to send a break signal to the
host. By default, this option is selected.

Related Topics
User Environment Customization




Hotspots Folder—General Category
3270 5250 VT

In the General category, you can specify the type of hotspot that you
want to enable or disable on the host screen.

Enable Hotspots—Enables or disables the display of hotspots on the
host screen.

Hotspot Style—This list is enabled only when you select the Enable
Hotspots check box. Lets you specify hotspots to display.

Invisible—The hotspot text or region appears in its regular
display, not highlighted; but when you place your cursor over the
hotspot, a hand appears which indicates it is a hotspot.

Highlighted Text—Text hotspots appear highlighted. Region
hotspots appear in the regular display.

Raised Button—The hotspot text or region appears in a three-
dimensional button display. By default, this option is selected.

Mouse Activation—Specify how the hotspot will be activated using the
mouse.

Left Single Click—Lets you activate the hotspot with a single click
of the left mouse button. By default, this option is selected.

Left Double Click—Lets you activate the hotspot with a double
click of the left mouse button.

Related Topics

User Environment Customization
Overview—Hotspots

Hotspots Folder—Assignments Category




Hotspots Folder—Assignments Category
3270 5250 VT

In the Assignments category, you can create, modify, and delete
hotspots.

Note: All the buttons in the dialog box have an associated keyboard shortcut. #

Scheme—Select the hotspot scheme to use for the current session. You
can enter the name of a new hotspot scheme or select an existing
scheme from the list.

Note: When you create a scheme, be sure to click Save to save it.
Save Scheme As—Saves a hotspot scheme.

Delete Scheme—Deletes an existing hotspot scheme. This button is
available only after you specify a scheme in the Scheme list.

Add New Hotspot—Opens the Properties dialog box which lets you add
hotspot entries.

Edit Hotspot Info—Opens the Edit Host dialog box which displays the
hotspot properties for the item selected in the hotspot list. This button is
available only after you add a hotspot to the Hotspot list.

Delete—Deletes the hotspot entry selected in the Hotspot list.
Delete All—Deletes all hotspots from the Hotspot list.
Copy—Copies the hotspot entry to the clipboard.
Paste—Pastes the hotspot entry to the Hotspot list.

Move Up/Move Down—Moves the selected item up or down a row.
These buttons are available only after you have added two or more
hotspots to the Hotspot list.

Show Hotspot Tips—Specifies that the hotspot tip (that you typed in the
Hotspot Text box of the Properties dialog box) will appear as a ToolTip
when you place your cursor over the hotspot in a session. By default, this
option is selected.

Related Topics
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User Environment Customization
Hotspots Folder—General Category
Overview—Hotspots

Properties Dialog Box

Properties Page (Edit Hotspot Dialog Box)
Action Page (Edit Hotspot Dialog Box)




Edit Folder—General Category (3270)
3270

In the General category, you can set general editing options for 3270
terminals.

Automatic Keyboard Unlock—Instructs HostExplorer to unlock the
keyboard after a user keyboard error (for example, attempting to enter
data in a protected area of the screen) and to ignore the invalid
keystroke. By default, this option is selected.

Multiline Delete Mode—Defines how the Delete and Backspace keys
remove characters. When this option is enabled, the Delete and
Backspace keys remove characters and shift all remaining characters
from the cursor position to the end of the field, even if the field spans
multiple lines. When disabled, the Delete and Backspace keys remove
characters and shift all remaining text from the cursor position to the end
of the current line, even if the field spans multiple lines. Real terminals do
not delete characters beyond the end of the current line. By default, this
option is cleared.

Multiline Insert Mode—Defines how the Insert key inserts characters.
When enabled, the Insert key inserts characters and shifts remaining
characters in the field toward the end of the field, even if the field spans
multiple lines. When disabled, the Insert key inserts characters and shifts
remaining characters in the field to the end of the current line, even if the
field spans multiple lines. Real terminals do not delete characters beyond
the end of the current line. By default, this option is selected.

3278 Style Insert—Determines when the Insert Key is toggled selected.
By default, this option is selected. When selected, the Insert key remains
selected until you press any Action key such as Enter, Pfx, Pax, or Clear.

Note: Clear this option if you want HostExplorer to use 3277 Style Insert. When cleared, the Insert key
remains toggled selected until you press the Reset Key.

Convert Nulls to Blanks—Automatically converts in-stream nulls to
blanks. In the IBM-3174 Establishment Controller Functional Description

Manual, this option is referred to as Null Space Processing. Selecting this
option eliminates the need to use an editing feature, such as NULLS



OFF, to prevent data from collapsing to the left-hand column. By default,
this option is cleared.

Note: Selecting this item when using the TSO command line may cause problems. This is due to the
TSO main screen design.

Respect Numeric Fields—Determines whether HostExplorer forces
data entry validation on numeric fields. Select this option if you want
HostExplorer to permit only numeric and special values within numeric
fields. By default, this option is cleared.

Always Autoskip—Select this option if you want the cursor, upon
reaching the end of the field, to skip to the next available input field. If you
clear this option, when you type, the cursor continues until it reaches a
protected field on the screen. By default, this option is cleared.

Note: You can produce the same behaviour by leaving Always Autoskip disabled and enabling Tab on
Protected Field Input.

Smart Insert—Select this option if you want to insert characters in a field
that contains nulls and/or spaces at the end. When this option is cleared,
you can insert characters in a field that contains only nulls at the end. By
default, this option is selected.

Tab on Protected Field Input—Forces the cursor to automatically tab to
the next input field if you attempt to input when the cursor is in a
protected field. By default, this option is cleared.

Related Topics
User Environment Customization
Edit Folder—Copy, Cut and Paste Category




Edit Folder—General Category (5250)

5250

In the General category, you can set general editing options for 5250
terminals.

Keyboard Unlock—Lets you select a response to an invalid keystroke.

Manual—The user must press the Reset key to unlock the
keyboard after an invalid keystroke generates an error. A message
or Error ID displays on the message line indicating the reason for
locking the keyboard. By default, this option is selected.

Automatic—Instructs HostExplorer to unlock the keyboard after a
user keyboard error (for example, attempting to enter data in a
protected area of the screen). A message or Error ID displays on
the message line indicating the reason the keyboard is locked.

The next keystroke forces HostExplorer to restore the message
line to its original text and to resume processing keyboard input. If
the cursor is not in an input field, the next keystroke moves the
cursor to the next input field before the keystroke is processed.

This option generates a Keyboard Locked event. It is
recommended that you activate a sound alarm for invalid
keystrokes.

Automatic (do not show errors)—An invalid keystroke does not
generate an error. If the cursor is in an input field, the keystroke is
ignored. If the cursor is not in an input field, HostExplorer moves it
to the next input field and the keystroke is attempted again.

This option generates an OIA Go Elsewhere event. It is
recommended that you activate a sound alarm for invalid
keystrokes.



Note: For more information, see Events Available for Sound Mapping.

Multiline Delete Mode—Defines how the Delete and Backspace keys
remove characters. When this option is enabled, the Delete and
Backspace keys remove characters and shift all remaining characters
from the cursor position to the end of the field, even if the field spans
multiple lines. When disabled, the Delete and Backspace keys remove
characters and shift all remaining text from the cursor position to the end
of the current line, even if the field spans multiple lines. Real terminals do
not delete characters beyond the end of the current line. By default, this
option is cleared.

Multiline Insert Mode—Defines how the Insert key inserts characters.
When enabled, the Insert key inserts characters and shifts remaining
characters in the field toward the end of the field, even if the field spans
multiple lines. When disabled, the Insert key inserts characters and shifts
remaining characters in the field to the end of the current line, even if the
field spans multiple lines. Real terminals do not delete characters beyond
the end of the current line. By default, this option is selected.

Preserve Entry Mode—Lets you enter multiple hexadecimal values
without having to reset the Hex Entry Mode by pressing the Hex key. If
this option is not enabled, and you want to enter multiple hexadecimal
values, you must press the Hex key after each entry.

Related Topics
User Environment Customization
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Edit Folder—Clipboard Formats Category
3270 5250 VT

In the Clipboard Formats category, you can set clipboard formats used by
HostExplorer. If you encounter problems copying data to other
applications or pasting data from other applications, you can enable or
disable specific clipboard formats.

Text/OEM Text—Enables the standard text format for Clipboard use. By
default, this option is selected.

Bitmap—Enables Bitmap format when copying data to the clipboard. By
default, this option is selected.

Paste Link—Enables the Paste Link format when copying data to the
clipboard. By default, this option is selected.

Rich Text Format—Enables the Rich Text Format when copying data to
the clipboard. By default, this option is selected.

HostExplorer 3270 (proprietary format)—Enables HostExplorer's
Proprietary format when copying data from one HostExplorer session to
another. By default, this option is selected.

Cell Delimited—Enables CSV and BIFF formats when copying data to
the clipboard and pasting data from other applications. CSV and BIFF are
common formats used by spreadsheet applications. When copying data
to the clipboard in Cell Delimited format, HostExplorer can parse screen
data at words or at field attributes. This allows you to determine how data
appears in cells in your spreadsheet application. By default, this option is
selected.

Related Topics
User Environment Customization




Edit Folder—Tabs Category
VT
In the Tabs category, you can set tab stops.

Tab Stops—Determines the location of the tab stop(s). When you set tab
stops, you can enter a numeric value, or click an area on the screen.

Set—Select the number of Tab stops.

Every 8'th—Sets the tab stops to every 8th position starting with column
9.

Clear—Clears the current tab stop.
Clear All—Clears all the tab stops.

Related Topics
User Environment Customization
Setting Tab Stops




Print Folder—Print Screen Advanced Category
3270 5250 VT

In the Print Screen Advanced category, you can set advanced print
screen options.

Document Name—Specifies the document name.

Header/Footer—Specifies the information you want to appear in the
printed document header and/or footer (up to 80 characters). You can
use replacement variables to configure the text that displays in the
document. If you change a replacement variable, the change affects the
current session. When you close the session, the modified configuration
is saved to the session profile.

View the complete list of variables »

Display Abort Dialog While Printing—Displays the Abort dialog box
while printing. By default, this option is cleared.

Display Print Screen Dialog When Job Starts—Displays the Print
Screen dialog box when job starts. By default, this option is cleared.

Print Reversed Colors—Prints reverse color modes. By default, this
option is selected.

Note: When selected, this option forces the print engine to swap black and white colors while printing
images. Clear this option if you want the print engine to print the image exactly as it appears on
the screen.

Force B&W Print—Forces black and white printing on color printers by
automatically converting colors to gray scale. By default, this option is
cleared.

Host Screens per Page—After specifying the multiple host screens that
you want to print using the Print Multiple Screens dialog box, you can
select the number of host screens that you want to print on one page.

Related Topics
User Environment Customization
Print Multiple Screens Dialog Box
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Print Folder—Print Screen Advanced Category




Print Folder—PCPRINT Category
3270

In the PCPRINT category, you can set PCPRINT options.

7171 Passthru Printing—HostExplorer supports 7171 passthru
sequences for use with the TPRINT host printing program available (at
no charge) from Yale University. When HostExplorer receives the 7171
passthru commands, it will search for escape sequences to
enable/disable the printer port. This option specifies what sequences the
emulator will search for in passthru mode.

Send PCPRINT/TPRINT Output to—Specify where HostExplorer will put
information received from a host TPRINT or PCPRINT program.

Default Windows Printer—Sends the output to the Default
Printer in the control panel.

LPT1—Sends the output to a printer connected to a LPT1 parallel
port. If the parallel port is captured by a network system, the data
will be sent to the network printer.

LPT2—Sends the output to a printer connected to a LPT2 parallel
port. If the parallel port is captured by a network system, the data
will be sent to the network printer.

LPT3—Sends the output to a printer connected to a LPT3 parallel
port. If the parallel port is captured by a network system, the data
will be sent to the network printer.

Clipboard—Sends the output directly to the Windows clipboard.

Printer Initialization String—Defines the escape sequences that you
can send to the printer at the beginning of a PCPRINT/TPRINT job. The
string may contain up to 255 characters.

Printer Deinitialization String—Defines the escape sequences that you



can send to the printer at the end of a PCPRINT/TPRINT job. The string
can contain up to 255 characters. You can enter Escape and binary
codes in C-style syntax using the backslash character (\). HostExplorer
treats Inline spaces as part of the sequence.

Related Topics
Special Characters
User Environment Customization




Print Folder—Host Printing Category
VT

In the Host Printing category, you can set general printer options relating
to the host computer.

Print Destination—Specify where you want the host print output to be
sent to.

Print to Default Printer—Sends the output to the printer that you
have specified as the default printer. When you select this option,
the rest of the page is disabled.

Print to Selected Printer—Sends the output to the printer
specified in the Selected Printer Info area.

Print to File—Sends the output to the file specified in the File
Options area.

Selected Printer Info—Displays the path to and name of the current
printer. This area is enabled only when you select Print to Select Printer
in the Print Destination list.

Select Printer—Select the printer to use for VT Passthru printing.

File Options—Specify options for the file that will contain the print
output. This area is enabled only when you select Print to File in the Print
Destination list.

File Name—Type the path to and name of the file which will
receive the host print job.

Write Mode—Specify how the print job will be sent to the file
specified in the File Name box.

. Overwrite Existing File—HostExplorer deletes the existing file
specified in the File Name box by overwriting it with the new
print job information.



. Append to Existing File—HostExplorer adds the new print job
to the end of the existing file specified in the File Name box.

. Auto-generate Numeric Suffix—HostExplorer generates a
new file for the print job by adding a numeric suffix to the end of
the file name. For example, if you specified "abc. txt", the file
name, HostExplorer generates the following file:

"abcOO1. txt".

Related Topics
User Environment Customization




Print Folder—Host Printing Advanced Category
VT

In the Host Printing category, you can set advanced printer options
relating to the host computer.

Formatting—Specifies how the print output will be formatted.

Bypass Windows Print Driver—Sends all print data from the
host directly to the printer as it is received (not translated). When
you clear this option, all data is translated and processed by the
HostExplorer print engine. This lets you select the page format in
the Page Setup dialog box accessible by clicking the Layout
button.

Disable Printer Translation—Disables translation of host data
from the host code page to the Windows code page. This option is
available only when you clear the Bypass Windows Print Driver
option.

Auto Formfeed—Automatically adds a formfeed to the end of the
print job.

Expand LineFeed—When Passthru printing is enabled by the
host, this option expands all line feed characters to Carriage-
Return Linefeed. When you clear this option, line feed characters
are not expanded.

Layout—This button is active only when you clear the Bypass
Windows Print Driver option. Opens the Page Setup dialog box
which lets you modify the page settings and specify a font for the
print output.

Printer Control—Specifies the string that will be sent to the printer for
passthru printing.



Printer Initialization String—Sends the Initialization strings to the
printer for passthru printing. The string defines the escape
sequences that can be sent to the printer at the beginning of a
print job, and can contain up to 255 characters. You can enter
Escape and binary codes using C-style syntax using the backslash
character (\). Inline spaces are treated as part of the sequence.

Printer Deinitialization String—Sends the Deinitialization strings
to the printer for passthru printing. The string defines the escape
seguences that can be sent to the printer at the end of a print job,
and can contain up to 255 characters. You can enter Escape and
binary codes using C-style syntax using the backslash character
(\). Inline spaces are treated as part of the sequence.

Options—Specifies the timeout options for the printer.

Enable Timeout—Enables the timeout specified in the Printer
Timeout (in seconds) box. By default, this option is cleared.

Printer Timeout (in seconds)—Specifies the delay before the
printer outputs a page.

Related Topics
User Environment Customization
Special Characters




File Transfer Folder—3270 General Category
3270

In the General category, you can set general file transfer options. You can
select transfer files from the disk or directly from the Clipboard.

Scheme—Select the file transfer scheme to use for the current session.
You can enter the name of a new file transfer scheme or select an
existing scheme from the drop-down list.

Note: When you create a scheme, be sure to click Save to save it.

Save As—Lets you enter and save a new file transfer scheme.
Delete—Deletes an existing file transfer scheme.

Initial Action—Determines the action HostExplorer will perform before
initiating a file upload or download.

No Action—Prevents HostExplorer from performing an action
before it transfers a file. By default, this option is selected.

Press Home Key—HostExplorer sends a Home Key command to
the host before transferring a file.

Press Enter Key—HostExplorer sends an Enter Key or Carriage
Return command to the host before transferring a file. Select this
option if you want HostExplorer to send an action key command,
wait for the keyboard to unlock, wait ¥2 second, then start the file
transfer.

Press Clear Key—HostExplorer sends a Clear Key command to
the host before transferring a file.

Host System—Select the operating system run by the host.

CMS—Uploads files to a host that is running CMS. By default, this
option is selected.



TSO/MUSIC—Uploads files to a host that is running TSO/MUSIC.
CICS—Uploads files to a host that us running CICS.

Block Size—Specifies the block size HostExplorer will use for file
transfers. You can select a block size between 256 and 32768 bytes. By
default, this option is set to 2048.

Note: For better performance, use the largest block size your system can handle.

File Transfer Program Name—Specifies the name of the Host file
transfer program to use when uploading and/or downloading files.

Default Download Directory—Specifies the default download directory.
Default Upload Directory—Specifies the default upload directory.

Clear Monitor Automatically—Determines whether HostExplorer
automatically exits the File Transfer Monitor upon completing a file
transfer. By default, this option is cleared.

Related Topics
User Environment Customization




File Transfer Folder—VT General Category
VT

In the General category, you can set general file transfer options.
Default Protocol—Select the default file transfer protocol.

Action on File Exist—Determines how the PC receives the file. For
example, you might receive a file called text2. txt from a host system
but already have a file called text2. txt on your local disk. You have
the following options:

Overwrite—QOverwrites the current file with the new file.

Rename—Renames the new file being received, leaving the
existing file unchanged. For example, it changes the name of the
incoming file from text2.txt to text2(1).txt.

Skip—Transfers all the files except for those already existing.

Default Receive Directory—Select the default directory for received
files.

Show Receive Dialog—Determines how the Receive File from host
command in the Transfer menu behaves. When you enable this option,
the Receive File dialog box will open when each time you receive a file. If
you disable this option, the file transfer starts automatically when Receive
File from host is selected from the menu. In this case, you must have
previously selected a Default Receive Directory and a Default protocol
(see above) for the transfer to complete properly.

Clear Monitor Automatically—Determines whether HostExplorer
automatically exits the File Transfer Monitor upon completing a file
transfer. By default, this option is cleared.

Related Topics
User Environment Customization




File Transfer Folder—Custom Category
3270
In the Custom category, you can set advanced file transfer options.

Scheme—Lets you enter the name of a new file transfer scheme or
select an existing scheme from the drop-down list.

Save As—Lets you save the file transfer scheme.

Delete—Deletes the selected file transfer scheme.



General Options
Select general transfer options.

ASCIll—Translates an ASCII (PC character set) file to an EBCDIC (IBM
host character set) file.

CRLF—Translates Carriage-Return Linefeed (CR-LF) end-of-line
characters to records on the host file system. This option is normally
required when transferring text files.

APPEND—Appends the file to an existing file on the host.

Convert CC—Converts host carriage control to PC carriage control. This
option is available only for downloads.



Upload Options
File Format—Select general upload options.

LRECL—Sets the logical record size for the file that you send to
the host.

BLKSIZE—Sets the block size for the file that you send to a host.
This option is valid only for MVS.

Record Format—Select general recording options.

Default—Indicates to the host portion of the file transfer to use the
default record format.

Fixed —Uploads the file to a fixed record format file.

Variable—Uploads the file to a Variable Record Format file. Use
the variable record format if you are transferring a binary file (such
as a program file, EXE, COM, DLL, and so on) and you want to
preserve the exact file size.



Custom Options

Custom Options—Specifies other operating system-specific options that
are not directly supported by this dialog box. You must specify custom
options in the appropriate format for the specific operating system. You
can not edit these parameters. HostExplorer appends these parameters
directly to the file transfer command.

Related Topics
User Environment Customization




File Transfer Folder—Code Pages Category
3270

In the Code Pages category, you can set general file transfer options.

Scheme—Lets you enter the name of a new file transfer scheme or
select an existing scheme from the drop-down list.

Save As—Lets you save the file transfer scheme.
Delete—Deletes the selected file transfer scheme.

PC Code Page—Specifies the code page that will be transferred to the
current "display" code page specified in the Character Set category of the
Terminal Folder.

Custom Transfer Table—This box is active only when you select
Custom in the PC Code Page list. Specify the path to and name of the
custom transfer table that you already created. This custom table defines
the translation of data between the PC and the host. »

Related Topics
User Environment Customization
Terminal Folder—3270 and 5250 Character Set Category




File Transfer Folder—XModem Category
VT

In the XModem category, you can set general file transfer options.

16 bit CRC—Enables CRC to aid in error detection. Clear this option to
change the error detection to Checksum. You should only use Checksum
when communicating with older XMODEM products.

1024 bytes Packets—Indicates the data packet size. Clearing this option
changes the setting to 128 bytes. You should normally use 1024 bytes as
it is faster. You may find the 128-byte setting useful if you have a
communication problem such as a noisy telephone line.



Send Options

ACK Timeout—Specifies the length of time in milliseconds before the file
transfer times out. Transfer delays are common, however, if a delay

becomes too long, HostExplorer will abort the transfer allowing you to try
again later.

Related Topics
User Environment Customization




File Transfer Folder—YModem Category
VT

In the YModem category, you can set general file transfer options.

Use Full Path Name to/from Host—Saves the file to the current UNIX
host directory and lets you keep the entire path name as the filename.
For example, the filename, myplan. txt, with this option selected,

might have a file name of:
c:\projects\myplan. txt



Send Options

ACK Timeout—Indicates the timeout value in milliseconds (ms). In the
course of transferring files between two computers, there are small
transmission delays, which are quite normal. However, if this delay
becomes too long, then HostExplorer assumes that the communication
line has been cut, and aborts the transfer process. When you set the
time-out value, you indicate to HostExplorer how long it should wait
before aborting.

Related Topics
User Environment Customization




File Transfer Folder—Kermit Category
VT

In the Kermit category, you can set general file transfer options.

Use Full Path Name to/from Host—Saves the file to the current UNIX
host directory and lets you keep the entire path name as the filename.
For example, the filename, myplan. txt, with this option selected,

might have a filename of
c:\projects\myplan. txt

Text Mode—Strips the upper bit of each byte as it is received and
prevents the saving of any non-ASCII characters.

RLE Compression—Improves file transfer efficiency by compressing
data in the Run Length Encoding (RLE) method. This option is enabled
by default.



Send Options

Binary Prefix—Kermit attempts to send 8-bit data characters over a 7-bit
channel by prefixing non-printable characters (Binary Prefix).

Related Topics
User Environment Customization




File Transfer Folder—ZModem Category
VT

In the ZModem category, you can set general file transfer options.

Use Full Path Name to/from Host—Saves the file to the current UNIX
host directory and lets you keep the entire path name as the filename.
For example, the filename, myplan. txt, with this option selected, might

have a filename of:
c:\projects\myplan. txt

Maximum Error Count—Determines how many error recoveries
HostExplorer will attempt before aborting the file transfer.



Send Options

Sliding Window—Sends all the files at once. Depending on the
receiver’'s communication layer, the receiver may or may not be able to
handle this high-speed transfer. In this case, check the sliding window
option. By default, HostExplorer sends 8192 bytes at a time giving the
receiver enough time to receive the data and acknowledge its reception.
However, if the sender’s TCP/IP stack cannot handle this high-speed
transfer, clear this option.

Overwrite Management Options—Determines how files are written to
the host system; for this feature to function properly, the receiving host
system must also support this feature. For example, you might send a file
called text2. txt to a host system already containing a file called
text2.txt. You have the following options.

Newer or Longer—Only overwrites if the existing file is older or
smaller than the file being sent.

Append—Adds the file you are sending to the end of the existing
file.

Always Overwrite—Always overwrites the old file.

File Size or Date Differ—Only overwrites if the existing file being
sent is a different size and/or newer.

Never Overwrite—Prevents you from overwriting an existing file.

Newer—Only overwrites if the existing file is older than the file
being sent.



Receive Options

Crash Recovery—Sets the system to automatically resume reception of
any transferred files if the system crashed during the transfer.

Auto Download—Detects the initial header of a request to receive files
and automatically starts the receiving process.

Enable Session Lockout—Enables the session lockout option, which
locks a session if it is left idle for a period of time. By default, this option is
selected.

Use Default Session Lockout Time—Uses the default session
lockout time (30 minutes). By default, this option is selected.

Lockout Session After The Following Number Of Idle Minutes
—Specifies a session lockout time. This option is available if the
default is not selected.

Related Topics

User Environment Customization

Specifying Text for the Title Bar

Terminal Folder—API Category

Removing the Save Profile on Window Close Function




Session Window Folder—Workspace Category
5250 VT

In the Workspace category, you can set options for the workspace of the
session terminal. The workspace is the background area of the entire
session window.

Show Workspace—Applies a border around the edges of the workspace
(that is, the area that you see between the session window and the
terminal screen) using the color specified in the Background Color
palette. By default, this option is cleared.

Show Bitmap in Workspace—Applies an image as a border around the
edges of the workspace. By default, this option is cleared.

Bitmap File—Specifies the bitmap file you want to apply as the
border. Click the Browse button to search for one.

Workspace Color—Choose workspace colors.

Foreground Color—Specifies the workspace text color.

Background Color—Specifies the workspace background color.

Apply—Applies the changes without closing the dialog box.

Related Topics
User Environment Customization
Assigning a Windows Bitmap Pattern




Session Window Folder—Window Sizing

Category
32705250 VT

In the Window Sizing category, you can set options for the size of the
terminal window.

Keep Font Aspect Ratio—Forces HostExplorer to keep all fonts within a
normal aspect ratio. Selecting this option lets HostExplorer better match
the fonts with the current window size. Clearing this option lets
HostExplorer create extra wide or extra tall fonts. By default, this option is
selected.

Force Exact Window Terminal Size—Eliminates the border between
the window and the screen, forcing the session frame to fit the terminal
size when the window is resized.

When Switching Modes—Determines how HostExplorer handles model
changes initiated by the host.

Keep Font Size Constant—Indicates to HostExplorer to keep the
font size constant when the host resizes the screen.

Keep Screen Size Constant—Indicates to HostExplorer to select
another font within given parameters (if the current font is not
available) when the host resizes the screen. By default, this option
Is selected. The Force Exact Terminal Window Size option
overrides the Keep Screen Size Constant option.

Keep Modes Independent—Select the window position and font
type independently. HostExplorer retains the settings you specify
for each model.

Resize Behavior—Determines how the host displays the information
upon resizing the session window.

Change Font Size—When you resize the window, HostExplorer
changes the size of the font to allow the same number of rows and



columns to be displayed in the resized window. By default, this
option is selected.

Windows Default—When you resize the window, HostExplorer
retains the font size and the number of rows and columns, and
introduces scroll bars if required.

Change Terminal Size (VT only)—This option is valid only for
Telnet hosts that support the NAWS (Negotiate About Window
Size) option which allows HostExplorer to specify a window size to
the Telnet server. After you resize the screen (either manually or
modifying the Default Screen Width option in the Size category of
the Terminal folder), HostExplorer sends a change in the number
of maximum rows and columns to the Telnet host, but the font size
does not change. If the host does not support the NAWS feature,
the new screen size information is not transmitted to the server.

Related Topics
User Environment Customization
Assigning a Windows Bitmap Pattern




Toolbar Folder—General Category
3270 5250 VT

In the Toolbar category, you can select a toolbar scheme to use for the
current session. You can also delete a scheme permanently.

Scheme—Lists available toolbar schemes. Select an existing scheme for
the current session. To create a new scheme, click Customize Toolbars
on the Tools menu.

Save Scheme As—Lets you enter a new name for the scheme. If you
want to rename a scheme, enter a new name and then delete the original
from the list. You can also save a copy of the scheme with a different
name.

Delete Scheme—Deletes the selected scheme permanently.

Related Topics

Customize Toolbars Dialog Box—Scheme Tab

Creating and Moving Toolbars

Revising the Session Window with Customized Schemes




Menu Folder—General Category
3270 5250 VT

In the Menu category, you can select a menu scheme to use for the
current session. You can also delete a scheme permanently.

Scheme—Lists available menu schemes. Select an existing scheme for
the current session. To create a new scheme, click Customize Menus on
the Tools menu.

Save Scheme As—Lets you enter a new name for the scheme. If you
want to rename a scheme, enter a new name and then delete the original
from the list. You can also save a copy of the scheme with a different
name.

Delete Scheme—Deletes the selected scheme permanently.

Related Topics

Customize Menus Dialog Box—Scheme Tab

Creating Menu Schemes

Revising the Session Window with Customized Schemes




Sound Folder—General Category
3270 5250 VT

In the General category, you can set sound options for the terminal.

Sound Enabled—Enables sounds in HostExplorer. The default setting is
selected.

Scheme—Lists available sound schemes. Select an existing scheme
from the list.

Note: If the list box is empty, you can create new schemes by mapping events to sounds, and then
clicking Save Scheme As.

Save Scheme As—Opens the Save Scheme As dialog box, which lets
you enter a name for the scheme, or select a name from the list of saved
sound schemes.

Delete Scheme—Deletes an existing scheme. This button is available
only after you select a scheme in the Scheme list.

Events—Displays a list of HostExplorer events available for sound
mapping. Select an event from the list to map to a sound. =

Sound—Displays a list of Windows Media Wave files. You can select a
sound file or browse to one. Select None to clear an event’s sound

mapping.
Play Wave File—Lets you hear the selected sound file.

Related Topics
User Environment Customization
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Events Folder—General Category
3270 5250 VT

In the General category, you can enable or disable the events that you
have programmed.

Enable Events—Lets you enable or disable programmed events.

Related Topics

User Environment Customization
Overview—Events

Enabling Events

Events Folder—Assignments Category




Events Folder—Assignments Category
32705250 VT

In the Assignments category, you can create, modify, and delete events.

Note: All the buttons in the dialog box have an associated keyboard shortcut. #

Scheme—Lists the event schemes available for use in the current
session. You can enter the name of a new event scheme or select an
existing scheme from the list.

Note: When you create a scheme, be sure to click Save to save it.
Save Scheme As—Saves an event scheme.

Delete Scheme—Deletes an existing event scheme. This button is
available only after you have saved an event scheme.

Events—oLists the events contained in the specified scheme.

Event Type—Specifies the type of programmed event.

Action—Specifies the action that the programmed event will
trigger.

Add New Event—Opens the Add New Event dialog box which lets you
create events.

Edit Event Info—Opens the Edit Event Info dialog box which displays
the event properties for the item selected in the Events list. This button is
available only after you add an event to the Events list.

Delete—Removes the event selected in the Events list.
Delete All—Removes all of the events from the Events list.
Copy—Copies the properties of the selected event.
Paste—Pastes the copied event to the Events list.

Move Up/Move Down—Moves the selected item up or down a row.
These buttons are available only when you have added two or more
events to the Events list.
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Related Topics

User Environment Customization
Events Folder—General Category
Overview—Events

Add New Event Dialog Box

Edit Event Info Dialog Box




Track Menu Folder—General Category
3270 5250 VT

In the General category, you can define the functions in a Track Menu.
This menu can provide quick access to frequently used session functions
(menu options; action, editing and shortcut keys; and unique characters).
You can configure the Track Menu to execute commands specific to a
session.

Scheme—Lists the schemes available for use in the current session. You
can enter the name of a new scheme or select an existing scheme from
the list.

Save Scheme—Opens the Save Scheme As dialog box, which lets you
enter a name (or change the name of) a scheme.

Track Menu—Displays the Track Menu labels and functions.

Note: You can move, delete, or append a Label or Function by using the available dialog box buttons
and drop-down lists. When finished, click OK to close the dialog box, then press Ctrl+Shift+right
mouse click to view the modified Track menu.

Function Group—Select a Function Group to display the functions
available for assigning to a Track Menu.

Note: Changing the Function Group automatically changes the options listed in the Function drop-
down list.

Function—Select a Function to assign to the Track Menu.

Note: If you cannot locate the function you want to assign to the Mouse Action, try changing the
Function Group. This changes the list of available Functions.

Move Up/Move Down—Moves the selected item up or down a row.
Reset All—Restores the original settings for the entire Track Menu.
Delete—Deletes the selected track menu item.

Append—Adds the selected function to the end of the Track Menu. To
move the newly appended item, use the Move Up or Move Down buttons.

Separator—Adds a separator to the end of the Track Menu. To move the
separator, use the Move Up or Move Down buttons.

Col. Break—Adds column break to the end of the Track Menu. To move



the column break, use the Move Up or Move Down buttons.

Related Topics
User Environment Customization
Customizing the Track Menu




Session Properties Folder—General Category
3270 5250 VT

Scheme—Select the session properties scheme to use for the current
session. You can enter the name of a new scheme or select an existing
scheme from the drop-down list.

Note: When you create a scheme, be sure to click Save to save it.



Session Font Dialog Box
32705250 VT
To access

You can use this dialog box to customize the font displayed in the
session window.

Font Name/SizelStyle—Specifies the font attributes.

Display Variable Width Fonts—Lists variable-pitch (that is, proportional)
fonts in the Font Name list. When you select a variable-width font, you
can alter the character spacing using the Character Spacing slider.

Sample—Displays a sample of the font.
Window Preview—Displays the corresponding window terminal size.

Character Spacing—Changes the character spacing for variable width
fonts.

Apply—Implements the changes you have made.

Related Topics
Modifying Font Attributes
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Save Keymap Dialog Box
32705250 VT
To access

You can use this dialog box to save key mapping changes. You can save
the changes as a new file, or apply them to an existing file.

Saved Keymap Files—Specifies a name for the keymap you want to
save. If you choose an existing keymap from the list below, its name
appears in this box.

Keymap list—Lists the existing keymaps.

Save—Saves any changes from the Keyboard Map dialog box with the
name specified in the Saved Keymap Files box.

Delete—Deletes a selected keymap from the list.

Related Topics
Keyboard Customization
Reconfiguring an Existing Keyboard
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HostExplorer Global Features
3270 5250 VT

To access

Use this console to configure global options. The tree displays the default
global feature values as they are configured in the assembly file
GlobalFeatures.hca, which is located in the Assemblies folder in

the HostExplorer directory.
You can edit the option names and values in the tree that displays in
HostExplorer Global Features console.

Note: For more information about editing session option values in the HostExplorer Global Features
console, see Overview—Configuring Global Options
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Common Features

Prompt on Window Close—Prompts the user before closing a
HostExplorer session. By default, this option is selected.

Prevent Automatic Shutdown by Windows—Does not let Windows
shut down while a HostExplorer session is active. By default, this option
Is selected.

Note: Changes to the previous two values take effect immediately. All other Global Feature options
require a restart of HostExplorer before changes are implemented.

Use Saved Window State—Opens a session window using the window

settings specified in the last saved session profile. By default, this option

is selected. Clear this option to open the session window using the

window parameters specified in the shortcut properties.

Note: For the specified window size, right-click the desktop shortcut and click Properties. The window
size is shown in the Run list of the Shortcut tab.

Capture OIA—Saves the Operator Information Area (OIA) when the
Save Screen function is executed. By default, this option is selected.

Auto Toggle NumLock—Turns off the Numlock LED automatically when
you press the Numlock key. Clear this option to toggle the Numlock LED
when the key is pressed. By default, this option is selected.

Note: This function only works if the Numlock key is mapped.

Allow Display of Host Address—Displays the IP host address or
gateway in the Operator Information Area (OIA). By default, this option is
selected.

Allow Tracing—Enables tracing on HostExplorer sessions. By default,
this option is selected.

Detailed Trace Format—Enables tracing of both data text and
hexadecimal values to the HostExplorer trace file. By default, this option
is cleared.

For example, a detailed trace line displays as follows:
Send completed. Data follows:
4B 40 4B 40 4B 40 7A 20 11 04 45 20 D8 D7 C1 C4 C5 E5



FO FO D8 F8 20 11 06 02 20 E6 85 93 83 96 |

Open Session in Same Window when Launched from Explorer—Lets
you open multiple sessions (for any terminal type) in the same session
window, unless the session is launched from the Open Session dialog
box.

Modify Tracing File—Lets you modify the name and location of the
HostExplorer trace file. By default, HostExplorer saves the tracing file in
your My Documents directory as hetrace. txt.

PrintScreen Font Name—Lets you change the keyboard template or the
default printer font used to print screen images to any TrueType font of
your choice. The default value is HE_ TERMINAL.

PrintScreen Font Size—Lets you change the font size of the default
printer used to print screen images. The default value is 12 points.

Session Lockout Time—Lets you specify number of idle minutes before
a session lockout. The default value is 0.



Advanced Features

Terminate Macros On Exit—HostExplorer terminates all currently
running macros when you close a session. By default, this option is
selected. Clear this option to let a macro continue to run after you close a
session (for example, a macro that monitors session activity).

Out of Band Inline Data—Enables the out-of-band inline socket, which
forces HostExplorer to convert out-of-band telnet data into in-band data.
By default, this option is selected.

5250 Display Compatibility—Specifies how the emulator interprets
5250 screen attributes in the range 0x34 to 0x37. The default value
TERMINAL lets fields controlled by any of these attributes display column
separator indicators. If the value is changed, the same fields do not
display column separator indicators.

Early Connect—Forces the internal connect flag. HostExplorer
considers a session connected when it receives data. It is possible to
connect to a system that sends no data until it receives input from the
user. If the host sends no data, the HLLAPI interfaces and a number of
internal functions such as the Auto Start Quick-Key do not work or
synchronize properly. Select this option to force the internal connect flag
to True when a connection is established. By default, this option is
cleared.

Record Portable Macros—Lets you record macros that are not bound to
a specific session profile. By default, this option is cleared.

Max Winsock Receive Size—Lets you set the receive size issued to the
Winsock TCP/IP stack. HostExplorer uses a 512 byte-block to receive
data. You can lower this value to solve problems in low memory
situations or raise this value to improve network efficiency. The default
value is 1024.

Maximum Sessions—Lets you determine the number of HostExplorer
sessions allowed. The default value is 65534.

HLLAPI Auto Assign—Automatically assigns HLLAPI letters to new
sessions, which lets the HLLAPI application connect to a session without
pre-configuring it. By default, this option is cleared.



Enable Macro On Save—Displays save options for macro files when
you finish recording a macro. By default, this option is selected.

Trap ALT Key—Enabling this option lets you avoid potential sequence
problems when using the Gateway programmable keyboard, which does
not properly transfer Alt sequences to the Windows operating system. By
default, this option is cleared.

Allow Error Restart—Lets HostExplorer attempt reconnection even if
the connection was dropped due to an error. By default, this option is
selected. Clear this option to let reconnection occur only if the connection
terminated successfully or if there was a timeouit.



Add New Event Dialog Box
3270 5250 VT

To access

Use this dialog box to specify properties for a new event, as well as
assign the new event to an action.

Event Type—Selects the type of event to program. The availability of the
options under this list depend on the event type that you select.

Enabled—Triggers the action specified in the Action area based on the
selected event in the Event Type list.
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Options
This area lets you program the event specified in the Event Type list.

Run this Event—Specifies how often HostExplorer executes the event
once it occurs.

Every Time—Each time the programmed event occurs, it triggers
the assigned action.

Once per Session—When the programmed event occurs, it
triggers the assigned action only once during the session.

Once, Then Delete It—When the programmed event occurs, it
triggers the assigned action only once during the session, which is
then removed from the event scheme. When the event occurs, it
no longer triggers the assigned action.

Event String—Specifies a string of text. When the host sends this string
of text, it triggers the assigned action. This box is available only when you
select the When a String Is Received from the Host option from the Event
Type list.

Case Sensitive—Specifies that the event string is case-sensitive.

Row—Specifies the row position in the host window in which the cursor
or string is located. This list is available only when you select one of the
following options from the Event Type list:

. When the cursor enters a field (3270 and 5250 only)

. When the cursor leaves a field (3270 and 5250 only)

. When the cursor enters a position

. When the cursor leaves a position

Any Row—Disables the row position box. The cursor or string can
be located in any row of the host window. This check box is
available only when you select one of the following options from
the Event Type list:



- When the cursor enters a position
- When the cursor leaves a position

Column—Specifies the column position in the host window in which the
cursor or string is located. This list is available only when you select one
of the following options from the Event Type list:

. When the cursor enters a field (3270 and 5250 only)

. When the cursor leaves a field (3270 and 5250 only)

. When the cursor enters a position

. When the cursor leaves a position

Any Column—Disables the column position box. The cursor or
string can be located in any row of the host window. This check
box is available only when you select one of the following options
from the Event Type list:

- When the cursor enters a position
- When the cursor leaves a position

Duration (HH:MM:SS)—Specifies the elapsed period of time (in hours,
minutes, and seconds) that the event must occur to trigger the assigned
action. This box is available only when you select one of the following
options from the Event Type list:

. When a time period elapses
. After a period of inactivity

Time (HH:MM:SS)—Specifies the time of day (in hours, minutes and
seconds) that the event must occur to trigger the assigned action. This
box is available only when you select At A Specific Time of Day from the
Event Type list.



Action

This area lets you specify the action that you want to assign to the
programmed event.

Function Group—Selects the type of action that the programmed event
will trigger (for example, System Commands).

Function—Selects a specific function to be assigned to the programmed
event.

Description—Shows a description of the function that you selected in
the Function list.

Related Topics

Overview—Events

Creating and Deleting Events

Events Folder—Assignments Category




Edit Event Info Dialog Box
32705250 VT

To access

Use this dialog box to modify the properties of an existing event, as well
as re-assign the event to another action.

Event Type—Specifies the type of event that you want to program. The
availability of the options under this list depend on the event type that you
select.

Enabled—Triggers the action specified in the Action area based on the
selected event in the Event Type list.
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Options
This area lets you re-program the event specified in the Event Type list.

Run this Event—Specifies how often HostExplorer executes the event
once it occurs.

Every Time—Each time the programmed event occurs, it triggers
the assigned action.

Once per Session—When the programmed event occurs, it
triggers the assigned action only once during the session.

Once, Then Delete It—When the programmed event occurs, it
triggers the assigned action only once during the session, and
then removed it from the Event Handler so that it no longer
triggers the assigned action when the event occurs.

Event String—Triggers the assigned action when you send this string of
text to the host. This box is available only when you select the When A
String Is Received from the Host option from the Event Type list.

Case Sensitive—Specifies that the event string is case-sensitive.

Row—Specifies the row position in the host window in which the cursor
or string is located. This list is available only when you select one of the
following options from the Event Type list:

. When the cursor enters a field (3270 and 5250 only)

. When the cursor leaves a field (3270 and 5250 only)

. When the cursor enters a position

. When the cursor leaves a position

Any Row—Disables the row position box. The cursor or string can
be located in any row of the host window. This check box is
available only when you select one of the following options from
the Event Type list:



- When the cursor enters a position
- When the cursor leaves a position

Column—Specifies the column position in the host window in which the
cursor or string is located. This list is available only when you select one
of the following options from the Event Type list:

. When the cursor enters a field (3270/5250 only)

. When the cursor leaves a field (3270/5250 only)

. When the cursor enters a position

. When the cursor leaves a position

Any Column—Disables the column position box. The cursor or
string can be located in any row of the host window. This check
box is available only when you select one of the following options
from the Event Type list:

- When the cursor enters a position
- When the cursor leaves a position

Duration (HH:MM:SS)—Specifies the elapsed period of time (in hours,
minutes, and seconds) that the event must occur to trigger the assigned
action. This box is available only when you select one of the following
options from the Event Type list:

. When a time period elapses
. After a period of inactivity

Time (HH:MM:SS)—Specifies the time of day (in hours, minutes and
seconds) that the event must occur to trigger the assigned action. This
box is available only when you select the At a Specific Time Of Day
option in the Event Type list.



Action
This area lets you re-assign another action to the programmed event.

Function Group—Specifies the type of action that the programmed
event will trigger (for example, System Commands).

Function—Specifies a specific function to be assigned to the
programmed event.

Description—Shows a description of the function that you selected in
the Function list.

Related Topics

Overview—Events

Editing Events

Events Folder—Assignments Category




Properties Dialog Box
3270 5250 VT

To access

You can use the Properties dialog box to define parameters for a new
hotspot.

Hotspot Text/Name—Specifies the text you want to include in the
hotspot (for Text hotspots) or the name of a hotspot region (for Region
hotspots).

Type—Specifies the type of hotspot. The options in the lower half of this
dialog box depend on the hotspot type you select.

Text—Specifies that the hotspot consists of the text string that you
type in the Hotspot Text box.

Region—Specifies that the hotspot consists of a region with the
name that you type in the Hotspot Name box.

Next—Displays the Action dialog box, where you can assign a function to
the hotspot.


javascript:Dialogs89.Click();

Text Hotspot Options

Only Valid in Row—Specifies that the hotspot text can only work in the
indicated row.

Only Valid in Column—Specifies that the hotspot text can only work if it
starts in the indicated column.

Case Sensitive—Specifies that the hotspot text is case-sensitive.

Text Must Be Preceded by a Space—Specifies that a space must
precede the hotspot on the screen in order to make the hotspot valid.

Text Must Be Followed by a Space—Specifies that a space must follow
the hotspot on the screen in order to make the hotspot valid.

Auto-Invoke When Text Appears on Display—Specifies that the
hotspot action (defined in the Action dialog box when you click Next) is
automatically invoked when the hotspot text appears on the display.



Region Hotspot Options

Upper Left Corner at—Specifies the row and column position for the
upper-left corner of the region.

Lower Right Corner at—Specifies the row and column position for the
lower-right corner of the region.

Related Topics

Action Dialog Box

Working with Hotspots

Hotspots Folder—Assignments Category




Action Dialog Box
3270 5250 VT

To access
You can use the Action dialog box to assign functions to a new hotspot.

Function Group—Selects the type of action the hotspot will perform (for
example, System Commands).

Function—Selects a specific function to be assigned to the hotspot.

Description—Shows a description of the selected function.
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Display Options

Tip Text—Specifies the text that appears when you hold the
cursor over the hotspot on the display.

Finish—Saves the changes and exits the dialog box.

Related Topics
Displaying Hotspots



Quick-Key Editor Dialog Box
3270 5250 VT

To access

You can use this dialog box to create, modify, and delete Quick-Keys.
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Quick-Keys area

Quick-Key Name—Specifies the name of your new Quick-Key. You can
select an existing Quick-Key from the drop-down list box in order to
modify or run it.

Assigned Quick-Key String—Specifies the actions the Quick-Key
executes.



Quick-Key Functions area

Function Group—Selects the type of action the quick-key will perform
(for example, System Commands).

Append Function—Adds the selected function to the Assigned Quick-
Key String box.

Function—Selects a specific function to be assigned to the Quick-Key. A
description is displayed in the description box.



Button Area
Set—Implements the Quick-Key.

Run—Executes the action specified in the string.
Delete—Removes the Quick-Key.
Close—Closes the dialog box without saving changes.

Load—Displays the Load Quick-Key dialog box, where you can load a
quick-key.

Save—Opens the Save Quick-Key dialog box, where you can save the
Quick-Key to a session profile.

Related Topics

Overview—Quick-Keys

Save Quick-Key Dialog Box

Automating Login Using Quick-Keys (3270 and 5250)
Automating Login Using Quick-Keys (VT)




Edit Menu
3270 5250 VT

The Edit menu contains the following items:
Undo (3270 and 5250)—Used to undo the most recent operation.

Redo (3270 and 5250)—Used to redo the most recently undone
operation.

Cut (3270 and 5250)—Removes the selected text from unprotected
areas of the screen and places it on the Clipboard.

Copy—Copies the selected text and saves it to the Clipboard.

Copy Append—Caopies the selected text and saves it to the Clipboard
without removing the current contents of the Clipboard. You can select
Paste to paste the entire contents of the Clipboard.

Paste—Pastes the Clipboard contents to the current cursor location.

Paste Continue (3270 and 5250)—Pastes any contents that remain on
the Clipboard after a Paste command. For example, if you are pasting 22
lines of text to an area that contains only 16 lines, the following message

appears:
More text available in clipboard. Use Paste Continue.

Select All (3270 and 5250)—Selects the contents of the entire screen.

Select All (VT)—Selects the contents of the entire screen plus the
contents of the scrollback buffer.

Options (3270 and 5250)—Opens the Session Profile dialog box, in
which you can change default settings. For more information, see Edit
Folder—Copy, Cut and Paste Category.

Find (VT)—Searches the telnet screen and scrollback buffer.
Clear Display (VT)—Clears the current screen display.

Clear All (VT)—Clears the current display and restores the system
memory by deleting information in the Scrollback buffer.

Soft Terminal Reset (VT)—Clears the current screen and resets all
terminal settings without restarting the session.



Related Topics
User Environment Customization




Transfer Menu

3270 5250 VT

The Transfer menu contains the following items:
Send File to Host—Uploads a file to the host.

Receive File from Host—Downloads a file from the host.



Fonts Menu

3270 5250 VT

The Fonts menu contains the following items:

Next Larger Font—Increases the size of the font.
Next Smaller Font—Decreases the size of the font.

Font—Opens the Session Font dialog box, which lets you configure the
font.

Maximize Font—Maximizes the current screen font for the current
window size. This option is available only if you first maximize the
window.



Options Menu
3270 5250 VT
The Options menu contains the following items:

Global Options—Opens the HostExplorer Global Features console,
used to configure settings that affect all HostExplorer profiles.

API Settings—Opens the API Global Settings dialog box, used to
change HLLAPI and EHLLAPI options.

Keyboard Mapping—Opens the Keyboard Map dialog box, used to map
functions to keys.

Quick-Keys—Opens the Quick-Key Editor dialog box, used to create,
modify, and delete Quick-Keys.

Session Properties—Opens the Session Profile dialog box. For more
information, see Session Property Categories.

Related Topics

HostExplorer Global Features
API Global Settings Dialog Box
Keyboard Map Dialog Box
Quick-Key Editor Dialog Box
User Environment Customization




View Menu
3270 5250 VT

The View menu contains the following items:

Hotspots—Toggles the visibility of hotspots on and off. When selected,
hotspots are visible.

Row and Column Indicator—Toggles the visibility of the Row and
Column indicator on and off. When selected, the indicator is visible in the
bottom right of the Operator Information Area (OIA).

Cross-Hair Cursor—Toggles the visibility of the cross-hair cursor, which
consists of two "cross-hair” lines that span across the screen and
intersect at the cursor.

Full Screen—Hides the title, menu and tool bars, so that the session
window occupies the entire screen.

Note: To return to normal screen, press Ctrl+Shift+F.



Window Menu
32705250 VT

The Window menu lists open windows and is used to arrange these
windows on the screen. The active window is indicated with a check
mark.

The menu also contains the following options:

Cascade—Arranges multiple open session windows in an overlapping
pattern so that the title bar of each window remains visible.

Next Session—This item is active only when you have more than one
session window open. Displays the session window that you opened after
the current one. Selecting this option when you are viewing the last
session in the session list takes you to the first session in the list.

Previous Session—This item is active only when you have more than
one session window open. Displays the session window that you opened
after the current one. Selecting this option when you are viewing the first
session in the session list takes you to the last session in the list.



Help Menu
3270 5250 VT
The Help menu contains the following options:

Contents—Opens the HostExplorer help which contains information on
how to use HostExplorer.

About—Shows version information about the installed HostExplorer
product.



Auto End Quick-Key/Quick Script/Macro
3270 5250 VT

You can use this entry to specify a macro, Quick-Key, or Quick Script that
HostExplorer automatically runs when you close a session.

To automatically close the session:

Browse to the Profile directory where the user files are stored on your
machine. To access the User Files folder, double-click the User Files
shortcut in the Hummingbird Connectivity program group.

6. In atext editor, open the profile that you want to edit (it may be in
another directory).

7. Add the following line to the [PROFILE] section, depending on
whether you are specifying a macro, Quick-Key, or Quick Script:

Auto End Quick-Key = MacroFileName.ebs

Auto End Quick-Key Quick-KeyFileName.gk3

Auto End Quick-Key = QuickScriptFileName.(qgs5



Clear Buffer On Connect
VT

You can use this entry to prevent the screen from being cleared on
reconnect. By default, the buffer is cleared when you disconnect a
session and then reconnect.

To prevent the screen from being cleared on reconnect:

Browse to the Profile directory where the user files are stored on your
machine. To access the User Files folder, double-click the User Files
shortcut in the Hummingbird Connectivity program group.

1. In a text editor, open the profile that you want to edit (it may be in
another directory).

2. Add the following line to the [PROFILE] section.
Clear Buffer On Connect = Off



Disable Replies
3270

You can use this entry to disable any specific 3270 structured field by
disabling the reply from the Read Partition Query command. On the right
side of the key, put one or more structured field IDs in hex separated by
commas.

To disable one or more replies:

Browse to the Profile directory where the user files are stored on your
machine. To access the User Files folder, double-click the User Files
shortcut in the Hummingbird Connectivity program group.

1. In a text editor, open the profile that you want to edit (it may be in
another directory).

2. Add the following line to the [PROFILE] section.
Disable Replies = FieldID

For example:

Disable Replies = F1,F2



Display Field Info
3270 5250

You can use this entry to prevent HostExplorer from updating the
Numeric Field and Operator Selectable Field in the Operator Information
Area (OIA) each time you move the cursor. By default, the system
updates the Numeric Field and Operator Selectable Field indicators in the
OIA every time you move the cursor. If this causes too much overhead on
your machine, for example, cursor movement appears too slow, disable
this option.

To prevent HostExplorer from updating the Numeric field:

Browse to the Profile directory where the user files are stored on your
machine. To access the User Files folder, double-click the User Files
shortcut in the Hummingbird Connectivity program group.

1. In a text editor, open the profile that you want to edit (it may be in
another directory).

2. Add the following line to the [PROFILE] section.
Display Field Info = Off



Max Hosts History
3270 5250 VT

You can use this entry to change the number of Host names listed in the
Open Session dialog list and the New Profile Host name list. The default
is 20.

To change the number of listed Host hames:

Browse to the hostex.ini file where the HostExplorer Default User files are
stored on your machine. To access the User Files folder, click the

User Files shortcut in the Hummingbird Connectivity program group.
1. In atext editor, open the hostex.ini file.

2. Add the following line to the [System.Settings] section.
Max Hosts History = n



ReRun Auto Quick-Key

3270 5250 VT

By default, HostExplorer executes the Auto Quick-Key/Quick
Script/Macro upon initiating a session. HostExplorer re-executes the Auto

Quick-Key/Quick Script/Macro when you connect to the session using the
Auto Reconnect feature, or by clicking Connect on the toolbar.

To disable the Auto Quick-Key from re-executing:

Browse to the Profile directory where the user files are stored on your
machine. To access the User Files folder, double-click the User Files
shortcut in the Hummingbird Connectivity program group.

1. In a text editor, open the profile (.hep) that you want to edit (it may
be in another directory).

2. Add the following line to the [PROFILE] section.
ReRun Auto Quick-Key = Off



Show Maximized
3270 5250 VT

You can use this entry to change the setting of the session windows
when they are opened. When enabled, all session windows are opened
in the maximized state. By default, this option is disabled.

To maximize the display of session windows:

Browse to the hostex. ini file where the HostExplorer Default User
files are stored on your machine. To access the User Files folder, click
the User Files shortcut in the Hummingbird Connectivity program group.

1. In atext editor, open the hostex.ini file.
2. Add the following line to the [PROFILE BROWSER] section.
Show Maximized = On



Scroll SSCP Screens
3270

By default, data on an SSCP screen scrolls when you reach the bottom
of the screen. You can use this entry to prevent scrolling of SSCP
screens when in SSCP_LU mode.

To prevent scrolling when in SSCP_LU mode:

Browse to the Profile directory where the user files are stored on your
machine. To access the User Files folder, double-click the User Files
shortcut in the Hummingbird Connectivity program group.

1. In a text editor, open the profile (.hep) that you want to edit (it may
be in another directory).

2. Add the following line to the [PROFILE] section.
Scroll SSCP Screens = Off



TN5250E
5250

You can use this entry to disable support for the TN5250E protocol.

To disable support for TN5250E:

Browse to the Profile directory where the user files are stored on your
machine. To access the User Files folder, double-click the User Files
shortcut in the Hummingbird Connectivity program group.

1. In a text editor, open the profile that you want to edit (it may be in
another directory).

2. Add the following line to the [PROFILE] section.
TN5250E = Off



Use Single Font Name
3270 5250 VT

You can use this entry to retain the font name of a restored session when
a user maximizes a session. For example, the default font name of a
maximized session is HEBITMAP. If the font name of a restored session
is HETERMINAL, with this option enabled, the maximized session
displays HETERMINAL.

To use a single font name:

Browse to the Profile directory where the user files are stored on your
machine. To access the User Files folder, double-click the User Files
shortcut in the Hummingbird Connectivity program group.

1. In a text editor, open the profile that you want to edit (it may be in
another directory).

2. Add the following line to the [PROFILE] section.
Use Single Font Name = On



VT Reset ISO Colors
VT

You can use this entry to determine how HostExplorer reacts to a Reset
Set Graphics Rendition (SGR 0) command when the host is sending
color graphics commands. If you encounter screens that appeared
properly with an older version of HostExplorer and no longer do, then set
the flag to OFF, as demonstrated below.

To reset the ISO colors:

Browse to the Profile directory where the user files are stored on your
machine. To access the User Files folder, double-click the User Files
shortcut in the Hummingbird Connectivity program group.

1. In a text editor, open the profile that you want to edit (it may be in
another directory).

2. Add the following line to the [PROFILE] section.
VT Reset ISO Colors = Off



Type Formats
PSCHAR—Word Value

LOBYTE—EBCDIC Character value for PS Position
HIBYTE—Reserved



Buffer Contents

The screen buffer passed through the clipboard is in the EBCDIC
character set. The non-standard character positions such as x'41' depend
on the host code page.

Each character position occupies a WORD (two bytes). The low order
byte contains the EBCDIC character value. Ignore the high order byte.



Open Layout Dialog Box
3270 5250 VT
To access

The Open Layout dialog box lists all the layouts that you have saved.
Each layout consists of a saved working environment.

Folder—Shows the location of layouts displayed in the dialog box.
Up One Level—Navigates from a subfolder to its parent folder.

Create New Profile button—Displays the New Profile dialog box, which
lets you create a new session profile.

Note: When creating a profile, the profile name must not contain any of the following characters:
\/:*¥2%<>|

Create New Profile Folder button—Creates a new folder once you

supply a folder name.

Layout list—Lists the folders and layouts that exist in the location
specified in the Folder list. You can double-click a layout to open it. You
can right-click a layout and choose an option from the pop-up context
menu.

Layout Name—Specifies the name of the selected layout.

Related Topics
Working with Layouts
Save Layout Dialog Box
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Save Layout Dialog Box
32705250 VT
To access

The Save Layout dialog box lets you save your working environment into
a file so that it can be used again later.

Selected Sessions—Specifies the sessions that will be saved in the
layout. When you first open this dialog box, all open sessions in your
working environment are selected (by default).

Profile Name—Specifies the name of the profile associated with
the session.

Window Title—Specifies the name and/or description displayed in
the top right-hand corner of the session window.

Folder—Shows the location of layouts displayed in the dialog box.
Up One Level—Navigates from a subfolder to its parent folder.

Create New Profile button—Opens the New Profile dialog box, which
lets you creates a new session profile.

Note: When creating a profile, the profile name cannot contain any of the following characters:
\/1*x2%<>|

Create New Profile Folder button—Creates a new folder once you
supply a folder name.

Layout list—Lists the folders and layouts that exist in the location
specified in the Folder list.

Layout Name—Specifies a name for the new layout.

Related Topics
Working with Layouts
Open Layout Dialog Box
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Edit Host Info Dialog Box
3270 5250 VT

To access

Use this dialog box to specify the general properties of a host to which
the session can connect.

Host Name—Modifies the name of the host or selects an existing name
to assign to the host.

Telnet Name Override—Modifies the name to override the name used
during Telnet negotiation with the host system. You can type any valid
terminal name that your host system recognizes. (For example, you can
type “IBM-3278-2" to override the name that gets generated from the
TN3270 settings.)

Warning! Modifying a name in the Telnet Name Override field without fully understanding this function
may cause connection failures.

TCP Port—Specifies the host port or socket number to use for the Telnet
session. You can specify a number between 0 and 65535.

HTTP Proxy URL—Specifies the URL for a proxy host that will be
associated with the current session profile.

Related Topics

Connection Folder—TN3270 Category
Connection Folder—TN5250 Category
Connection Folder—Telnet Category
Add New Host Dialog Box
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Certificate Information Window
3270 5250 VT
To access

Use this dialog box to view detailed information about a specific
certificate.

Field—Specifies the type of information contained within the certificate
(for example, subject, issuer, and expiry dates).

Value—Specifies the information corresponding to the field.

Certificate Status—Specifies the current status of the specified
certificate.

Status—Indicates whether the certificate is valid or invalid.

Reason—Specifies the reason that the certificate became invalid.
This box is active only when the certificate has an invalid status.
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HostExplorer File Transfer Name Templates
Dialog Box
3270

To access

You can specify a template to format a file being transferred to or from a
3270 host.

Available Templates—Lists the available templates, along with each
one’s associated format and scheme.

Edit/Add—Displays the Edit Template dialog box, where you can edit an
existing template or add a new one to the list.

Delete—Deletes the selected template from the list.

Test Template—Verifies that the selected template is suitable to produce
a target file name.

Find Match—Tests all defined templates until one produces a target file
name.

Transfer Direction—Specifies the direction of the file transfer: PC-to-
host or host-to-PC.

Source File Name—Specifies the name of the file you want to transfer.

Target File Name—Displays the file name generated by using the other
fields (including the Source File Name and Minidisk boxes) and a suitable
template.

Related Topics

Transferring Files to a Mainframe
Receiving Files from a Mainframe
Edit Template Dialog Box
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5250 Data Transfer Wizard—General Setup Page

Data Transfer Direction—Select the direction of the transfer.
Host Name—Type the name or IP address of the host.

User ID—Type your ID on the AS/400.

Password—Type your password on the AS/400.

Host Code Page—Specify the host code page used to translate data
from PC or AS/400 format to the destination format.

Enable Trace—Store a record of the transfer in a trace file.

Trace File Name—Type a complete path or click Browse to search for an
existing file.
Note: You can use the Execute button to perform a transfer at any stage of the wizard process. The

Execute button becomes available when you have provided the minimum information required
to perform a transfer.

Related Topics

Transferring Files to and from AS/400

PC-t0-AS/400 File Transfers:
5250 Data Transfer Wizard—PC File Setup Page

5250 Data Transfer Wizard—Host File Setup Page

AS/400-to-PC File Transfers:
5250 Data Transfer Wizard—PC File Setup Page

5250 Data Transfer Wizard—Host File Setup Page




5250 Data Transfer Wizard—Complete Page

Save Data Transfer Settings—Opens the Windows Save dialog box
when you click Finish in the wizard. In this dialog box, you can specify a
name and location for the transfer profile. All of the settings you entered
in the wizard are saved in this profile.

Create Desktop Shortcut to Execute Data Transfer—Opens the
Windows Browse For Folder dialog box when you click Finish in the
wizard. You can specify a location for the shortcut.

Transfer Data Immediately—Begins the data transfer process.

Related Topics
5250 Data Transfer Wizard—Welcome Page
5250 Data Transfer Wizard—General Setup Page




General Page (Printer Session Properties Dialog

Box)
3270 5250

To access
Use this page to set options relating to the host computer.

IP Host/Gateway—Specifies the IP address, machine name, or DNS
name of the host (or the gateway to the host) from which reports are
printed. This box appears only when you select Telnet from the Connect
By list in the New Profile dialog box.

LU or Pool Name—Specifies the logical unit (LU) name to use for a host
connection. You can type the individual LU name or the name of an LU
pool. The LU contains the necessary configuration information needed to
connect to a host. The LU name can contain up to 10 (ten) characters,
but it must start with a letter and it cannot contain any spaces. This box
appears only when you select Microsoft SNA Server from the Connect By
list in the New Profile dialog box.

LU Name | Device Name—Specifies the LU name that the host is using
to identify the host printer that the program is emulating (which is called a
device name on AS/400). This box is enabled only when you select
Telnet from the Connect By list in the New Profile dialog box.

Choose a Printer Type—Specifies the host printer that you want to
emulate:

IBM-3287-1—This printer type appears only for 3270 printer
sessions. Commonly used by MVS and other IBM mainframe
operating systems.

IBM-3812-1—This printer type appears only for 5250 printer
sessions. Commonly used by AS/400.

Connect By—Selects the transport type that HostExplorer will use to
connect to a host.

Telnet—Connects to a host using TCP/IP.
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Microsoft SNA Server—Connects to a host through a Microsoft
SNA Server gateway.

TCP Port—Specifies the port number of the host. This box is enabled
only when you select Telnet in the Connect By list.

Connect Timeout—Specifies the number of seconds allowed to pass
before the connection to the host times out. This box is enabled only
when you select Telnet from the Connect By list.

TN5250E Message Queue—Lets you configure queue settings. This
area is enabled only for 5250 printer sessions.

Message Queue Name and Message Queue Library—lIldentifies
the location (on the AS/400) to which status messages are
spooled. This field is enabled only if you select IBM-3812-1 in the
Choose A Printer Type list.

Enable Auto Reconnect—Enables the auto reconnect options.

Retry Interval (Secs)—The number of seconds between auto-
reconnect attempts.

Number of Retries—The number of times the system attempts to
auto-reconnect when the connection to the host drops.

TN3270E LU Request—Specifies the format of the contents of the LU
Name box. This list is enabled only for 3270 printer sessions.

Connect—If you select this option, the LU Name box specifies the
actual LU resource used for the printer session.

Associate—If you select this option, the LU Name box specifies
the LU of the display session. In this case, the host system
assigns the LU associated with the display LU (if available).

Related Topics



LU1 Settings Page (Printer Session Properties Dialog Box)

LU3 Settings Page (Printer Session Properties Dialog Box)
Printer Destination Page (Printer Session Properties Dialog Box)
Page Layout Page (Printer Session Properties Dialog Box)
Printer Advanced Page (Printer Session Properties Dialog Box)

ASCII/EBCDIC Translation Table Page (Printer Session Properties Dialog
Box)

Host-Print Transform Page (Printer Session Properties Dialog Box)




LU1 Settings Page (Printer Session Properties
Dialog Box)
5250

To access

Use this page to set options for reports that the host computer prints
using the LUL printer protocol. An LU1 printer is also known as an SNA
Character String (SCS) printer. Unlike LU3 printers, LU1 printers use data
streams that are similar to ASCII print jobs. HostExplorer supports a
number of SCS control sequences.

Double Space Lines—Forces all printed output to be double-spaced.
This option treats all linefeeds as double linefeeds.

Print Upper Case Only—Converts all data to uppercase. This option
does not affect other special characters or accented characters.

Suppress Initial Form Feed—Enables the system to discard a form feed
at the beginning of a job. Many systems include a form feed at the
beginning of a job to align the printer. If you are printing using Windows,
alignment is automatic and the initial form feed is not required.

Add Blank Page at End of Job—Adds a form feed at the end of a job. If
you are printing using Windows, this option may print a blank page. If you
are printing directly to LPT1, LPT2, LPT3, or a file, this option adds an
ASCII form-feed character to the end of the job.

Discard SCS Transparency Blocks—Enables the system to discard
(ignore) transparency blocks. Transparency blocks usually send printer-
formatting codes to a specific printer. If you are printing using Windows,
select this option. Transparency blocks are not compatible with the
Windows internal print engine.

Ignore Vertical Channel Select (VCS)—Enables the system to ignore
VCS commands. You can use VCS commands to skip to a specific
channel to align the vertical format. When you select this option, VCS
commands have no effect on a print job.

LU1 Transparency Blocks Contain ASCII Data—Prevents the program
from translating transparency blocks from EBCDIC to ASCII. If you are
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using transparency blocks to download printer-specific information (such
as escape sequences for font selection and other printing orders), select
this option. If you clear this option, all data in transparency blocks are
translated from EBCDIC to ASCII.

Host Formatting—Specifies how to handle host formatting orders.

Ignore Host Formatting Orders—Enables the program to ignore
all host formatting orders except for Carriage Return and Line
Feed. [Chiclet Help Jump]

Honor Host Formatting Orders in Current Job Only—Enables
the program to interpret host formatting orders, and then resets
the tab stops, vertical tabs, and margins at the end of a print job.
This option allows all print jobs to start with their default values.

Honor Host Formatting and Retain in Following Jobs—
Enables the program to interpret host formatting orders and
retains the tab stops, vertical tabs, and margins at the end of a
print job. The next print job will use the same print parameters.

Defaults—Resets all options to their system default.

Related Topics

General Page (Printer Session Properties Dialog Box)

LU3 Settings Page (Printer Session Properties Dialog Box)
Printer Destination Page (Printer Session Properties Dialog Box)
Page Layout Page (Printer Session Properties Dialog Box)
Printer Advanced Page (Printer Session Properties Dialog Box)

ASCII/EBCDIC Translation Table Page (Printer Session Properties Dialog
Box)

Host-Print Transform Page (Printer Session Properties Dialog Box)
Supported SCS Control Sequences




LU3 Settings Page (Printer Session Properties
Dialog Box)
3270

To access

Use this page to configure options that HostExplorer will use for reports
that the host computer prints using the LU3 printer protocol.

Note: The LU3 Settings tab is available only for 3270 terminals.

An LUS3 printer is also known as a 3270 printer. LU3 is sometimes used
by IBM mainframes, but not by AS/400 hosts.

Double Space Lines—Forces all printed output to be double-spaced.
This option treats all linefeeds as double linefeeds.

Print Upper Case Only—Converts all data to uppercase. This option
does not affect other special characters or accented characters.

Suppress Initial Form Feed—Enables the system to discard a form feed
at the beginning of a job. Many systems include a form feed at the
beginning of a job to align the printer. If you are printing using Windows,
alignment is automatic and the initial form feed is not required.

Add Blank Page at End of Job—Adds a form feed at the end of a job. If
you are printing using Windows, this option may print a blank page. If you
are printing directly to LPT1, LPT2, LPT3, or a file, this option adds an
ASCII form-feed character to the end of the job.

Always Honor Form Feeds—Enables the program to honor form-feed
orders even if the print position is not column 1. When you clear this
option, and the print position is not column 1, the program treats form-
feed orders as blanks.

Reset Position to Column 1 on Form Feed—Enables the program to
reset the print position to column 1 after processing a form-feed order.
Normally, a form feed causes a form eject, then moves the print position
to column 2.

Note: If you select this option, your print job may not align correctly.

Print Blank lines If Line is Empty—Enables the program to print a
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blank line when it encounters lines containing only null characters.

Defaults—Resets all options to their system default.

Related Topics

General Page (Printer Session Properties Dialog Box)

LU1 Settings Page (Printer Session Properties Dialog Box)
Printer Destination Page (Printer Session Properties Dialog Box)
Page Layout Page (Printer Session Properties Dialog Box)
Printer Advanced Page (Printer Session Properties Dialog Box)

ASCII/EBCDIC Translation Table Page (Printer Session Properties Dialog
Box)




Customize Toolbars Dialog Box—Functions Tab
3270 5250 VT

To access

Use the Functions tab to add actions and functions to a toolbar.

Function Group—Selects the type of function that can be added to the
new toolbar (for example, System Commands).

Function—Selects the function to add as a button to the new toolbar.
You can drag and drop functions to any toolbar in the session window.

Selected Function Description—Describes the currently selected
function.

Related Topics

Toolbar Customization

New Scheme Dialog Box

Customize Toolbars Dialog Box—QOptions Tab
Customize Toolbars Dialog Box—Scheme Tab
HostExplorer Functions
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New Toolbar Dialog Box
3270 5250 VT
To access

The New Toolbar dialog box lets you name a new toolbar for the session
window.

Name—Specifies a name for the new toolbar. The default name is
Custom #.

Start with Defaults—Uses the default toolbar configuration as a basis
for the custom toolbar that you want to create.

Related Topics

Creating and Moving Toolbars

Customize Toolbars Dialog Box—Scheme Tab
Toolbar Customization

Rename Toolbar Dialog Box
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Rename Toolbar Dialog Box
32705250 VT

To access
Use this dialog box to rename an existing toolbar.

Name—Lets you specify a new name for the selected toolbar.

Related Topics

Toolbar Customization

Creating and Moving Toolbars

Customize Toolbars Dialog Box—Scheme Tab
New Toolbar Dialog Box
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Rename Scheme Dialog Box
3270 5250 VT

To access

Use this dialog box to rename an existing scheme.
Name—Lets you specify a new name for the selected scheme.

Related Topics

Creating Menu Schemes

Customize Menus Dialog Box—Scheme Tab

Customize Session Properties Dialog Box—Scheme Tab
New Scheme Dialog Box
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Properties Page (Edit Hotspot Dialog Box)
3270 5250 VT

To access

You can use the Properties page of the Edit Hotspot dialog box to modify
the parameters of an existing hotspot.

Hotspot Text/Name—Specifies the text you want to include in the
hotspot (for Text hotspots) or the name of a hotspot region (for Region
hotspots).

Type—Specifies the type of hotspot. The options in the lower half of this
page depend on the hotspot type you select.

Text—Specifies that the hotspot consists of the text string that you
type in the Hotspot Text box.

Region—Specifies that the hotspot consists of a region with the
name that you type in the Hotspot Name box.
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Text Hotspot Options

Only Valid in Row—Specifies that the hotspot text can only work in the
indicated row.

Only Valid in Column—Specifies that the hotspot text can only work if it
starts in the indicated column.

Case Sensitive—Specifies that the hotspot text is case-sensitive.

Text Must Be Preceded by a Space—Specifies that a space must
precede the hotspot on the screen in order to make the hotspot valid.

Text Must Be Followed by a Space—Specifies that a space must follow
the hotspot on the screen in order to make the hotspot valid.

Auto-Invoke When Text Appears on Display—Specifies that the
hotspot action (defined in the Action page of this dialog box) is
automatically invoked when the hotspot text appears on the display.



Region Hotspot Options

Upper Left Corner at—Specifies the row and column position for the
upper-left corner of the region.

Lower Right Corner at—Specifies the row and column position for the
lower-right corner of the region.

Related Topics
Hotspots Folder—Assignments Category
Properties Page (Edit Hotspot Dialog Box)




Action Page (Edit Hotspot Dialog Box)
3270 5250 VT

To access

You can use the Action dialog box to re-assign functions to an existing
hotspot.

Function Group—Specifies the type of action the hotspot will perform
(for example, System Commands).

Function—Specifies the available functions that can be assigned to the
hotspot.

Description—Shows a description of the selected function.
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Display Options

Tip Text—Specifies the text that appears when you hold the
cursor over the hotspot on the display.

Related Topics
Properties Page (Edit Hotspot Dialog Box)
Hotspots Folder—Assignments Category




Custom Transfer Table

A custom transfer table is a master table that you create which specifies
translate settings used for data transferred between the host and PC.
You can save this user-defined .ini file anywhere on your disk. The
table must include an [Upload] section which specifies a PC-to-host file
transfer, and a [ Download] section which specifies a host-to-PC file
transfer. It should follow this format:

[Upload]
aa=mm
bb=nn

[Download]
Jj=xx
kk=yy

The [Upload] section lets you define translation from PC to host values
in hexadecimal format. The left side of the equal sign is the PC value in
hexadecimal format and the right side of the equal sign is the translated
value for the host in hexadecimal format.

The [Download] section lets you define translation from host to PC
values in hexadecimal format. The left side of the equal sign is the host
value in hexadecimal format and the right side of the equal sign is the
translated value for the PC in hexadecimal format.

Note: In both the [Upload] and [Download] sections, you should list all values, 00 to FF, in the
table.

The following is an example of a custom transfer table:

[Upload]
00=00
01=01
02=02

20=40



21=5A
22=7F
30=F0
31=F1
FF=FF

[Download]
00=00
01=01

40=20

FO=30

F1=31

F2=32

FF=FF

Note: The ellipses in the sample represent omitted values. However, in an actual
custom table, all values must appear in the two sections.



Save Quick-Key Dialog Box
32705250 VT
To access

You can use this dialog box to save Quick-Key changes. You can save
the changes as a new file, or apply them to an existing file.

Saved Quick-Key Files—Specifies a name for the Quick-Key you want
to save. If you choose an existing Quick-Key from the list below, its name
appears in this box.

Quick-Key list—Lists the existing keymaps.

Save—Saves any changes from the Quick-Key Editor dialog box with the
name specified in the Saved Quick-Key Files box.

Delete—Deletes a selected Quick-Key from the list. This button is only
available if there is at least one Quick-Key file saved.

Related Topics
Overview—Quick-Keys
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API Global Settings Dialog Box
3270 5250 VT

To access

Use this dialog box to configure external interfaces.
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HLLAPI Options

Update Screen After PS Update—Selects the text you send to the host.
By default, this option is disabled to enhance performance. When you
copy text to the screen using CopyStringToPS or CopyStringToField, the
emulator window is not updated with the text.

Auto Sync—Synchronizes any sent AID generating keys (Enter, PFx,
PAX, Clear) with the host system. This option is similar to enabling Type
Ahead for the API. The SendKey API does not return until the host has
updated the screen and unlocked the keyboard.

Auto Unload—Makes a call to DisconnectPS terminate the session, if
that session was started automatically using ConnectPS.

Start Session—Lets you select the window mode of all future sessions
started by a ConnectPS call. This option does not affect sessions already
started. Select Normal Window, Minimized, Maximized, or Hidden.

Enable Tracing to File—Enables tracing and creates a trace file named
ehllapi. txt in the My Documents directory.

Trace File Name—Lets you enter a path and file name for the trace file,
or lets you browse to one.

Enable DDE Server—Enables the DDE Server.
DDE Server Name—Lets you enter a name for the DDE server.

EHLLAPI Compatibility—Specifies whether the EHLLAPI interface
(ACS3EHAP.d11) is compatible with Attachmate's EXTRA! for

Windows or Irma Workstation for Windows.



Edit Template Dialog Box
3270

To access

Using the Edit Template dialog box, you can edit existing templates or
create new ones for 3270 file transfers.

After you make changes in this dialog box, you can choose to overwrite
an existing template with these changes or create a new template.

PC File Template—Specifies the format of the PC template.
Host File Template—Specifies the format of the host template.

Scheme—Selects a scheme to associate with the template. A file
transfer scheme is a collection of various file transfer settings.

Edit Action—Determines whether you want to overwrite an existing
template or create a new one. These options work in conjunction with the
number in the Template box. For example, if the Template box contains
the number 1, then the edit action you choose is applied to the first
template listed in the File Transfer Name Templates dialog box.

Replace—Overwrites an existing template with the changes you
make in this dialog box.

Add Before—Creates a new template that is added to the list in
the File Transfer Name Templates dialog box immediately before
an existing template.

Add After—Creates a new template that is added to the list in the
File Transfer Name Templates dialog box immediately after an
existing template.

Template—Specifies which existing template is affected by the edit
action.

Related Topics
HostExplorer File Transfer Name Templates Dialog Box
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Transferring Files to a Mainframe
Receiving Files from a Mainframe




5250 Data Transfer Wizard—PC File Setup Page

PC File Name—Type the path to the source file (the file that you want to
transfer) on your PC, or click Browse to search for it.

Note: The options in the PC File Setup page depend upon whether you are transferring files to a host
or from a host.

Related Topics
5250 Data Transfer Wizard—Host File Setup Page




5250 Data Transfer Wizard—Host File Setup Page

Library/File (Member)—Type the path to a destination library/file
(member) on the AS/400. Click Browse to search for one in the Host Files
dialog box.

Host Objects—Indicate how and where the wizard places the uploaded
data. Your selection affects the availability of other options in this dialog
box.

Authority—Set the permissions on the destination file.

Member Text—Type a description of the AS/400 member. When you
browse for host members in the expanded view of the host tree, this text
appears as a pop-up ToolTip when you rest the cursor on the selected
member.

File Text—Type a description of the AS/400 file. When you browse for
files in the expanded view of the host tree, this text appears as a pop-up
ToolTip when you rest the cursor on the selected library/file.

Host File Type—Select the type of file to create on the AS/400. Select
Data for a database file. Select Source for a text file. The wizard then
inserts the entire PC file into the SRC DTA field in the AS/400 file
(member).

Record Length—Type the record length of the AS/400 (member).

Host Field Reference File—Type the path to a file that acts as a
template for the destination file. Click Browse to search for one. This
option is available when you select Create File And Member from the
AS/400 Objects list. The reference file provides table and column
formats, and other attributes of the destination file.

Note: You can use the Execute button to perform a transfer at any stage of the wizard process. The

Execute button becomes available when you have provided the minimum information required
to perform a transfer.

Related Topics
5250 Data Transfer Wizard—PC File Setup Page




5250 Data Transfer Wizard—PC File Setup Page

PC File Name—Type a complete path to the destination file on your PC.
Click Browse to search for it.

File Type—Select the type of file to send to the PC. Choose the No
Conversion option to send or receive binary data.

Truncate Trailing Spaces—Remove trailing spaces in any fields in the
file being transferred to the PC. This saves disk space on your PC.

Include Column Titles—Select this option if you want column heading
information included in the file.

If PC File Exists—From the drop-down list, select the action that the
wizard will take when it attempts to create a destination file that already
exists on the PC.

Field Format—Open the Field Format Options dialog box, which lets you
specify how to format any date, time, or decimal fields in the file being
transferred.

Note: The options in the PC File Setup page depend upon whether you are transferring files to a host
or from a host.

Related Topics
Field Format Options Dialog Box




5250 Data Transfer Wizard—Host File Setup Page

Library/File (Member)—Type a complete path to a library/file (member)
on the AS/400. Click Browse to search for one in the Host Files dialog
box.

Select—Type a list of fields for the SELECT statement to select table data
from the file. The default is * which selects all columns.

Where—Type a WHERE clause for the SELECT statement to place
conditions on the selection of records.

Order by—Type an ORDER BY clause for the SELECT statement to sort
the returned records.

Group by—Type a GROUP BY clause for the SELECT statement to
group returned records.

Having—Type a HAVING clause for the SELECT statement to place
conditions on the selection of records.

Join by—Type a JOIN BY clause for the SELECT statement to join
together two or more tables in the destination file.

Return Records with Missing Fields—Transfer records that contain
missing fields, such as a field containing a NULL value.

SQL Details—Open the SQL Details dialog box, in which you can
customize SQL statements that are used during a file transfer session.
Note: You can use the Execute button to perform a transfer at any stage of the wizard process. The

Execute button becomes available when you have provided the minimum information required
to perform a transfer.

Related Topics
SQL Details Dialog Box




Printer Destination Page (Printer Session

Properties Dialog Box)
5250

To access

Use this page to configure the destination path used to print host jobs.
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Printing System

Use Windows Printing—~Prints all reports through the Windows
Printing subsystem. You can print to any type of printer (for
example, PCL and PostScript). In this mode, the program lays out
the print job similar to that of a word processor. This mode
provides complete control over the format of the report and the
font used to print the report. You can select the layout options on
the Page Layout Page (Printer Session Properties Dialog Box).

Print Directly to LPT1/LPT2/LPT3—Spools print reports to the
device of the same name. This spools the data to the printer port
through the operating system. Use these options only in special
situations, since error messages such as the Printer Offline and
Out of Paper can cause Abort/Retry errors by the operating
system.

Print to File—Spools reports to a file. If the file does not exist, the
program creates it. All reports are automatically appended to the
file. The filename is entered in the Filename Edit box below.

Spool Job Directly—Bypasses the Windows Printing system and
spools the data directly to the printer. This option is similar to the
Print Directly to LPT1/LPT2/LPT3 option, except that network
printers are supported. With this option enabled, you cannot
control the layout of the print report since the program spools the
report to the printer (after converting it from EBCDIC to ASCII).
However, reports are queued in Print Manager (if it is enabled).

Select Printer—Opens the standard Print Setup dialog box, where you
select the destination printer when the destination is Windows Printing.

Selected Printer Info—Shows the Print Setup information (read-only).
To change it, click Select Printer.

Filename—Specifies the path and name of the file which receives the



host print reports when the destination is Print to File.

Defaults—Resets all options to their system default.

Related Topics

General Page (Printer Session Properties Dialog Box)

LU1 Settings Page (Printer Session Properties Dialog Box)
LU3 Settings Page (Printer Session Properties Dialog Box)
Page Layout Page (Printer Session Properties Dialog Box)
Printer Advanced Page (Printer Session Properties Dialog Box)

ASCII/EBCDIC Translation Table Page (Printer Session Properties Dialog
Box)

Host-Print Transform Page (Printer Session Properties Dialog Box)




Page Layout Page (Printer Session Properties
Dialog Box)
5250

To access

Use this page to configure the page layout for the host report.

Note: The options available on this page are ignored unless the Use Windows Printing option on the
Printer Destination Page (Printer Session Properties Dialog Box) is selected and the Spool Job
Directly option is cleared.

Layout Using—Specifies the type of settings to use when printing data.

Use Font Info Only—Selects the font style and size for the
printed data. In this mode, the selected font and font size—as well
as the size of the paper loaded in the actual printer—determine
the quantity of text that is printed on each page. When selected,
the font information you choose when clicking the Font button is
used, but the Page Format settings are ignored.

Use Page Format Info—Specifies the dimensions of the report in
columns and rows, as well as the size of the margins. When
selected, the Page Format settings override the font size you
choose when clicking the Font button. For example, this option lets
you specify that you want 80 columns, 54 rows, a one-inch margin
top and bottom, and a half-inch margin left and right. HostExplorer
will select a font size and spacing to create a printout with the
characteristics specified.

Margins—Specifies the print margins in inches.

Page Format—Controls the size of the printout when the Use Page
Format info layout is selected. The system uses the font name (not size)
selected and creates a font that fits the specified number of rows and
columns.

Orientation—Selects the orientation of the print job. This overrides the
value selected in the Printer Setup dialog box.
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Printer Font—Displays the currently selected font name. It also displays
the currently selected font size if you selected Use Font Info Only from
the Layout Using list.

Defaults—Resets all options to their system default.

Font—Selects the font for the print jobs. If the layout mode is Use Page
Format info, then only the Font name is used. The Font Size parameter is
ignored because HostExplorer generates a font to fit the specified
number of rows and columns. If the layout mode is Use Font Info Only, all
parameters are used and the paper size, margins, and the font size
determine the number of rows and columns.

Related Topics

General Page (Printer Session Properties Dialog Box)

LU1 Settings Page (Printer Session Properties Dialog Box)

LU3 Settings Page (Printer Session Properties Dialog Box)
Printer Destination Page (Printer Session Properties Dialog Box)
Printer Advanced Page (Printer Session Properties Dialog Box)

ASCII/EBCDIC Translation Table Page (Printer Session Properties Dialog
Box)

Host-Print Transform Page (Printer Session Properties Dialog Box)




Printer Advanced Page (Printer Session

Properties Dialog Box)
5250

To access
Use this page to set advanced printer options.

Printer Initialization String—Defines escape sequences that the
program will send to the printer at the beginning of a print report. The
string can contain up to 255 characters. This option is available for the
Print to LPTx and Print to File destinations.

You can enter Escape and binary codes or use the backslash character
(\). Embedded spaces are treated as part of the string. »

Printer Deinitialization String—Defines escape sequences that the
program sends to the printer at the end of a print report. See Printer
Initialization String.

Flush When End of Job Received—Forces the last page of the report
to clear the printer using Service. To print several reports together, like on
a line printer (where the beginning of a report prints on the same page as
the end of a previous report), clear this option and specify a timeout for
flushing the jobs.

Host Print Timeout for Flushing (Seconds)—Specifies timeout when
the Flush When End Of Job Received option is cleared. The timeout is
the amount of time (in seconds) that the system remains idle before
forcing the last page of a report to clear the printer.

Defaults—Resets all options to their system default.

Related Topics

General Page (Printer Session Properties Dialog Box)

LU1 Settings Page (Printer Session Properties Dialog Box)

LU3 Settings Page (Printer Session Properties Dialog Box)
Printer Destination Page (Printer Session Properties Dialog Box)
Page Layout Page (Printer Session Properties Dialog Box)
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ASCII/EBCDIC Translation Table Page (Printer Session Properties Dialog
Box)

Host-Print Transform Page (Printer Session Properties Dialog Box)




ASCII/EBCDIC Translation Table Page (Printer

Session Properties Dialog Box)
3270 5250

To access

Use this page to select a host code page that is used to convert data
received from the host from EBCDIC to ASCII (and to translate
messages sent to the host from ASCII to EBCDIC).

Language—Specifies the host code page. The default language is US
English, but you can select another language from the list.

Related Topics

General Page (Printer Session Properties Dialog Box)

LU1 Settings Page (Printer Session Properties Dialog Box)

LU3 Settings Page (Printer Session Properties Dialog Box)

Printer Destination Page (Printer Session Properties Dialog Box)
Page Layout Page (Printer Session Properties Dialog Box)

Printer Advanced Page (Printer Session Properties Dialog Box)
Host-Print Transform Page (Printer Session Properties Dialog Box)
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Host-Print Transform Page (Printer Session

Properties Dialog Box)
5250

To access

Use this page to set the properties of AS/400 print jobs. The AS/400 host
formats the data and sends it to the printer using ASCII Transparency.

Host-Print Transform—Transforms printed data into ASCII format using
the AS/400 host. You must select this check box to specify the following
options:

Printer Model—Specifies the type of PC printer that you want to
use. If your printer model is not in the list, select a model that is
similar to your printer type.

Note: Your AS/400 system must be able to recognize the selected printer model for
Host-Print Transform to function properly.

Drawer 1—Specifies the size of the paper loaded in drawer 1 of
the LAN printer.

Drawer 2—Specifies the size of the paper loaded in drawer 2 of
the LAN printer.

Envelope Hopper—Specifies the size of the envelopes loaded in
the envelope hopper of the LAN printer.

ASCII Code Page 899—Select this check box if you want your
printer to support ASCII code-page-899 symbols.

Customizing Object—Specifies the name of the AS/400
customizing object that contains the information to be used for
your printer during a printer session.

Customizing Library—Specifies the name of the AS/400 system
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library that contains the customizing object.

Related Topics

General Page (Printer Session Properties Dialog Box)

LU1 Settings Page (Printer Session Properties Dialog Box)
Printer Destination Page (Printer Session Properties Dialog Box)
Page Layout Page (Printer Session Properties Dialog Box)
Printer Advanced Page (Printer Session Properties Dialog Box)




Field Format Options Dialog Box
5250

To access

You can use this dialog box to specify how to format any date, time, or
decimal fields in a file being transferred from an AS/400 host to your PC.

You have the following options:
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Date Options
Format—Selects how to format date fields in the file being transferred.

Separator—Selects the separator used to separate any Date fields in the
file being transferred.



Time Options

Format—Selects how to format any Time fields in the file being
transferred.

Separator—Selects the separator used to separate any Time fields in
the file being transferred. This option is only valid if you choose a time
format of DFT or HMS. If you choose another time format, the default
separator is used.



Decimal

Ignore Decimal Data Errors—Sets a flag on the AS/400 to ignore any
decimal errors in the file being transferred. If you do not select this check
box, the wizard cannot transfer any file that contains decimal data errors.

Separator—Selects the separator used to separate any decimal
numbers in the file being transferred.

Other Button—Opens the Other Options dialog box, where you can
specify the character set and character sort sequence used in any SQL
sorts on the file being transferred.

Related Topics
Other Options Dialog Box
Transferring Files to and from AS/400




SQL Details Dialog Box
5250

To access

You can use this dialog box to customize the SQL statements used on
the file being transferred from an AS/400 host to your PC. Under each
tab in the dialog box, you can configure options in the following three
regions.
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Clause

Provides a place for you to build SQL statements. You can insert
operators by clicking one of the options in the SQL Operations list. You
can also type all operators directly.



SQL Operations

Provides a list of available SQL operations. The contents of the list
depend on the tab of the dialog box you click.



Fields

Displays the properties of any field in a database or any column in a
table. You can double-click any field or column to insert it into the Select
Clause box. The properties include the following:

Field—Shows the name of the field or column.
Type—Shows the type of the field or column.
Length—Shows the length (in bytes) of the field or column.

Digit—Shows the number of digits to the left of the decimal point, if the
field or column is zoned.

Decimal—Shows the number of digits to the right of the decimal point, if
the field or column is zoned.

Null Capable—Shows whether the field can contain a NULL value.

Related Topics
Transferring Files to and from AS/400




